PV-WAVE 7.5

Tutorial for UNIX and Open VMS

Helping Customers Solve Complex Problems
### Visual Numerics, Inc.

<table>
<thead>
<tr>
<th>Location</th>
<th>Address</th>
<th>Phone No.</th>
<th>Fax No.</th>
<th>Email Address</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Visual Numerics, Inc.</strong></td>
<td>2500 Wilcrest Drive, Suite 200, Houston, Texas 77042-2579</td>
<td>713-784-3131</td>
<td>713-781-9260</td>
<td><a href="mailto:info@vni.com">info@vni.com</a></td>
</tr>
<tr>
<td><strong>Visual Numerics, Inc. (France)</strong></td>
<td>Tour Europe, 33 place des Corolles, Cedex 07, France 92049 PARIS LA DEFENSE</td>
<td>33-1-46-93-94-20</td>
<td>33-1-46-93-94-39</td>
<td><a href="mailto:info@vni-paris.fr">info@vni-paris.fr</a></td>
</tr>
<tr>
<td><strong>Visual Numerics International, Ltd.</strong></td>
<td>Suite 1, Centennial Court, East Hampstead Road, United States of America, RG 12 1 YQ</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Visual Numerics International GmbH</strong></td>
<td>Zettachring 10, D-70567 Stuttgart, Germany</td>
<td>49-711-13287-0</td>
<td>49-711-13287-99</td>
<td><a href="mailto:info@visual-numerics.de">info@visual-numerics.de</a></td>
</tr>
<tr>
<td><strong>Visual Numerics S.A. de C.V.</strong></td>
<td>Cerrada de Berna 3, Tercer Piso, Col. Juarez, Mexico, D.F. C.P. 06600</td>
<td></td>
<td></td>
<td><a href="mailto:vda-sprt@vnij.co.jp">vda-sprt@vnij.co.jp</a></td>
</tr>
<tr>
<td><strong>Visual Numerics, Inc., Korea</strong></td>
<td>Seoul 121-050, Mapo-gu, Korea</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 1990-2001 by Visual Numerics, Inc. An unpublished work. All rights reserved. Printed in the USA.

Information contained in this documentation is subject to change without notice.

IMSL, PV-WAVE, Visual Numerics and PV-WAVE Advantage are either trademarks or registered trademarks of Visual Numerics, Inc. in the United States and other countries.


**IMPORTANT NOTICE:** Use of this document is subject to the terms and conditions of a Visual Numerics Software License Agreement, including, without limitation, the Limited Warranty and Limitation of Liability. If you do not accept the terms of the license agreement, you may not use this documentation and should promptly return the product for a full refund. Do not make illegal copies of this documentation. No part of this documentation may be stored in a retrieval system, reproduced or transmitted in any form or by any means without the express written consent of Visual Numerics, unless expressly permitted by applicable law.
# Table of Contents

Preface vii

Technical Support ix

**Chapter 1: Introduction**  1

The PV-WAVE ® Software Family  2

What is Visual Data Analysis?  6

Using This Tutorial  7

Conventions Used in This Tutorial  8

Getting Ready  10

Where to Obtain Additional Help  10

**Chapter 2: About PV-WAVE**  11

Some Basic Rules and Concepts  12

**Chapter 3: Experimenting with the Navigator**  17

What is the Navigator?  17

Tutorial Exercises Using the Navigator  18

Starting PV-WAVE  18

Starting the Navigator  19

The Online Help System  20

Manuals Online  20

**Displaying Time-Series Data**  21

Importing ASCII Data  21

Creating XY Plots  24

Using PV-WAVE Commands  26

Reformatting Datasets  27
Displaying Data as an Image  27
Creating Three-Dimensional Surface Plots  34
Using Online Help  35
Printing Your Results  36
Experimenting on Your Own  37
Ending the Session  37

**Displaying Image Data  38**
Importing 8-bit Image Data  38
Checking the Selected Variables List  39
Displaying the Image  40
Displaying the Image as a 3D Surface Plot  41
Using Color  42
Rescaling Image Data  42
Resizing the Image  44
Smoothing the Image  45
Cropping the Image  46
Creating an Inverted Image  48
Editing Color  49
Experimenting on Your Own  50
Saving the Session  51
Ending the Session  51

**Animating Image Data  52**
Importing the Animation Data  52
Viewing Displacement as an Image  53
Shading and Rotating a Surface View  54
Building an Animation Sequence  56
Viewing Animation  59
Changing the Appearance of a Plot  60
Chapter 7: Array Processing Techniques  137
  Previewing This Lesson  138
  Displaying and Processing Arrays  138

Chapter 8: Using Color  151
  Using Color Tables  152
  Using Color to Enhance Analysis  157

Chapter 9: Advanced Math and Statistics  161
  Programs You Can Use  162
  Solving a Nonlinear System of Equations  163
  Using a 2D B-Spline Interpolation Procedure  166
  Creating and Plotting a Parametric Cubic Spline Interpolant  171
  Estimating Area with a Random Number Generator  174
  Plotting a Fourier Sine Series  176
  Plotting a Shaded Surface of a Scattered 2D Interpolant  178
  Using the Lorenz Attractor  180
  Using Multiple Regression Capabilities  183
  Writing Programs  186
  Creating and Using Batch Files  190
  A Comparison of Matrices and Arrays  198

Chapter 10: Using PV-WAVE:GTGRID™  205
  Previewing This Lesson  206
  About PV-WAVE:GTGRID  206
  Drawing a Surface Plot  207
  Using the PV-WAVE:GTGRID Function  209
  More Information on PV-WAVE:GTGRID  212
Chapter 11: Animation with PV-WAVE  213
  Previewing This Lesson  214
  Displaying a Series of Images  214
  Animation As a Wire Frame Surface  216
  Rotating the Images in an Animation  218
  More Information on Animation  218

Chapter 12: PV-WAVE Gallery  219
  PV-WAVE Gallery Setup  220
  Gallery Contents  220
  Applications  222

Index  1
Preface

Welcome to the tutorial for PV-WAVE for UNIX and OpenVMS systems!

The first two chapters of this tutorial provide information about this tutorial and PV-WAVE. Chapters 3 through 11 provide sequenced, hands-on, step-by-step examples that demonstrate a wide range of applications and enable you to learn the fundamentals of using PV-WAVE products.

The chapters in this tutorial are organized as follows:

Chapter 1, Introduction — Explains how to use this tutorial and how to prepare to use PV-WAVE.

Chapter 2, About PV-WAVE — Discusses the features of PV-WAVE and some basic concepts that are helpful to know before you begin.

Chapter 3, Experimenting with the Navigator — Prepares you to use the Navigator and VDA Tools of PV-WAVE: Visual Exploration This technology provides the easiest way for you to interact with PV-WAVE. It features an intuitive graphical interface and context sensitive online help.

Chapter 4, Beginning PV-WAVE — Introduces you to the PV-WAVE command line interface, beginning with a simple plot and continuing with a more detailed exercise in the use of some basic functions and keywords.

Chapter 5, Basic Information for Any Session — Discusses some of the basics of working with PV-WAVE, such as saving and restoring sessions, using online documentation, and getting help.

Chapter 6, Plotting with PV-WAVE — Provides you with experience using plotting and graphics keywords to display several types of 2D and 3D plots, including contour and surface plots.
Chapter 7, Array Processing Techniques — Shows you how to read in an array of bytes, how to display this data as an image, and how to use PV-WAVE array processing commands.

Chapter 8, Using Color — Shows you how you can use color to enhance image analysis and to produce customized displays of color in your plots.

Chapter 9, Advanced Math and Statistics — Demonstrates the power of PV-WAVE:IMSL Mathematics and PV-WAVE:IMSL Statistics in two parts. The first section has code examples of mathematical and statistical programs you can run and use to pattern your own programs. The second part focuses on methods that will help you write your own PV-WAVE programs.

Chapter 10, Using PV-WAVE:GTGRID™ — Shows you the basic capabilities of PV-WAVE:GTGRID, including an example of the effects on plotted data before and after using the GTGRID function.

Chapter 11, Animation with PV-WAVE — Shows you several methods for animating data.

Chapter 12, PV-WAVE Gallery — Describes the PV-WAVE Gallery demonstration and provides information that can aid you in understanding the examples shown in the demo.

Index
Technical Support

If you have problems installing, unlocking, or running your software, contact Visual Numerics Technical Support by calling:

<table>
<thead>
<tr>
<th>Office Location</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate Headquarters</td>
<td>713-784-3131</td>
</tr>
<tr>
<td>Houston, Texas</td>
<td>303-939-8920</td>
</tr>
<tr>
<td>Boulder, Colorado</td>
<td>+33-1-46-93-94-20</td>
</tr>
<tr>
<td>France</td>
<td>+49-711-13287-0</td>
</tr>
<tr>
<td>Germany</td>
<td>+81-3-5211-7760</td>
</tr>
<tr>
<td>Japan</td>
<td>+82-2-3273-2633</td>
</tr>
<tr>
<td>Korea</td>
<td>+52-5-514-9730</td>
</tr>
<tr>
<td>Mexico</td>
<td>+886-2-727-2255</td>
</tr>
<tr>
<td>Taiwan</td>
<td>+44-1-344-458-700</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>713-784-3131</td>
</tr>
</tbody>
</table>

Users outside the U.S., France, Germany, Japan, Korea, Mexico, Taiwan, and the U.K. can contact their local agents.

Please be prepared to provide the following information when you call for consultation during Visual Numerics business hours:

- Your license number, a six-digit number that can be found on the packing slip accompanying this order. (If you are evaluating the software, just mention that you are from an evaluation site.)
- The name and version number of the product. For example, PV-WAVE 7.0.
- The type of system on which the software is being run. For example, SPARCstation, IBM RS/6000, HP 9000 Series 700.
- The operating system and version number. For example, HP-UX 10.2 or IRIX 6.5.
- A detailed description of the problem.
FAX and E-mail Inquiries

Contact Visual Numerics Technical Support staff by sending a FAX to:

<table>
<thead>
<tr>
<th>Office Location</th>
<th>FAX Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate Headquarters</td>
<td>713-781-9260</td>
</tr>
<tr>
<td>Boulder, Colorado</td>
<td>303-245-5301</td>
</tr>
<tr>
<td>France</td>
<td>+33-1-46-93-94-39</td>
</tr>
<tr>
<td>Germany</td>
<td>+49-711-13287-99</td>
</tr>
<tr>
<td>Japan</td>
<td>+81-3-5211-7769</td>
</tr>
<tr>
<td>Korea</td>
<td>+82-2-3273-2634</td>
</tr>
<tr>
<td>Mexico</td>
<td>+52-5-514-4873</td>
</tr>
<tr>
<td>Taiwan</td>
<td>+886-2-727-6798</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>+44-1-344-458-748</td>
</tr>
</tbody>
</table>

or by sending E-mail to:

<table>
<thead>
<tr>
<th>Office Location</th>
<th>E-mail Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boulder, Colorado</td>
<td><a href="mailto:support@boulder.vni.com">support@boulder.vni.com</a></td>
</tr>
<tr>
<td>France</td>
<td><a href="mailto:support@vni-paris.fr">support@vni-paris.fr</a></td>
</tr>
<tr>
<td>Germany</td>
<td><a href="mailto:support@visual-numerics.de">support@visual-numerics.de</a></td>
</tr>
<tr>
<td>Japan</td>
<td><a href="mailto:vda-sprt@vnij.co.jp">vda-sprt@vnij.co.jp</a></td>
</tr>
<tr>
<td>Korea</td>
<td><a href="mailto:support@vni.co.kr">support@vni.co.kr</a></td>
</tr>
<tr>
<td>Taiwan</td>
<td><a href="mailto:support@vni.com.tw">support@vni.com.tw</a></td>
</tr>
<tr>
<td>United Kingdom</td>
<td><a href="mailto:support@vniuk.co.uk">support@vniuk.co.uk</a></td>
</tr>
</tbody>
</table>

Electronic Services

General e-mail           info@boulder.vni.com
Support e-mail           support@boulder.vni.com
World Wide Web           http://www.vni.com
Anonymous FTP            ftp.boulder.vni.com

PV-WAVE Mailing List:    Majordomo@boulder.vni.com
To subscribe include:
To post messages         pv-wave@boulder.vni.com
Introduction

Welcome to PV-WAVE. This tutorial helps you begin using PV-WAVE Foundation and the companion technologies — PV-WAVE:Visual Exploration, PV-WAVE:IMSL® Mathematics, PV-WAVE:IMSL® Statistics — as well as some of the specialized optional toolkits. The logical approach used in the tutorial gets you started in a focused and productive way, so that you can have immediate results.

Figure 1-1 Image of sun's intensity taken from a diode array.

In 325 B.C, Aristotle concluded in his treatise, On the Soul, “... thought is impossible without an image.”
The PV-WAVE ® Software Family

“If only I’d had PV-WAVE ...I wish I’d had something like PV-WAVE back when I did this sort of work for a living. I would have gotten so much more done. It’s enough to make me maudlin about the weeks and months spent writing FORTRAN and C routines to do what now can be done with PV-WAVE in almost no time at all.”

— Barry Sheen, RS/Magazine, May, 1992

Introducing PV-WAVE Extreme Advantage ™ and PV-WAVE Advantage ™

Both PV-WAVE Extreme Advantage and PV-WAVE Advantage provide application developers with powerful functionality that supports a rapid application development environment (RADE) and provide the fundamental components of application development.

These components include an interactive language, reusable objects, powerful portability and robust graphic and numeric routines.

With PV-WAVE Extreme Advantage or PV-WAVE Advantage, you can make the best decisions, build the most robust applications, and solve the most complex problems. Leading the industry in ease-of-use and the ability to customize applications, these PV-WAVE packages enable you to identify hidden data trends, improve the quality of your analysis, reduce application development time, and become more productive.

PV-WAVE Extreme Advantage ™

PV-WAVE Extreme Advantage includes:

• PV-WAVE Foundation
• PV-WAVE Visual Exploration
• PV-WAVE IMSL Mathematics
• PV-WAVE IMSL Statistics
• PV-WAVE:Signal Processing Toolkit
• PV-WAVE:Image Processing Toolkit
**PV-WAVE Advantage ™**

PV-WAVE Advantage includes:

- PV-WAVE Foundation
- PV-WAVE Visual Exploration
- PV-WAVE IMSL Mathematics
- PV-WAVE IMSL Statistics

**PV-WAVE Foundation**

The cornerstone of PV-WAVE Foundation is its interactive programming language. PV-WAVE’s array-oriented and highly developed 4GL reduces coding requirements up to 80% and eliminates the need for compiling and linking. It supports variables and collections of variables, and all the same language constructs of FORTRAN and C. Its powerful functionality includes global variables, an event-driven interpreter, resource file support, and dialog box alerts to make your programming more efficient.

PV-WAVE Foundation features:

- Industry standard I/O
- GUI-based debugger
- Flexible data management functions
- Backwards compatibility
- Cross-platform compatibility

**PV-WAVE: Visual Exploration**

PV-WAVE Visual Exploration is an interactive environment for efficient visual data analysis and rapid application development. PV-WAVE Visual Exploration consists of multiple high-level application components, called VDA Tools, and a pre-developed GUI called the Navigator.

VDA Tools are reusable objects that provide the developer with a powerful modular framework to easily customize applications. VDA Tools allow you to perform specific functions such as generating plots, images, and contours, importing and exporting data, creating tables, generating code, and many other common procedures in an easy-to-use interactive environment. VDA Tools can also be pieced together to quickly create sophisticated, custom interfaces.
The Navigator is an intuitive interface that provides quick, individual access to the VDA Tools. Built entirely from VDA Tools, the Navigator can also be customized and extended for specific application requirements.

**PV-WAVE:IMSL Mathematics**

PV-WAVE IMSL Mathematics provides mathematical routines that save implementation time and provide accurate results. The math libraries contain a full range of capabilities, with subroutines for engineering and scientific disciplines, and other fields requiring accurate, reliable mathematical computation.

The capabilities of PV-WAVE IMSL Mathematics include:

- linear systems
- differential equations
- optimization
- basic matrix/vector operations
- interpolation and approximation
- eigenvalue systems analysis
- quadrature
- Bessel functions
- random number generation

**PV-WAVE:IMSL Statistics**

PV-WAVE IMSL Statistics routines reduce development time, save development expense and allow you to build applications that are portable across multiple platforms. The statistics routines provide versatility in handling missing values, evaluating various data types and quantities, and generating printed results.

Some of the calculations performed using PV-WAVE IMSL Statistics routines include:

- basic statistics
- factor and cluster analysis
- regression and random number generation
- tests of goodness-of-fit
- correlation
The PV-WAVE® Software Family

• cluster analysis
• nonparametric statistics
• time series analysis and forecasting
• variance analysis

Together, PV-WAVE:IMSL Mathematics and PV-WAVE:IMSL Statistics provide the utmost in numerical functionality and power because they
• are built upon the most widely used routines in the IMSL Fortran Numerical Libraries.
• include extensive online documentation with powerful search capabilities.
• include prepackaged functions that reduce application development.
• use a variable argument list structure that simplifies calling sequences.
• contain building blocks that eliminate the need to write code from scratch.

**PV-WAVE:Signal Processing Toolkit**

Signal processing is widely used in engineering and scientific research and development for representing, transforming, and manipulating signals and the information they contain. The PV-WAVE:Signal Processing Toolkit is a collection of digital processing functions that work in conjunction with PV-WAVE Advantage. These functions are designed for easy use by the beginning signal processor, while providing the advanced signal processor with many options for solving difficult problems.

**PV-WAVE:Image Processing Toolkit**

Included in the PV-WAVE:Image Processing Toolkit is an extensive set of filters, transforms, and image processing operators designed to meet the needs of even the most demanding image processing application. A robust graphical interface makes the PV-WAVE:Image Processing functionality easy to use giving the user easy access to:
• Image file import and export
• Image processing
• Histograms
• Profiles
• Contour Plots
• Surface Plots

**PV-WAVE: Database Connection**

PV-WAVE is the only Visual Data Analysis product to let you directly connect, query, and extract data from possibly your most valuable corporate asset — your formal SQL database. Database Connection uses standard SQL select statements to let you extract the data you need from any SQL database in your network. In combination with PV-WAVE’s integrated table tools for managing and manipulating tabular data, there is no better way to extract meaning – and value – from your data.

**PV-WAVE: GTGRID™**

Powerful interpolation and extrapolation techniques provided by PV-WAVE:GTGRID are used in PV-WAVE to produce technically superior gridded data sets. Even if your data set is large, sparse, faulted, noisy, or non-uniform, PV-WAVE:GTGRID provides you with the best in a wide choice of traditional and state-of-the-art algorithms for the gridding process.

---

**What is Visual Data Analysis?**

Visual Data Analysis (VDA) improves traditional data analysis by giving you a more active role in the analysis process. By emphasizing user interaction and visual representations of data, VDA enables you to control your data analysis in powerful new ways. The hallmarks of VDA are

• the ability to handle large, multidimensional data sets
• tools for fast data manipulation and subsetting
• quick graphical displays of intermediate results
• immediate user interaction
• advanced graphics tools for animating and displaying multidimensional data

By involving you visually in the analysis process — by allowing you see your data — VDA enables you to process large amounts of information quickly, giving you the opportunity to direct the discovery process from one moment to the next. With VDA you not only get more results from technical data, you get them faster.
Using This Tutorial

The PV-WAVE Tutorial assists you in discovering and exploring some of the powerful features of these products. This tutorial assumes that you have a working knowledge of your computer, its operating system, and a text editor. For complete instructions on using PV-WAVE, see the following:

- **PV-WAVE Reference** — An alphabetically arranged, two-volume manual that describes PV-WAVE’s functions and procedures, graphics keywords, system variables, and fonts.
- **PV-WAVE User’s Guide** — Provides information about how to use PV-WAVE to do plotting, image processing, rendering, and many other Visual Data Analysis techniques.
- **PV-WAVE Programmer’s Guide** — Describes the PV-WAVE programming language in detail.
- **PV-WAVE Development Guide** — Discusses PV-WAVE widget functions and PV-WAVE:Visual Exploration API components such as Tools Manager routines and utilities. This manual describes how to build your own GUI applications using this extensive functionality.
- **PV-WAVE:IMSL Statistics Reference** — A functionally arranged reference describing the statistical routines of this companion technology product.
- **PV-WAVE:IMSL Mathematics Reference** — A functionally arranged reference describing the mathematical routines of this companion technology product.

In addition, the following manuals accompany the PV-WAVE toolkits:

- **PV-WAVE:Database Connection User’s Guide**
- **PV-WAVE:GTGRID User’s Guide**
Conventions Used in This Tutorial

This tutorial uses specific terms and typographical conventions; these conventions are explained in this section.

Terms

MB1, MB2, and MB3 refer to the left, middle and right mouse buttons respectively.

Enter and Type mean type the indicated text at the prompt or into a text input field and then press the <Return> key.

The notation MenuName=>Command means select the function Command from the MenuName menu. For example, “select File=>Print” means select the Print command from the File menu.

Choose, Select, and Click mean move the pointer to the indicated position and press the left mouse button (MB1).

Drag means move the pointer to the indicated item, press the left mouse button (MB1) and hold it down while dragging the pointer to a specific location.

When you must press two keys simultaneously, the two key names are separated by a hyphen. For example: <Control>-D indicates that you should press the <Control> key and the <D> key at the same time.

Pathname refers to all directories and subdirectories in a path. Filename refers to the complete name of the file, including its extension.

Type Styles

To assist you in recognizing functions, keywords, system variables, etc., the following conventions are used:

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Used to Indicate</th>
</tr>
</thead>
<tbody>
<tr>
<td>All upper case (i.e., all capital letters)</td>
<td>Command and statement names, such as PLOT, FLTARR, FOR, WHILE, DO, CASE</td>
</tr>
<tr>
<td>Initial letter capitalized, default font</td>
<td>System variables, such as !Path, !P.Ticklen, !D.N_Colors</td>
</tr>
<tr>
<td>Initial letter capitalized and italics</td>
<td>Keywords, such as X_Type, Max_Levels, Linestyle</td>
</tr>
</tbody>
</table>
Conventions Used in This Tutorial

Unless otherwise noted, you can use upper or lower case as you prefer, because PV-WAVE is not case sensitive. However, PV-WAVE:Maple is case sensitive.

Text printed in italics in a command indicates that you must substitute the name yourself. For example,

```
WAVE> OPENR, 1, 'PathName/FileName'
```

means that you are to supply the full path and filename, such as

(UNIX)  `$VNI_DIR/wave/data/mandril.img`

(OpenVMS)  `VNI_DIR[WAVE.DATA]MANDRIL.IMG`

**Tips, Cautions, and Icons**

**TIP** A tip usually describes an alternate (often easier) method for achieving a particular task.

**NOTE** A note calls attention to important information or a definition.

**CAUTION** A caution signals that you must be careful when performing a particular task or risk losing work or data.

**SEE ALSO** A “see also” note lets you know when reference is made to information found in another printed source, such as the PV-WAVE Programmer’s Guide or PV-WAVE Reference.
Getting Ready

Supported Platforms
PV-WAVE runs on numerous hardware platforms. For the most current information on platforms supported by PV-WAVE, refer to the installation instructions, or contact Visual Numerics, Inc. Contact information is shown at the end of this chapter.

Required Hardware
The storage space can differ significantly on different platforms due to the efficiency of different architectures in storing object code. If you are going to install on your hard disk, check your installation instructions for more information about the space required for your platform.

Installation
When you are ready to install PV-WAVE products, refer to the installation instructions provided with the software.

Once you have installed your PV-WAVE software, you may need to validate the installation by contacting Visual Numerics, Inc. Contact information is shown at the end of this chapter.

Where to Obtain Additional Help
Just type HELP at the WAVE> prompt. The online help system contains detailed information on all PV-WAVE commands and on the PV-WAVE programming language.

A complete set of online manuals for PV-WAVE and its add-on components is also available online as an optional installation.
About PV-WAVE

Using PV-WAVE’s interactive programming environment, you can analyze and visualize your data in less time than with other programming tools.

Figure 2-1 A Julia set image generated using PV-WAVE.
PV-WAVE provides an extensive set of data analysis functions for processing, analyzing and manipulating data. Programs written in PV-WAVE are shorter and execute faster than programs written in other scientific programming languages. With the seamless integration of IMSL’s C/Math/Library and C/Stat/Library into PV-WAVE:IMSL Statistics and PV-WAVE:IMSL Mathematics, you can realize the strength, flexibility, and power of these mathematical and statistical libraries.

The PV-WAVE Gallery demonstrates many of the applications listed above. For information on running the PV-WAVE Gallery, see Chapter 12, *PV-WAVE Gallery*.

### Some Basic Rules and Concepts

Knowledge of certain basic rules and concepts of PV-WAVE makes learning the programming language more rapid.

#### PV-WAVE Notation

PV-WAVE provides a set of data types and operations to represent data with a natural and efficient notation. You can easily define and use structures containing aggregate data types. PV-WAVE variables, procedures, operators, and functions operate on scalar, vector, and array data with no change in notation or meaning.

PV-WAVE borrows much of its semantics from the programming language APL. The power and conciseness of PV-WAVE can be attributed to this APL influence. The main advantages over APL are syntax and control mechanisms plus visualization capabilities.

In the design of PV-WAVE, whenever there was a choice between brevity (and perhaps obscurity) and verbosity, the most readable alternative was selected.

Because scientists write their formulas using infix notation with parentheses, PV-WAVE has an expression syntax that resembles FORTRAN or BASIC, where operators are evaluated according to precedence and left-to-right sequence.

#### Extensive Error Checking

As with any well-designed interactive language or system, extensive error checking and informative error messages are provided. The type of error and the associated variable are printed in an understandable format, without error codes or cryptic messages. You can stop a program that is running at any time and look at or change intermediate values. You can then resume the suspended program from the point of interruption.
General Information

The following list contains basic concepts, rules, and tips that you will use over and over during any PV-WAVE session. More detail about each item is provided in subsequent lessons and in the appendix.

✔ Start online help by typing HELP at the WAVE prompt.
✔ Start online documentation (UNIX only) by typing wavedoc at the operating system prompt.
✔ Obtain online information about saved variables, procedures, etc., by entering INFO at the WAVE> prompt.
✔ PV-WAVE is not case sensitive; upper and lower case letters are used in this manual to enable you to learn names and to distinguish functions from keywords more easily.
✔ Press the <Return> key to indicate you have completed the entry of a command and to execute the command.
✔ Use the “up” arrow (↑) key to recall the most recent line of input to PV-WAVE. (This works on most computers.) After you redisplay a line, you can edit it and then press the <Return> key to execute it. Recall up to 20 lines by pressing this key repeatedly.
✔ Commas (,) are used to separate one argument from another.
✔ Use the ampersand (&) to enter more than one command on a line.
✔ To continue a command from one line to another, append a dollar sign ($) at the end of the line you wish to continue.
✔ The RETALL command is very useful when you encounter an error or interrupt. After an error, PV-WAVE stops at the end of the last procedure, which may not return you to the main program level. Your variables are available at the main program level. Entering the RETALL command returns you to the main program level. Alternatively, you may enter the RETURN command, which will return you to the next highest program level.
✔ A semicolon (;) is used to begin a comment in a PV-WAVE .pro file or program.

Basic Data Types

Typing and binding of variables in PV-WAVE are dynamic, that is, the structure and type of data contained in a variable may change during a session. The basic data types that PV-WAVE variables may have are:
Scalars, Arrays, and Structures

A scalar is a single instance of one of the seven data types or a single composite structure. An array is a simple structure containing multiple elements of the same data type. Array elements are addressed with subscripts and subscript ranges. A structure is an aggregation of the basic data types, other structures, and arrays.

PV-WAVE is array-oriented, that is, it handles an array as a single entity, rather than as separate numbers. As a result, you can perform mathematical operations on arrays in the same manner as on individual elements. For example, to multiply the variable $a$ times 5, you enter “$a*5$”. PV-WAVE performs the operation with ease, whether the variable $a$ is a scalar, vector, or an array.

Comparison of Matrices and Arrays

Matrices can be referenced differently from arrays by using the functions PM (Print Matrix), RM (Read Matrix), PMF (Print Matrix File), and RMF (Read Matrix File).

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte</td>
<td>An 8-bit, unsigned integer ranging from 0 to 255. Pixels in images are commonly represented as byte data.</td>
</tr>
<tr>
<td>Integer</td>
<td>A 16-bit, signed integer ranging from $-32,768$ to $+32,767$.</td>
</tr>
<tr>
<td>Longword</td>
<td>A 32-bit, signed integer ranging in value from approximately $-2 \times 10^9$ to $+2 \times 10^9$.</td>
</tr>
<tr>
<td>Floating</td>
<td>A 32-bit floating point number in the range of $\pm 10^{34}$ on VAX and $\pm 10^{38}$ on machines supporting the IEEE standard, with approximately 6-7 decimal places of significance.</td>
</tr>
<tr>
<td>Double</td>
<td>A 64-bit double precision, floating point number in the range of $\pm 10^{34}$ on VAX and $\pm 10^{38}$ on machines supporting the IEEE standard, with approximately 13-14 decimal places of significance.</td>
</tr>
<tr>
<td>Complex</td>
<td>A real-imaginary pair using single-precision floating point numbers. Complex numbers are useful for signal processing and frequency domain filtering.</td>
</tr>
<tr>
<td>Double Complex</td>
<td>A real-imaginary pair using double-precision floating point numbers.</td>
</tr>
<tr>
<td>String</td>
<td>A sequence of alphanumerical characters, from 0 to 32,767 characters in length.</td>
</tr>
</tbody>
</table>
Matrices are used by mathematically-oriented functions and procedures. If $A$ is a matrix, then $A(i, j)$ refers to the $i$-th row, $j$-th column of $A$. This conforms to standard mathematical notation. The elements in a matrix are stored columnwise, i.e., the elements of the 0-th column are first, followed by the elements of the 1-st column, and so forth.

Other functions and procedures, such as the image display function TV, use arrays. If $A$ is an array (an image is an array of pixels), then $A(i, j)$ refers to the pixel whose $x$ coordinate is related to $i$ and whose $y$ coordinate is related to $j$. The elements in an array are stored row-wise, i.e., the elements of the 0-th row are first, followed by the elements of the 1-st row, etc.

PV-WAVE provides specific methods to read arrays and matrices. The PV-WAVE PRINT command returns values according to the array syntax, and the READ command is the corresponding command to read data. The PV-WAVE PM command (Print Matrix) and the RM command (Read Matrix) follow the matrix notation convention. You have the option of using the type of commands that emulate the notation with which you are most comfortable.
Experimenting with the Navigator

What is the Navigator?

The Navigator provides an easy-to-use graphical interface for performing visual data analysis. It consists of a collection of high-level components called VDA Tools. The Navigator lets you perform many of the tasks that normally require the expertise of an experienced PV-WAVE programmer.

The Navigator allows you to:

- Import and export data
- Preview ASCII data files
- Display 2D plots, images, histograms, surfaces, and contour plots
- Animate data
- View and subset tables of data
- Save and restore sessions
- View and select variables
- Modify image and plot colors
Chapter 3: Experimenting with the Navigator

Tutorial Exercises Using the Navigator

To get you started quickly and to pave the way for using your own data, we’re giving you three short Navigator exercises using datasets that we have provided for you.

The first example uses an ASCII dataset containing atmospheric temperature and air quality data. You start by importing data into PV-WAVE, and then you create simple graphics. You will see how to use the WzImage Tool to get a quick visual overview of the data, even though it was not originally obtained from an imaging device.

The second dataset was obtained from an imaging device. The data is in 8-bit image format and consists of a poor-quality image of a flame. You will use the WzImage Tool to modify the image by changing its size, cropping bad data along its edges, increasing the contrast, and adding color. You will see how easy it is to manipulate and enhance image data.

The third example contains data from shock wave measurements. Each data point represents the calculated pressure at a point in a simulated block of graphite epoxy composite. You’ll look at surfaces representing pressures along slices through this volume and learn how to “animate” these surfaces to look at the progression of shock waves.

Starting PV-WAVE

If PV-WAVE isn’t already installed on your system, install it first. If you’re installing PV-WAVE yourself, the installation information is included with the media you received from Visual Numerics, Inc. Along with the PV-WAVE software, the media contains several data files you will use to work through the examples.

NOTE

The illustrations in this document depict PV-WAVE being run with the Motif window manager in an X Window System environment. Although PV-WAVE runs under other X Window System window managers, Motif (or some other Motif-compliant window manager) is the preferred window manager for this version of the software on UNIX and OpenVMS platforms. This version of PV-WAVE is designed especially to work with Motif and has been thoroughly tested running with the Motif window manager.

Once PV-WAVE is installed, you’re ready to begin. If you have trouble running the software, refer to the installation instructions for detailed information.
Step 1  To start PV-WAVE, type the following command at the operating system prompt:

WAVE

Starting the Navigator

To start the Navigator, enter the following command at the PV-WAVE prompt:

WAVE> navigator

Now take a look at the Navigator window to get a feel for the point-and-click interface.

Figure 3-1  The Navigator window consists of a title area, menu bar, icon bar, and message area.

This window contains four parts:

• **Title Area** — You can move the window to a different location on the screen by pressing and holding down MB1 (the left mouse button) in the title area while you drag the window to its new location. The title area also contains the window manager menu (on the left) and buttons for minimizing or maximizing the window (on the right).
• **Menu Bar** — The menus available in the Navigator are listed below the title area. If you press MB1 and hold it down while the pointer is over a menu button, a pulldown menu appears. Try it.

   The menus are pulldown style, which means you hold the mouse button down and release it over the desired menu selection. To close a menu without making a selection, drag the pointer out of the menu and release the mouse button.

• **Icon Bar** — When you click on an icon, the corresponding VDA Tool opens.

   **TIP** To see the name of the VDA Tool associated with an icon, simply position the pointer over the icon. The name of the icon appears in the space just above the leftmost icon.

• **Message Area** — Messages appear at the bottom of the window. They provide information that can be helpful when you’re using the window.

   At any time, you can exit the Navigator by selecting **File=>Close** from the Navigator window.

   **NOTE** The notation **File=>Close** means “select the Close command from the File menu”. This notation is used throughout the tutorial.

   Now we’ll introduce you to the online help system.

---

**The Online Help System**

Online help is provided on all platforms. You can get information on any PV=WAVE routine and many aspects of the programming language by typing **HELP** at the **WAVE>** prompt. In addition, context sensitive help is provided for the VDA Tools and Navigator of PV=WAVE:Visual Exploration.

You will have many opportunities to explore the online help system as you work through this tutorial.

---

**Manuals Online**

A complete set of PV=WAVE documentation, equivalent to the hardcopy documentation set, is available on UNIX platforms.
If you have the online documentation installed on your system, you can start an interactive table of contents window by entering the following command at the PV-WAVE prompt:

WAVE> HELP, /Documentation

The online documentation system includes a main table of contents from which you can display pages from any manual. Hypertext links enable you to find additional information on most topics quickly. You can also print any of the online documentation files on a PostScript printer.

---

**Displaying Time-Series Data**

This first example uses an ASCII file containing three columns of data. Each column contains 8,760 floating-point values.

This dataset contains atmospheric data collected by environmental monitoring instruments taken in one hour intervals for an entire year, which resulted in 8,760 observations of temperature, carbon monoxide, and sulphur dioxide levels. Using the Navigator, you can analyze this data — in less time than it took to collect two sets of measurements.

In this session, you will learn how to do the following:

- Import ASCII data without elaborate conversion or programming.
- Compute and display a mathematical relationship between entire datasets.
- View your data using three different graphical methods: 2D line, image, and surface.
- View cross-sectional plots of image data.
- Experiment with different colortables.
- Use the online help system.
- Print your results.

---

**Importing ASCII Data**

Start by importing the atmospheric data for the example. The data file consists of three columns:

- ✔ **Column 1** — Temperature (degrees Fahrenheit)
✔ **Column 2** — CO (carbon monoxide)
✔ **Column 3** — SO₂ (sulphur dioxide)

**Step 1**  Click the WzPreview icon in the Navigator main window. (When you move the pointer over the icons, their names appear in the upper-left portion of the Navigator window, just above the leftmost icon.)

The WzPreview Tool appears.

![Image of WzPreview Tool]

*Figure 3-2* The WzPreview Tool is a VDA Tool used to read ASCII data from a file into variables.

**Step 2**  Click MB1 in the **Filename** text field. This selects the field for receiving typed input.

**Step 3**  Type the full path and filename of the first example data file, as follows:

**(UNIX)**  
VNI_DIR/wave/data/air_qual.dat

**(OpenVMS)**  
VNI_DIR:[WAVE.DATA]AIR_QUAL.DAT
where $VNI\_DIR$ is the name of the directory where PV=WAVE is installed. If you aren’t sure which directory this is, see your system administrator.

**Step 4**  Press `<Return>`.

In a few moments, the top of the `air_qual.dat` file appears in the display area of the WzPreview Tool. WzPreview has auto-defined and named the three columns of data it “sees” in the file. The width of each column is shown with a small rectangle, and the header information is differentiated from the data with a larger rectangle.

![Image of WzPreview Tool](image)

**Figure 3-3** The WzPreview Tool highlights portions of the ASCII data file that are to be read into variables.

**Step 5**  Click the读 button in the control area of the WzPreview Tool. This function reads the columns of the data file into individual variables.

The WzPreview Tool has enabled you to read the data without programming or converting it. Indeed, the WzPreview Tool understood enough to read past the header information in the data file.
Creating XY Plots

At this point, you have read ASCII data into variables with very little effort and with no programming at all.

The next step is to plot this data. Before doing this, bring up another VDA Tool called WzVariable. Think of WzVariable as a data manager. Use this tool to list and select the variables that you want to plot during a session.

**Step 1**  Click on the WzVariable icon in the Navigator window. The WzVariable Tool appears.

All the variables you created with WzPreview are all listed in the WzVariable window.

**Step 2**  To get a first graphical view of your data, select TEMP from the WzVariable list by clicking on it with MB1.

![Figure 3-4](image)

The TEMP variable is selected in the WzVariable Tool.

**Step 3**  Click the WzPlot icon in the Navigator window.

A 2D line plot of the data appears in the WzPlot Tool.
**Step 4** Move the WzVariable Tool to another location on your screen if it is in the way, but do not close it yet.

![WzPlot Tool](image)

**Figure 3-5** The WzPlot Tool is used to plot 2D or 3D datasets.

WzPlot distributes the points evenly along the x-axis and plots their values along the y-axis. This example lets you see daily temperature variations at the observing station along with the annual variation. By looking for the place where the data drops nearly down to the bottom axis, you can spot a cold snap during the winter months.

At this point, you have meaningful graphic of the data without typing a single command.

Once you get a plot in the WzPlot Tool, you can modify it easily. Take a look at the menus available on the menu bar. Functions on the **Attributes** menu let you modify
the appearance of the plot and the data. Functions on the Create menu let you add graphical elements such as lines and text to a graph. The button bar, just below the menu bar, contains functions for adding graphical elements, selecting data and graphics, and several editing functions.

We’ll explain more about these capabilities later.

**Step 5**  Exit the WzPlot Tool by selecting **File=>Close**.

---

**Using PV-WAVE Commands**

The variables you have read in and plotted are normal PV-WAVE variables. They “exist” in PV-WAVE at the main program level. Therefore, you can perform operations on these variables from the command line using PV-WAVE functions and procedures.

Next, you will perform some simple operations on the variables you have created. Then, you will see how the processed variables can again be displayed in the WzPlot Tool.

With PV-WAVE, you can easily do mathematics on an entire array. Because of the way the numerical operators work in PV-WAVE, you can handle entire datasets with a single equation. For example, suppose you want to plot each day’s ratio of SO₂ concentration to its temperature.

**Step 1**  To compute this ratio, enter the following command at the **WAVE>** prompt. (This prompt appears in the window from which you started PV-WAVE. You might need to move other windows out of the way to see the **WAVE>** prompt window.)

```
WAVE> RATIO = SO₂/TEMP
```

**Step 2**  Display this newly created variable, RATIO, in the WzVariable Tool. To do this, select **Options=>Redisplay List** from the WzVariable Tool menu. The variable RATIO appears in the list.

**Step 3**  Select RATIO by clicking MB1 on it.

**Step 4**  Plot this variable the same way you plotted the TEMP variable previously. Simply click the WzPlot icon in the Navigator window.

**Step 5**  When you have finished viewing this data, close the WzPlot Tool.
Reformatting Datasets

You can reorganize data to analyze periodicity. The temperature dataset you are working with has two periods:

- **Diurnal** — A period equal to 24 hours
- **Annual** — A period equal to 365 days

You can derive some interesting graphics by converting the 8,760-point, 1D TEMP variable into a 24-by-365 2D variable. In the new variable, the first dimension now represents the hour of the day and the second dimension represents the day of the year.

**Step 1** Convert your data with the following command entered at the WAVE> prompt:

```
WAVE> TEMP_I = REFORM(TEMP, 24, 365)
```

**Step 2** Display this newly created variable, TEMP_I, in the WzVariable Tool. To do this, select **Options=>Redisplay List** from the WzVariable Tool menu.

The variable TEMP_I appears in the WzVariable list box.

**Step 3** Verify that this is a 2D (24-by-365) variable by double clicking on the variable name in the WzVariable Tool.

**Step 4** Click **OK** in the Variable Information dialog box to dismiss it.

Now you can look at this new 2D variable in some new ways. You’ll use image processing techniques with this time-series data, all without any programming!

---

**Displaying Data as an Image**

Viewing data as an image is a powerful technique for looking at a large amount of data at once, because an image is compact and it enables you to use color to differentiate the various values in the dataset.

**Step 1** If the TEMP_I variable is not already selected in the WzVariable Tool list, select it. Make sure all other variables are deselected.

**Step 2** Click on the WzImage icon in the Navigator window.
PV-WAVE displays an image of this 2D variable. Remember that in a WzImage view, each data value is represented by only one pixel.

**Resizing the Image**

Even though the image does not fill the viewing area, you can resize it to make it larger and easier to view. You do this by adding additional values to the dataset. The image you just displayed is long and narrow. To increase the size in the horizontal direction, you can simply increase the number of points in the array.

PV-WAVE provides several functions to help. Two functions, CONGRID and REBIN, will do the job. CONGRID interpolates a new set of points with the same overall shape as the old set. REBIN produces a similar result, faster than CONGRID, but requires that the new set be a factor or multiple of the old set.

Go ahead and use REBIN to increase the horizontal dimension by some multiple to get a larger number of points. The number 360 is a multiple of 24. Change the first dimension of 24 points to 360 (24 times 15) and leave the second at its original 365.

**Step 1** Enter the following command at the WAVE> prompt:

```
WAVE> TEMP_I = REBIN(TEMP_I, 24*15, 365)
```

PV-WAVE will evaluate the mathematical expression given as the second parameter, resulting in a first dimension of 360.

**Step 2** Now, just click the Redraw button on the WzImage Tool button bar.

The image is updated when you click Redraw because the variable you updated is the same one that is currently displayed in the VDA Tool. In this case, there was no reason use the WzVariable Tool.

**Step 3** Resize the WzImage window so that the entire image is displayed. Do this by pressing MB1 over the lower right corner of the border and dragging.
Displaying Data as an Image

Figure 3-6  A display of the 2D variable using the WzImage Tool.

WzImage automatically scales the numerical values of the dataset so that every shade of color (or every shade of gray) is utilized. The lightest points have a numerical value of 127, while the darkest have a value of 0 (zero).

The origin of the image is at the lower left; thus, the beginning of the year is at the bottom, and the beginning of each day is at the left.

As you would expect, the temperature is at its minimum (the darkest colors) near the beginning of each day and at its maximum (the lightest colors) near the middle of each day. It’s also easy to see that the average daily temperature reaches its minimum early in the year and its maximum in the middle of the year.

Displaying Profile Plots

You can easily create profile plots. With the data you are using in this tutorial, a row profile plot represents temperature variations during a day. A column profile plot represents the temperature for each day of the year, measured at the same time each
day. The profile, which is like a cross-section of the image, allows you to examine a particular portion of the image with more precision than you can in the image itself.

**Step 1** Select either the Row Profile button or the Column Profile button from the button bar (just below the menu bar on the WzImage Tool), or select Column Profile or Row Profile from the Edit menu to start a row or column plot. A blank viewing mode window appears, ready to display the row or column that you select.

**Step 2** Using MB1, click the image at the point where you want to see a cross-section. Clicking MB1 displays either a row or column plot, depending on which profile button you chose. Remember that the plots are scaled to fit the available viewing area.

**Step 3** Press and drag MB1 and the profile is updated dynamically.

**Step 4** When you are through looking at profiles, click the Dismiss button in the Profile window.

**NOTE** The VDA Tool stays in the profiling mode until you select a different mode such as data selection or object selection.
Manipulating Data Across VDA Tools

This example demonstrates how VDA Tools can share the same data. When you modify the data in one VDA Tool, the changes take effect for all VDA Tools sharing the same data.

Step 1  First, in the WzVariable List, select the variable TEMP.

Step 2  Now, click the WzPlot icon in the Navigator window. This brings up the same 2D plot you saw previously.

Remember the dip that occurs early in the sampling period, which we attributed to a cold snap? Let’s assume that there wasn’t a cold snap, but rather the data sampled during that period was erroneous.

Let’s correct the faulty data using the data selection feature and the WzTable Tool.

Step 3  Click the WzTable icon in the Navigator window. WzTable opens and the individual data values from the TEMP variable are shown in the table cells.

Step 4  Move the windows so that you can see both the WzTable Tool and WzPlot Tool at once.

Step 5  In the WzPlot Tool, select Edit=>Data Select. This puts the Tool in data selection mode.

Step 6  Select the downward spike that we previously attributed to a cold snap. To do this, press and drag MB1 to draw a rectangle around the data. Try to select the entire spike, approximately as shown in the following figure.
Figure 3-8 An area of the 2D plot selected for analysis or data manipulation using the data selection mode.

Notice that the selected data is highlighted in both the WzPlot Tool and the WzTable Tool. Use the scroll bars in the WzTable Tool to scroll through the range of selected data values.

**Step 7** Now, edit the variable TEMP directly by entering 32 in the Change Selected Values To field of the WzTable Tool.

**Step 8** Press <Return>.

The plot in WzPlot is automatically updated with the new values. Note that this operation has directly modified the variable TEMP. You could have edited each value in the table individually instead of setting them all to one value.
**Step 9**  See what happens when you select **Edit=>Undo** from the WzTable menu bar.

We encourage you to experiment with other values and other selected ranges of data.

**Step 10**  Close the WzPlot and WzTable windows.

**Using Color**

PV-WAVE supplies you with a number of colortables that display values in color rather than shades of gray.

**Step 1**  To try color, select the **WzColorEdit** icon from the Navigator window.

**Step 2**  If necessary, move the WzColorEdit Tool away from WzImage Tool, so that you can see the image.

**Step 3**  Select **ColorTable=>System** to bring up the list of System Color Tables.

**Step 4**  Click on the **Blue-Red** item in the list and notice the change. Click **Dismiss** when you are finished with the list of System Color Tables.

The image now appears in colors better suited for the display of this temperature data. If you like, you can try some of the other system color tables available to you.

**Step 5**  Close the WzColorEdit Tool by selecting **File=>Close** when you are done experimenting with colors.

**Step 6**  Close the WzImage Tool.
Creating Three-Dimensional Surface Plots

You can display the data as a mesh surface plot.

**Step 1** If the TEMP_I variable is not already selected in the WzVariable Tool list, select it. Make sure all other variables are deselected.

**Step 2** Click on the WzSurface icon in the Navigator window.

![WzSurface Tool](image)

*Figure 3-9* The WzSurface Tool provides yet another way to look at the same temperature data you were viewing earlier as a 2D line and as an image.
Using Online Help

Use online help anytime you want more detailed information about a particular Navigator feature. Online help also gives you fast access to reference information on all PV-WAVE functions and procedures and features of the programming language.

We encourage you to experiment with the help system as you progress through this tutorial.

PV-WAVE Online Help

First, let's see what information is available on the REBIN command that you used during this lesson. REBIN is a PV-WAVE function.

Step 1  At the WAVE> prompt, type:

WAVE> HELP, ‘REBIN’

After a few moments, the online help system starts and reference information on the REBIN function is displayed in the help window.

Step 2  Type the following command at the WAVE> prompt:

WAVE> HELP, ‘REFORM’

The reference information on the REFORM function is displayed in the help window.

TIP  If you want to learn more about the online help system, select Help=>How To Use Help from the menu bar of the online help window, or select Help=>On Help from the menu bar of any VDA Tool or the Navigator.

Context-Sensitive Help

When you are using the Navigator or VDA Tools, context-sensitive help is available to you at any time during the session. Context-sensitive help is available when you select Help=>On Window from the Navigator menu or from any VDA Tool menu. On Window displays a table of contents of information about the specific window.

Step 3  Select Help=>On Window from the WzSurface Tool menu bar.
TIP  You can leave the help window open during an entire session, and refer to it at any time.

In addition, all dialog boxes have a Help button that brings up specific reference information about that dialog box.

Step 4  Select Attributes=>Surface Attributes from the WzSurface Tool menu bar. The Surface Attributes dialog box appears.

Step 5  Click the Help button in the dialog box. Information on the dialog box is displayed in the help window.

Step 6  Click the Cancel button to close the Surface Attributes dialog box.

Printing Your Results

Obtaining a printed version of a VDA Tool window is often an important step, because it enables you to share your results with others. But if you do not wish to create a hardcopy version of the surface you see in the VDA Tool, you may skip this section.

Step 1  To print a copy of the plot that you see in the WzSurface Tool, select File=>Print. The Printer Setup dialog box appears.

Step 2  Type the appropriate print queue name in the text field. If you do not know the print queue name, ask your System Administrator, or just leave the text field empty to try the default queue.

Step 3  Select the appropriate output format for your printer from the Printer Type option menu.

Step 4  Select the Print button.

Step 5  Click OK to dismiss the dialog box. (If you type the wrong print queue, or wish to change the print queue, you need to select File=>Print Setup to display the Printer Setup dialog box again.)

TIP  If you wish to print subsequent graphics during this session, you can simply select File=>Print. This is because you only have to set up your printer options once during a session. The Printer Setup dialog box will not appear again unless you explicitly select File=>Print Setup.
Step 6  Close the WzSurface Tool by selecting **File=>Close**.

Step 7  Also close the WzVariable Tool.

Printing procedures will vary from site to site. If you have difficulty printing, contact your System Administrator to determine the proper printer queue names, output formats, and printer options.

---

**Experimenting on Your Own**

In this example, you have done some simple visual data analysis, mostly of temperature data. You may want to continue working with this data to explore the relationship of temperature to the recorded levels of CO and SO₂ and we encourage you to do so.

In this session, you have learned how to do the following:

- Import ASCII data without elaborate conversion or programming.
- Compute and display a mathematical relationship between entire datasets.
- View your data using three different graphical methods: 2D line, image, and surface.
- View cross-sectional plots of image data.
- Experiment with different colortables.
- Use the online help system.
- Print your results.

If you have an ASCII dataset of your own that would lend itself to similar visual data analysis, try it.

---

**Ending the Session**

You can exit the Navigator and PV-WAVE session or continue to the next tutorial.

When you exit the Navigator, all of the data you have imported or created through processing remains on the main program level of PV-WAVE. When you exit PV-WAVE, however, all the data you have imported or created will be lost unless you have saved it.

Of course, the original data in the imported file remains intact.
To exit the Navigator, choose **File=>Close** from the Navigator window. To exit from PV-WAVE altogether, type **EXIT** at the **WAVE>** prompt.

**NOTE** We’ll discuss saving files in a later example, so don’t bother to save your data now. You won’t need the results from this example for any future session.

---

### Displaying Image Data

The next dataset to experiment with consists of an image of a flame obtained with an imaging device. This dataset is a 128-by-128 2D array. The data is 8-bit binary, and thus has values ranging from 0 to 255.

We have purposely given you a dataset that contains a poor image so that you can see how easy it is to use the Navigator to enhance the image.

**Step 1** If it is not already running, start PV-WAVE. (See *Starting PV-WAVE* on page 18 if you need detailed instructions.)

**Step 2** If it is not already running, start the Navigator by typing `navigator` at the **WAVE>** prompt.

---

### Importing 8-bit Image Data

Because the data type for this 8-bit data is byte, you do not import the data with the WzPreview Tool, as you did in the previous example. (Remember that the WzPreview Tool is designed for importing ASCII data.) For this type of data, you need to use the WzImport Tool.

**Step 1** Click the WzImport icon in the Navigator window. The WzImport Tool appears.

**Step 2** From the **File Type** option menu of the WzImport Tool, select **8 Bit Image**.

**Step 3** In the **File Name** text field, type the full path and file name of the image data file, as follows:

- **(UNIX)** `<wavedir>/data/flame.img`
- **(OpenVMS)** `<wavedir>:[DATA]FLAME.IMG`
Where `<wavedir>` is the main PV-WAVE directory. This is the directory where PV-WAVE was installed. If you aren’t sure which directory this is, see your system administrator.

**Step 4** Select the Read button.

A message appears in the message area indicating that the variable `IMG8` has been created.

**Step 5** Close the WzImport Tool. (Select File=>Close.)

---

### Checking the Selected Variables List

To display a variable in a graphical VDA Tool, such as WzImage, the variable must be “selected”. One way to select a variable is to open the WzVariable Tool and click on the variable name in the list box. That was how you selected variables in the previous lesson.

Anytime you import data into a variable using WzImport, the newly created variable is automatically “selected”. In other words, you do not have to bring up WzVariable now (unless you want to).

You can always determine which variable is the currently selected variable, by doing the following:

- Choose **Tool=>List Selected Variables** from the Navigator window menu. The currently selected variable or variables are then listed in the message area of the Navigator window. In this case, the variable `IMG8`, the variable you just read in, is listed there.
Displaying the Image

Because the image variable is already selected, all you need to do is click the WzImage icon in the Navigator window.

The image is displayed in the WzImage Tool.

![WzImage Tool](image)

**Figure 3-10** The selected variable is displayed in the default WzImage Tool window.

Note that the displayed image doesn’t look very distinctive and is small compared with the available view area. That is because it is 128 x 128 pixels, while the view area can display a much larger area.
Displaying the Image as a 3D Surface Plot

Step 1  To display the image as a 3D surface plot, click the WzSurface icon in the Navigator window.

A 3D mesh surface of the flame is displayed in the WzSurface Tool.

![WzSurface Tool](image)

**Figure 3-11** A 3D mesh surface of the image data.

You can also see that the edge of the surface contains spurious data, shown as a cliff. This has an undesirable effect on the display of the image since contrast in the image is scaled from the lowest to the highest valued point. It’s like accidentally getting the sun in a photograph, which over-saturates the image. A little later you’ll use PV=WAVE commands to remove this meaningless data.

Step 2  Close the WzSurface Tool.
Using Color

Now try looking at the image of the flame with a different set of colors.

**Step 1**  Click the WzColorEdit icon on the Navigator window. The WzColorEdit Tool appears.

**Step 2**  If necessary, move the windows around so that you can see both the WzImage Tool and WzColorEdit.

**Step 3**  In the WzColorEdit Tool, select **ColorTable=>System**. The System Color Tables list box appears.

**Step 4**  To use color more effectively, select the **RED TEMPERATURE** color table and click the **Dismiss** button.

You will see the image in shades of red. It’s still a poor quality image; however, the next few steps will improve it.

**Step 5**  Close the WzColorEdit Tool. (For now, do not close the WzImage Tool. It will be interesting to compare this original image with the enhanced image you will create later)

Rescaling Image Data

You can eliminate much of the undesirable effect of the zeros at the edge of the image by using the PV-WAVE BYTSCl function.

BYTSCl scales your data so that all values below the specified minimum are scaled to 0, and all points with values above the specified maximum are scaled to the new maximum. When the resulting data is displayed, it scales all the points to values ranging from 0 to 255.

In the flame image, all real points fall between 200 and 255. By selecting 200 as a minimum, you set the spurious edge data to the same values as the darkest part of the flame. This will result in a marked improvement in image contrast, so go ahead and make the change.

**Step 1**  Enter the following command at the WAVE> prompt:

```
WAVE> FLAME1 = BYTSCl(IMG8, Min=200)
```
The variable FLAME1 is the byte-scaled data with the effects of the zeros along the edge removed. You will now select and view the data as an image to see the improvement.

Instead of using the Navigator, let’s see how a VDA Tool can be started directly from the command line. All VDA Tools can be started in this manner, without going through the Navigator.

Step 2   At the WAVE> prompt, enter the following command:

    WAVE> WzImage, FLAME1

The rescaled image is displayed in the WzImage Tool.

![Rescaled data displayed in WzImage Tool](image)

**Figure 3-12** Rescaled data is displayed in the WzImage Tool.
Resizing the Image

Use the REBIN function to increase the size of the image.

**Step 1** Enter the following command at the WAVE> prompt:

```
WAVE> FLAME2 = REBIN(FLAME1, 512, 512)
```

**Step 2** Open the WzVariable Tool.

**Step 3** In the WzVariable Tool list, select the variable FLAME2.

**Step 4** Select **File=>Export Variables** from the WzVariable Tool menu bar. The Export Variables dialog box appears.

**Step 5** Select FLAME2 in the upper list box of the dialog box and WzImage_1 in the lower one.

**Step 6** Click the OK button in the Export Variables dialog box.

**Step 7** Resize the WzImage window so the entire image fits in the display area.

![Image](image.png)

Figure 3-13 The resized image is displayed in the WzImage Tool.
The image now is much larger and fills the view area. As a result of resampling, the image has a blotchy appearance. Next, you will smooth the image.

**Smoothing the Image**

The smoothing algorithm works by changing the values based on nearby values. The PV-WAVE SMOOTH command takes a *width* parameter, which should be chosen as small as possible to still provide adequate smoothing. The larger the value of width, the more nearby values are considered in the smoothing algorithm. The effect is greater smoothing at the risk of losing detail. With this data, a good value to use for width is 7.

**Step 1** Enter the following command at the WAVE> prompt:

WAVE> FLAME2 = SMOOTH(FLAME2, 7)

**Step 2** Now view the smoothed image of FLAME2 by clicking on the Redraw button in the button bar of the WzImage Tool.

![Smoothing Image Example](image)

*Figure 3-14* The smoothed image is displayed in the WzImage Tool.
The image is noticeably smoother. If you like, experiment with different values of width.

**Cropping the Image**

Even though the spurious edge data is no longer affecting the quality of the flame image, you may want to remove this data by cropping the image. To graphically crop an image, you will use the Data Selection function.

**Step 1** Click the Data Selection button on the button bar of the WzImage Tool or choose Edit=>Data Select.

**Step 2** Press and drag MB1 to draw a rectangle around part of the image, approximately as shown in the following figure.

![Figure 3-15](image.png) Part of the image data is selected using the mouse.
Step 3  Select **File=>Export Selected Data** in the WzImage Tool. The Export Selected Data dialog box appears. This dialog box contains two list boxes. The first list box contains the name of a variable that was created to hold the subsetted data. The second list box contains the names of the VDA Tools that are currently open.

Step 4  Select the variable name `FLAME2_SUB` in the first list box, and select `WzImage_1` in the second list box.

Step 5  Click **OK**.

The subsetted variable is exported back to the original WzImage Tool. The exported variable is automatically displayed in the WzImage Tool.

Notice how cropping the image affects its appearance.

**Figure 3-16** The image contrast is improved by cropping spurious edge data.
Creating an Inverted Image

You can create an inverted image by subtracting the value of each element in the variable from 255.

NOTE The number 255 is used because the data was byte scaled into the range 0-255. If, for example, the data was in the range 0-127, then inversion would be achieved by subtracting your data from 127, and so on.

Step 1 Enter the following command at the WAVE> prompt:

WAVE> FLAME3 = 255 - FLAME2_SUB

Step 2 In the WzVariable Tool, select Options=>Redisplay List. The FLAME3 variable appears in the list.

Step 3 In the WzVariable Tool list, select the variable FLAME3.

Step 4 Select File=>Export Variables from the WzVariable Tool menu bar.

Step 5 Select FLAME3 in the upper list box and WzImage_1 in the lower one.

Step 6 Click OK.

You now see an inverted image of the flame.
You can select your own combinations of red, green, and blue for a color table to see different effects in the image display. In this example you will change the color of data with values 40 and 60.

Step 1  Click the WzColorEdit icon in the Navigator window. The WzColorEdit Tool appears.

Step 2  Enter 40 in the Selected Color text field, and press <Return> to select color table index 40.

Step 3  Place the pointer on the slider portion of the scale labeled Blue. Press and hold down MB1 and drag the slider to the right to set this color index to a shade of blue. Release MB1 after adjusting the scale.

**Figure 3-17** The flame image has been inverted.

---

**Editing Color**

You can select your own combinations of red, green, and blue for a color table to see different effects in the image display. In this example you will change the color of data with values 40 and 60.

Step 1  Click the WzColorEdit icon in the Navigator window. The WzColorEdit Tool appears.

Step 2  Enter 40 in the Selected Color text field, and press <Return> to select color table index 40.

Step 3  Place the pointer on the slider portion of the scale labeled Blue. Press and hold down MB1 and drag the slider to the right to set this color index to a shade of blue. Release MB1 after adjusting the scale.
You can see the changes in the color display of the image as you interact with the slider.

**Step 4**  Now do the same for the color index 60, but make it green.

![WzColorEdit Tool](image)

**Figure 3-18** Editing colors using the WzColorEdit Tool.

Take a moment to look at the remarkable highlighting effects in the flame image. Try experimenting with other color changes.

**Step 5**  Close the **WzColorEdit** Tool.

**Step 6**  Finally, compare this enhanced, modified image with the original image displayed in window **WzImage_0**.

---

**Experimenting on Your Own**

In this session, you have learned how to do the following:

- Read 8-bit image data from a file.
- Use PV-WAVE commands to improve the quality and contrast of an image.
• Interactively subset an image before performing further analysis on a region of interest.
• Change the appearance of an image by selecting a different colortable.

If you have any 8-bit (or byte) data of your own that would lend itself to visual display, try it.

---

**Saving the Session**

When you save a Navigator session, you can save all or some of the VDA Tools that are currently open. Once the session is saved, you can reopen it at any time, fully restoring the VDA Tools and data that was saved.

**Step 1** Select **File=>Save Session** from the Navigator menu bar. The Save Session dialog box appears.

**Step 2** In the Save Session dialog box, select the following items from the list using MB1 to select the first item and <Shift>-MB1 to select the others: WzImage_0, WzImage_1, WzVariable_0.

**Step 3** In the **Session File Name** text field, type: `flame.sav`

**Step 4** Click the **OK** button.

Now the session is saved. To restore the session at any time in the future, simply start PV-WAVE and the Navigator, then use the **File=>Restore Session** function from the Navigator menu bar.

---

**Ending the Session**

You can now either exit the PV-WAVE session or start a new tutorial without quitting.

• To exit the Navigator, select **File=>Close** on the Navigator window.
• To exit PV-WAVE type **EXIT** at the **WAVE>** prompt.
Animating Image Data

In this example, you’ll get a chance to experiment with animation using the VDA Tool WzAnimate. You observe the animation in the same manner that you would view a movie — by the rapid display of a series of still graphics.

We chose an example that allows you to observe how a shock wave, radiating through a block of graphite composite, is reflected off the boundaries of the block. You’ll also get some practice adding annotation to a plot.

Step 1   If you are not presently running the Navigator, you will need to start it now. Follow the same procedure to start the Navigator as you followed in the previous two examples.

Step 2   Close any VDA Tools that are currently open.

Importing the Animation Data

Start by importing some multidimensional shock wave data into PV-WAVE. The data for this exercise has been provided for you as a save file. The data was generated in this format using PV-WAVE commands.

Step 1   To read the PV-WAVE save file, enter the following command at the PV-WAVE prompt:

```
WAVE> RESTORE, !Data_Dir+'shock_wave.sav'
```

Now the data is ready to use as a series of PV-WAVE variables.

Step 2   Click on the WzVariable icon in the Navigator window. The WzVariable Tool appears.

Step 3   Resize the WzVariable Tool by dragging the bottom right corner downward until the window is about six inches long. Resizing allows you to avoid scrolling to select variables.

Note that a series of variables beginning with “DSP” and “STR” appear in the WzVariable Tool list. All of these variables were imported from the same save file.

The variables represent data from 14 time slices taken at 1 millisecond intervals. The variable with the name beginning in DSP contains displacement data. These data values represent the magnitude of the displacement of molecules from their
equilibrium position in a plane in the block. The variables with names beginning in STR contain stress data. These data values represent stress on points in the plane. Each variable contains an array of 55-by-40 displacement or shock values. That is, each of the 55 slices has 40 points at which data was measured.

**Viewing Displacement as an Image**

To begin, increase the size of the image DSP14 using the REBIN command and then view the image to see what it looks like before you animate it.

**Step 1**  Enter the following command at the PV=WAVE prompt:

```
WAVE> DSP_MAG = REBIN(DSP14, 55*10, 40*10)
```

This increases the size by a factor of ten. Remember that with REBIN, any array you create must be a multiple or factor of the original array.

**Step 2**  In the WzVariable Tool, select **Options=>Redisplay List**. The newly created variable now appears in the list.

**Step 3**  Click on the DSP_MAG variable in the WzVariable Tool. Now that variable is selected and ready to be displayed as an image.

**Step 4**  Click the WzImage icon in the Navigator window.
The image is displayed in the WzImage Tool.

**Step 5**  Click the WzColorEdit icon in the Navigator window.

**Step 6**  Select **Colortable=>System**, and then select **Blue-Red** from the color-table list.

You’ll notice that the color of the image has changed to blue and red.
Step 7  Click on **Dismiss** in the System Color Table list.

Step 8  Close the **WzColorEdit Tool**

Step 9  Close the **WzImage Tool**.

**Shading and Rotating a Surface View**

Now create a surface view using two variables. Use **DSP14** for the surface, and shade it using **STR14**. By shading the surface, you create a view that contains more information than can be obtained from either variable alone.

**Step 1**  In the WzVariable Tool list, select **DSP14**.

**Step 2**  Click the **WzSurface** icon in the Navigator window.

**Step 3**  Select **Attributes=>Surface Attributes** from the WzSurface menu bar. The Surface Attributes dialog box appears.
Now select your view attributes by interacting with some option menus.

**Step 4** Select None for the Surface attribute (in the Surface option menu in the dialog box).

**Step 5** Now select From Variable from the Shading option menu.

**Step 6** Type STR14 in the Shade Variable text input field.

**Step 7** Select the OK button. The Surface view window with the shaded surface appears.

![Image of Surface View Window](image)

**Figure 3-20** The default view displays a surface at a 30 degree angle of rotation about the z-axis, which is displayed as the vertical axis.

The default view displays a surface at a 30 degree angle of rotation about the Z axis, which is displayed as the vertical axis. However, your individual surface plot might be better viewed from a different angle. The WzSurface Tool lets you rotate to any view angle.

Practice changing the rotation by changing the angle to 120 degrees.
Step 8  Select the value 30 next to the Z Rotation slider and change the value to 120. Press <Return> to confirm the rotation change.

Step 9  When you finish viewing the surface, close the WzSurface Tool.

Building an Animation Sequence

Next, you will create an animation sequence with the WzAnimate Tool. You individually create the frames that will be animated and store them in a variable. After the sequence is complete, you can animate the frames forward or backward. WzAnimate displays the views in rapid sequence, allowing you to get a dynamic, interactive view of your data.

For this example, you're animating surface views of the data. The first step is to create an animation array.

Defining an Animation Array

You will create the array at the same time that you store the first frame. Your animation sequence will consist of six “snapshots” of the shock wave.

Step 1  Select STR01 in the WzVariable list.

Step 2  Click the WzSurface icon in the Navigator window. A WzSurface Tool appears displaying the first set of stress data.
Step 3  In the WzSurface Tool, select **File=>Export As Pixmap**. The Export Pixmap dialog box appears. Note that the name `ANIMATE_0` appears in the Pixmap Variable Name text field, and the Add to Pixmap Variable button is selected.

Step 4  Click **Apply**.

At this point, the plot in the WzSurface display area is saved as a pixmap in the variable called `ANIMATE_0`.

Step 5  Select `STR02` through `STR06` in the WzVariable list. To select multiple elements of a list, click MB1 on the first element, and click Shift-MB1 on each subsequent element.

Step 6  Select **File=>Export Variables** in the WzVariable Tool.
Step 7 In the Export Variables dialog box, select STR02 in the upper list box
and make sure that WzSurface_0 is selected in the lower list box.

Step 8 Click Apply in the Export Variables dialog box. This exports the variable
STR02 to the WzSurface Tool, which displays the variable in its view
area.

Step 9 Click the Apply button in the Export Pixmap dialog box. Now, you have
stored a second pixmap in the variable ANIMATE_0.

Step 10 Repeat steps 7, 8, and 9 four more times, each time selecting the next
variable, until STR03, STR04, STR05, and STR06 are stored in
ANIMATE_0.

Step 11 When you have saved all variables, close the Export Pixmap dialog box
by clicking the Cancel button.

Step 12 Close the Export Variables dialog box by clicking the Cancel button.

Step 13 Select Options=>Redisplay List in the WzVariable Tool. The variable
ANIMATE_0 appears in the list.

Step 14 Double-click on the variable name ANIMATE_0 in the WzVariable list.
The Variable Information dialog box confirms that this is a 3D variable (640-by-
512-by-6). The first two dimensions hold the image data, and the third dimension
represents the number of individual pixmaps in the animation sequence. For exam-
ple, if the dimensions of a variable were 512-by-512-by-30, the variable, when
viewed in the WzAnimate Tool, would produce a loop or cycle consisting of 30
frames.

Step 15 Click OK to dismiss the Variable Information dialog box.

Step 16 Close the WzSurface Tool.

You have now stored a six-frame animation sequence. You are ready to view the
animation sequence.
**Viewing Animation**

Now view the animation to see how the shock wave develops.

Since you did not define an animation array name, the array was given the default name, `ANIMATE_0`.

**Step 1** In the WzVariable Tool, select `ANIMATE_0` from the list. Ensure that all other variables are deselected.

**Step 2** Click the WzAnimate icon in the Navigator window.

The WzAnimate Tool appears.

![WzAnimate Tool](image)

**Figure 3-22** Using the WzAnimate Tool to view successive data “snapshots”.

Now you’re ready to play the animation in a variety of ways:

**Step 3** Select the Continuous button in the controls area.

**Step 4** Select the Forward button to run the animation frames forward.
You may want to try some of the other animation controls, such as the \textbf{Reverse button} and the \textbf{Stop button}.

\textbf{Step 5} When you are finished viewing the animation, select the \textbf{Stop button} and then close the WzAnimate Tool.

---

\section*{Changing the Appearance of a Plot}

After a plot is created, you can change its appearance and annotate it. For example, you may want to do this before showing the plot to someone else, before printing it for your files, or to prepare an illustration for a publication.

For this example, you can use a surface view of \texttt{STR14}. You’ll change the colors of parts of the plot, select a font to use for a title you’re giving the plot, and place the title on the plot.

\textbf{Step 1} Select \texttt{STR14} from the WzVariable list. Make sure that all other variables are deselected.

\textbf{Step 2} Click the \texttt{WzSurface} icon in the Navigator window.

\textbf{Step 3} Select \texttt{Attributes=>Surface Attributes}. The Surface Attributes dialog box appears.

This dialog box offers a variety of options to enhance the appearance of a plot. We’ll suggest a particular set of attributes, but you may want to experiment using your own attributes.

\textbf{Step 4} Click the \texttt{Upper Color} button and select the color white from the color bar, then click \texttt{OK}. This choice will make the top of the surface white (color 1).

\textbf{Step 5} Click the \texttt{Lower Color} button and select the color red from the color bar, then click \texttt{OK}. This choice will make the base (underside) of the surface red (color 3).

\textbf{Step 6} Select the \texttt{Skirt} checkbox to highlight the edge of the surface with a skirt.

\textbf{Step 7} Select the \texttt{OK} button of the Surface Attributes dialog box to apply the attributes and exit the dialog box.

\textbf{Step 8} Select \texttt{Attributes=>View Attributes}.
Step 9  Click the Background Color button and select the color blue (color 5) from the color bar, then click OK.

Step 10 Click OK in the View Attributes dialog box.

Now add a title to your plot.

Step 11 Select Attributes=>Defaults=>Text Object. The Default Text Attributes dialog box appears.

Step 12 Click the Color button and select the color cyan (color 6) from the color bar, then click Dismiss.

Step 13 Select Complex Roman from the Font option menu.

Step 14 Enter 2 in the Size field and 2 in the Thickness field.

Step 15 Click the OK button.

Step 16 Select the Create Text Object icon on the WzSurface Tool button bar, or select Create=>Text Object.

Step 17 Position the pointer near the upper-left corner of the plot and click MB1. Then type Shockwave Displacement Magnitude and press <Return>.

The surface plot of STR14 now includes a title at the top of the plot.
Figure 3-23 Changing the appearance of the plot using the Attributes menu.

**Saving and Using a Template**

Now that you have a surface plot set up with annotation, colors, and other attributes, you can save these setups as a template. Then, you can open other surface plots with the template, and those plots will contain the same color, text, and other setups.

This feature can be useful if you want to achieve a consistent look or style in your graphics output. For example, you could create a template with a custom legend in one corner and a company logo in another.

**Step 1** Select File=>Save Template As from the Navigator menu bar. The Save Template dialog box appears.
Step 2 In the Enter File Name field, enter the name of a file for the template. Give the filename a .tpl extension, for example STR14.tpl.

Step 3 Click OK.
Now that the template is saved, you can use it with other surface plots.

Step 4 Close the WzSurface Tool.

Step 5 Select Defaults=>WzSurface from the Navigator menu bar. The Default VDA Tool Attributes dialog box appears.

Step 6 In the Template File Name field, enter STR14.tpl (or whatever you named the template file). Or, you can use the Browse button to locate and select the file.

Step 7 Click OK.

Step 8 In the WzVariable Tool, select STR13.

Step 9 Click the WzSurface icon in the Navigator window.
A new surface appears with all the same annotations and other setups that were saved in the template.

---

**Saving a Plot**

You can save a specific plot, along with all of its annotation and other attributes, for future use in another application, such as a desktop publishing system.

Step 1 To save the plot, select File=>Print Setup. The Printer Setup dialog box appears.

Step 2 Select Postscript from the Printer Type option menu.

Step 3 Select the Print to file button and type shock_wave_plot in the Print to file text field, then select the OK button. The plot is saved as a PostScript file.

Step 4 Close the WzSurface Tool.
PostScript files can be saved in three different formats; you make your choice with an option menu in the Postscript Options dialog box. This dialog box is displayed when you select the Options button in the Printer Setup dialog box.
Encapsulated or encapsuled interchange (EPSI) PostScript files can be used with other applications. For example, you may want to import the file directly into a desktop publishing system to prepare a publication with embedded graphics. If you export the file with the EPSI option enabled, some publishing systems will be able to display the plot on the screen, as well as having it appear in the hardcopy output.

---

**Experimenting on Your Own**

By now, you have a good idea of how to use the Navigator and VDA Tools features of PV-WAVE: Visual Exploration.

VDA Tools provide a rich environment for doing visual data analysis. This tutorial covered only a portion of the VDA Tool capabilities. We encourage you to try out the following features. You can read more about them in the online help system:

- **Code generation** — Save the PV-WAVE code used to create a plot in a file. You can then use this code in other applications.

- **Copy and paste between VDA Tools** — You can copy graphical elements such as text, lines, and rectangles from one VDA Tool and paste them in another VDA Tool.

- **Histogram plots** — Try out the WzHistogram Tool. Use it to analyze quantitative trends in large datasets.

- **Contour plots** — The WzContour Tool displays 2D variables containing contour data.

- **Data export** — The WzExport Tool can be used to export data from a variable to a file.

---

**Exiting PV-WAVE**

To exit PV-WAVE, type `EXIT` at the `WAVE>` prompt.
Beginning PV-WAVE

In this lesson, you will learn some of the techniques that enable you to be more creative and more productive, in less time than ever before. First-time users of PV-WAVE are frequently delighted at how easily they can learn this programming language, and also at how few commands are necessary to achieve complex results compared to other methods of programming.

Figure 4-1 A surface plot that you will create in this chapter.
Before You Begin ...

Before you begin, make sure that PV-WAVE is installed as described in the installation instructions.

Starting and Exiting PV-WAVE

It is very easy to enter and exit PV-WAVE.

UNIX USERS Start PV-WAVE in an xterm window (rather than a shell tool window) if you want to be able to copy and paste text from the online documentation.

Step 1 Start PV-WAVE by entering at the operating system (OS) prompt:

\texttt{WAVE> wave}

After a moment, a message appears in the window telling you the program is initialized and ready for use.

Your prompt sign looks like this: \texttt{WAVE>}

\textbf{NOTE} To do the exercises in Chapter 9, you will need to be running the companion technology products PV-WAVE:IMSL Mathematics and/or PV-WAVE:IMSL Statistics.

Start PV-WAVE:IMSL Mathematics by entering at the \texttt{WAVE>} prompt:

\texttt{WAVE> @math_startup}

Start PV-WAVE:IMSL Statistics by entering at the \texttt{WAVE>} prompt:

\texttt{WAVE> @stat_startup}

Always press the \texttt{<Return>} key after you have completed typing a command.

Step 2 Quit the session. Type

\texttt{WAVE> EXIT}

PV-WAVE closes and the OS prompt is displayed.
Previewing This Lesson

To preview the steps you will take and the plots you will create in this lesson, run the batch file named below.

**Step 1**  Start PV-WAVE by entering at the operating system (OS) prompt

WAVE> wave

**Step 2**  Go to the PV-WAVE code subdirectory for this tutorial. At the PV-WAVE prompt, enter

WAVE> cd, ‘$VNI_DIR/docs/tutorial/code’
   If you are running the UNIX version of PV-WAVE.

WAVE> cd, ‘VNI_DIR:[DOCS.TUTORIAL.CODE]’
   If you are running the OpenVMS version of PV-WAVE.

If you want to verify that you are in the correct directory, at the PV-WAVE prompt, you can enter the dollar sign ($) to precede an operating system command. For example, for UNIX machines, when you enter the command:

WAVE> $ pwd
PV-WAVE prints the present working directory.

Run the lesson preview by entering the following command at the WAVE> prompt:

WAVE> @lesson_3

The batch file lesson_3 runs the programs, demonstrating the steps you will take and the plots you will produce in this lesson.

If a plot window fails to appear when you enter the command @lesson_3, see *Tips for the PV-WAVE Software Family* on page 99.

**TIP**  To ensure that you see the correct colors during the lesson preview, move the pointer so that it is positioned over a PV-WAVE plot window.
Creating and Labeling a Plot

Line plots are the basic expression of many mathematical equations. The PLOT procedure is a rapid method to display data. Your data may be in the form of a named variable.

Creating the Data

Before you can create a plot, you need data for the plot. You will create data by using the FINDGEN function, which returns a single-precision floating-point array with the specified dimensions. Each element of the array is set to the value of its one-dimensional subscript. If you have FrameViewer® online documentation available, use the copy and paste capability to copy commands from the online tutorial and paste them at the WAVE> prompt.

NOTE  Press the <Return> key after you type or paste text at the WAVE> prompt.

Step 1  Create an 801-element vector to hold the values for \( x \). Divide each element of the vector by 5, then subtract 80 from each element to scale the values from \(-80\) to 80. Type (or cut and paste)

```
WAVE> x = FINDGEN(801)/5 -80
```

Step 2  Set \( y \) equal to \( x\sin(x) \).

```
WAVE> y = x*SIN(x)
```

Drawing the Plot

By typing PLOT, followed by the name of the variable you wish to plot, you can easily display a line plot with PV-WAVE. The PLOT command automatically draws \( x \)- and \( y \)-axes and places tick marks on them.

TIP  Use a comma (,) to separate arguments, parts of commands, and so forth.

Step 3  Type

```
WAVE> PLOT, y
```

A plot of the indices versus function appears.
NOTE  This plot is shown with black lines and white background, which is the reverse of what appears on your monitor. Reverse printing is used often in this tutorial to improve readability.

Using Keywords

Keywords are an easy means to add optional parameters to functions, providing variety, power, and flexibility. For example, you can create windows with the WINDOW function. You can modify the size, position, title bar text, and colors used in a window by using keywords for the WINDOW function.

PV-WAVE assigns an index number between 0 and 31 to a window if you do not. The initial default window index number, printed across the title bar, is 0. The default window size is 640 pixels wide by 512 pixels in height.

A single keyword, such as Title, may apply to many functions, such as PLOT, SURFACE, CONTOUR, WINDOW, etc.

Step 4  To change the size of the window, use the XSize and YSize keywords. Add a title by using the Title keyword.

WAVE> WINDOW, 0, XSize = 875, YSize = 800, $

WAVE> Title = ‘PV-WAVE’

The original window is replaced by a new, empty, larger window that has the title PV-WAVE.
The previous plot depicted all of the data. You can explicitly define the data range using the \textit{XRange} and \textit{YRange} keywords.

\textbf{Step 5} Specify the data range.

\begin{verbatim}
WAVE> PLOT, y, XRange = [200, 600], $
\Rightarrow$ YRange = [-40, 40]
\end{verbatim}

\textbf{NOTE} Note that the dollar sign ($) is used to continue a command on the next line. You might not need to enter the dollar sign if your command window is wide enough for the entire command.

The new plot contains a single line with \( x \) values ranging from 200 to 400.

\begin{center}
\includegraphics[width=0.5\textwidth]{plot.png}
\end{center}

\textbf{Obtaining Information About Your Data}

\textit{PV-WAVE} can display information about your data in several ways.

\textbf{Step 1} To determine the type and dimensions of your variables, enter

\begin{verbatim}
WAVE> INFO
\end{verbatim}

\textit{PV-WAVE} returns a list of your variables and of saved procedures and functions. Note that \( x \) and \( y \) are listed as floating-point arrays and the dimensions of each are given. If you ran the lesson preview, several saved variables, procedures, and functions also are listed.
You can print any PV-WAVE data variables to the screen; they are displayed as ASCII characters.

**Step 2** Print each value of \( x \) to the screen.

```
WAVE> PRINT, x
```

All values of \( x \) are displayed in the PV-WAVE window.

**Step 3** Print the values in \( y \).

```
WAVE> PRINT, y
```

To print a specific value, specify the position of the value in the vector.

**Step 4** Print the 604th value of \( y \), enter

```
WAVE> PRINT, y(603)
```

Arrays are indexed from zero, so this must be taken into account.

**Step 5** To print the range of third through the sixteenth values, enter

```
WAVE> PRINT, y(2:15)
```

**Adding Symbols**

PV-WAVE offers eight different types of plotting symbols that you can use to mark the points.

**Step 1** For square symbols, type

```
WAVE> PLOT, y, XRange = [200, 600], $ YRange = [-40, 40], PSym = 6
```

The points are plotted, using squares for the symbols.
Setting $\text{PSym}$ equal to 6 did not draw the connections between the points. Assigning a negative value to the symbol number associated with $\text{PSym}$, i.e., adding a single character, the minus sign ($-$), is all that is necessary to specify that points be connected with lines.

**Step 2** To connect the symbols, and to use a new symbol, type

```
WAVE> PLOT, y, XRange = [200, 600], $YRange = [-40, 40], PSym = -5
```

The triangles representing data points are connected by solid lines.

**Adding Another Line to the Plot**

You can plot more than one line on a single plot. The OPL T function overplots data on the same axes as an existing line. More than 75 keywords can be used with this function,

**Step 1** First, create another data set, $w$, which is a cosine variation of $y$.

```
WAVE> w = x*COS(x)
```

**Step 2** Plot $w$ over the existing plot of $y$.

```
WAVE> OPL T, w, XRange = [200, 600], $YRange = [-40, 40], PSym = -2
```

The new line is plotted with the same axis range as the first line.
Changing the Colors

There are many ways to change and specify color in your plots. In Chapter 8, Using Color, you use some of the newer color manipulation tools; this lesson shows you some classic tools that may be familiar to you if you used PV-WAVE before.

Your plot is in black and white because the default color table is a gray-scale. There are 16 ready-made color tables from which to choose. The default, Black and White Linear, is color table number 0. The other numbers are in the range 1–15.

If your monitor is displaying 24-bit color, some of the commands affecting color in this tutorial may produce unexpected results. You can simulate 8-bit color by entering

```
WAVE> Device, Pseudo = 8
```

before opening a PV-WAVE plotting window. If you ran the lesson preview, 8-bit color was set then, if needed.

If you have a monochrome monitor, other colors are not available. PV-WAVE has device drivers for most monitors and it usually detects and takes the workstation’s default visual class into account during PV-WAVE startup. Most monitors display 8-bit color; this tutorial has a few commands that do not apply to monochrome monitors. For more information on controlling output to monitors, printers, and plotters in the PV-WAVE Software Family, see the PV-WAVE User’s Guide.

Step 1 You can determine the color indices and manipulate colors in the color table. Type

```
WAVE> LOADCT, 5
```

The Standard Gamma II color table is loaded.

To specify a specific color, you can refer to the color’s index number. For 8-bit color, the color indices range from 0–255.

Step 2 Display the numbered colors.

```
WAVE> COLOR_PALETTE
```

The COLOR_PALETTE window appears, displaying alternate colors (of a possible 256-color palette) with the index printed on each. Keep the COLOR_PALETTE window open for later use.

Step 3 Display a full palette that enables you to change the colors in the palette.

```
WAVE> PALETTE
```
The PALETTE window appears, displaying the entire color range at the top and blocks for each color.

Step 4  To obtain instructions for using the PALETTE, move your pointer to Help and click the left mouse button. Instructions for using this tool appear in the PV-WAVE window.

The PALETTE tool also has sliders that you can move to interactively change a specific color. Lines of a plot are drawn in the highest color number by default. The color in the upper-left corner has the index number 0. The lowest color index number is the default color for the plot background.

Step 5  Select the left color block in the second row from the top by moving your pointer to this block and clicking the left mouse button.

You can move the RGB sliders in either of the two following ways:

- press the left mouse button while the pointer is on the slider, drag the pointer across the bar, and release the mouse button
- place the pointer approximately where you want the slider to be and then click the left mouse button

Step 6  Use the RGB sliders to change the color.

The indices to the right of the bars change as the color changes.

The process of interpolating the color indices between two colors in the table is called ramping.

Step 7  Ramp a row of colors. Select the left color block in the fourth row from the top and change the color of it.

Step 8  Move the pointer back to the first color block you changed and click the middle mouse button.

The colors in the second and third rows are changed so that there is a smooth transition of color between the two colors at each end.

Step 9  Experiment with the palette colors.

Step 10  Select Undo All, which is in the lower right corner of the window.

The original palette is restored.

If you click the right mouse button while the pointer is in the PALETTE window, you exit the PALETTE and save the modified colors. You can type
WAVE>  LOADCT, 5
WAVE>  PALETTE
again and the color table and PALETTE are reloaded.

**Step 11** Exit the PALETTE by clicking the right mouse button while the pointer is in the PALETTE window.

Window managers and other programs use some of the colors; you rarely have access to the full range of 256 colors.

**Step 12** To see how many colors are available, enter

WAVE>  INFO, !D.N_Colors
The exclamation mark (!) preceding a word indicates a system variable, which is a special predefined variable.

The total number of available colors will vary because other programs allocate colors also, but PV-WAVE distributes the colors of a color table across the available range. !D.N_Colors is a system variable that is also useful in writing code for colors, as shown in the next example.

**Step 13** Now, plot the lines in the color that has an index number equal to the total available minus 40 and change the background color to index 46. Type

WAVE>  PLOT, y, XRange = [200, 600], $ YRange = [-40, 40], PSym = -5, $ Color = !D.N_Colors -40, Back=46

*Color* specifies the number of the color to use for drawing. *Back* specifies the number of the color to use for the background.

What if only approximately 128 colors are available? The previous commands might not produce the desired colors. In some cases, it may be better to specify a percentage of the total number of available colors.

The default linestyle, 0, is a solid line. Five other styles of dotted and dashed lines are available. For example, linestyle 4 specifies a dash-dot-dot-dot line.

**Step 14** Overplot the other set of data in a different linestyle.

WAVE>  O PLOT, w, XRange = [200, 600], $ YRange = [-40, 40], PSym = -2, $ Color = !D.N_Colors*.6, $ LineStyle = 4
The linestyles and their index numbers are:

<table>
<thead>
<tr>
<th>Index</th>
<th>Linestyle</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Solid</td>
</tr>
<tr>
<td>1</td>
<td>Dotted</td>
</tr>
<tr>
<td>2</td>
<td>Dashed</td>
</tr>
<tr>
<td>3</td>
<td>Dash Dot</td>
</tr>
<tr>
<td>4</td>
<td>Dash Dot Dot</td>
</tr>
<tr>
<td>5</td>
<td>Long Dashes</td>
</tr>
</tbody>
</table>

Recalling Previous Commands

To recall the line you typed in Step 1, or any of the last 20 lines of text you typed:

**Step 1**  To display your last line of input, press the up (↑) arrow key.

PV-WAVE returns the last line you typed.

**NOTE** If you did not see your previously-entered command echoed at the prompt, you may be running PV-WAVE from a shell tool, which does not, in all cases, permit command recall. An xterm window does allow command recall. If you are running PV-WAVE in a shell tool, try exiting and starting PV-WAVE in an xterm window. Copy and paste enough commands to recreate the plot seen in Step 14 in the previous section.
Step 2  Press the up (↑) arrow key again.
Your last line of input is recalled.
You can edit, erase, copy and re-enter any of these lines.

Step 3  To review as many as the last 20 lines you input, type

WAVE>  INFO, /Recall_Commands
Up to 20 lines are displayed from the input buffer.
Using this feature, you can easily correct errors and you rarely need to retype an entire command.

Step 4  Press the down (↓) arrow key until there is no longer any text at the prompt.

Adding Labels to the Plot
You can place labels on the x- and y-axes, as well as a title and subtitle on your plot.
You may use the default font, Simplex Roman, or select from any of 15 other built-in fonts.

Using Built-in Fonts
The built-in fonts can be rotated in plots. These vector-drawn fonts were originally digitized by Dr. A. V. Hershey of the Naval Weapons Laboratory. The font character sets include serif, non-serif, script, regular and oblique English, as well as Greek, math and special symbols, and several others, which provide the capability to print almost any character you desire. You can access device dependent hardware-generated fonts as well. (See the PV-WAVE User’s Guide for information on using hardware-generated fonts.)

Step 1  To see what each font looks like, enter the following command. (Be sure you are in the code directory — see page 67.)

WAVE>  @showfonts
Each character of each of the fonts is displayed alongside its corresponding keyboard key.
**Step 2**  Delete the window. Type

`WAVE>` **wdelete**

**Adding Titles**

By default, the *Title* is automatically made to be 1.25 times as large as the titles on the *x*- and *y*-axes.

**Step 1**  Add titles to the *x* - and *y*-axes and a title to the top of the plot.

`WAVE>` **PLOT, y, XRange = [200, 600], $**

▌ **YRange = [-40, 40], $**

▌ **Color = !D.N_Colors -40, Back = 46, $**

▌ **XTitle = ‘Index’, YTitle=‘Function’, $**

▌ **Title = ‘!17PV-WAVE 2D Plot’**

The designated titles are added to your plot.

The font designated for the *Title* was inherited by all other characters in the plot. Font specification remains in effect until another font is specified. If you wanted to have all titles in font 17 and all axis numbers in the default font (3), you would need to enter

`XTite = '!17Index!3', $`

`YTitle = '!17Function!3', $`

`Title = '!17PV-WAVE 2D Plot!3', $`

Adding the “!3” at the end of the text string drawn last (the *YTitle* string in this case) would cause the default font to be used thereafter, in this and in subsequent plots.
Adding Today’s Date to the Plot

Information relating to dates and times is essential to many types of data processing. PV-WAVE has many ways to incorporate and manipulate calendar-based information.

**Step 1** Create the variable `a` to hold today’s date by using the TODAY function.

```
WAVE> a = TODAY()
```

The optional parentheses provide complete current time information.

**Step 2** Print the contents of `a`.

```
WAVE> DT_PRINT, a
```

**Step 3** Convert the variable to a character string and specify that it prints only the day, month, and year.

```
WAVE> DT_TO_STR, a, b, Date_Fmt = 1
```

**Step 4** Add a subtitle that incorporates today’s date into a sentence.

```
WAVE> PLOT, y, XRange = [200, 600], $  
    ➤ YRange = [-40, 40], $  
    ➤ Color = !D.N_Colors -40, Back = 46, $  
    ➤ XTitle = 'Index', YTitle='Function', $  
    ➤ Title = 'PV-WAVE 2D Plot', $  
    ➤ SubTitle='I made this PV-WAVE plot ' + ' + b + '!!'
```

**NOTE** The plus (+) character indicates a character string is to be continued with the information that follows the plus character. For formatting purposes, it is sometimes necessary to break a character string and continue it on the next line.

Today’s date is placed within the character string in the subtitle.

Note that the font is Hershey Triplex Roman, font 17, which was inherited from the last plot.
Using System Variables to Retain Changes

While keywords can be used to make changes to a plot, you may want to make the changes apply to all plots. The keywords affect only the command with which they are associated; their effect does not carry over into subsequent plots. The effects of system variables, on the other hand, remain until they are explicitly countered with a similar command. Many system variable fields have plotting keyword counterparts.

The tick marks along the $x$- and $y$-axes are small by default, to ensure that they will not be too large for small windows. The default value is .02, .05 produces a grid, and negative values place the tick marks outside the plot region.

**Step 1** Make the tick marks smaller.

```
WAVE> !P.TickLen = .01
```

The bottom of the subtitle touched the frame of your window. You can re-position the plot and associated annotation in the window by using the !Region system variable, in which you set the fractional distances for the XMin, YMin, XMax, and YMax parameters.

**Step 2** To re-position the plot so that there is greater margin around the labels, type

```
WAVE> !P.Region = [.0, .04, .98, .95]
```

**Step 3** To double the size of the characters, type

```
WAVE> !P.CharSize = 2
```

**Step 4** Increase the size of the $x$- and $y$-axis characters.

```
WAVE> !X.CharSize = .75
WAVE> !Y.CharSize = .75
```

CharSize indicates the desired multiplier for the default size (1.0) of your characters. !P is a structure variable and Thick, CharSize, TickLen, and Region are fields in this structure.

Specifying a value of .75 makes the $x$- and $y$-axis characters 75 percent as large as those in other text strings, but they will be 150 percent the default value of 1 because 75 percent of 2 is 1.5.
Step 5  Double the thickness of plotted lines by typing
WAVE>  !P.Thick = 2

Step 6  To see the effects of the changes you just made, type
WAVE>  PLOT, y, XRange = [200, 600], $ YRange = [-40, 40], $ XTitle = 'Index', YTitle='Function', $ Title = ‘PV-WAVE 2D Plot’, $ SubTitle='I made this PV-WAVE plot ’ $ + ‘on ’ + b + ‘!!’

WAVE>  OPLOT, w, XRange = [200, 600], $ YRange = [-40, 40], $ Color = !D.N_Colors*.6, $ LineStyle = 4

The line thickness and character sizes are increased in the plot, and the tick marks are shorter.

Placing Labels Within the Plot

The plot would be more informative if it had a legend, such as “Sine” and “Cosine”, to distinguish the two lines. The XYOUTS procedure can draw text at any designated position in the window or currently selected graphics device.

Step 1  Place a text string at a position that begins at $x = 300$ and $y = -30$.
WAVE>  XYOUTS, 300, -30, '!17Sine', CharSize = 2

The word “Sine” is placed at the specified coordinates.

Step 2  Overplot a horizontal line from $x = 350$ to $x = 500$ to represent the first function.
WAVE>  OPLOT, [380, 500], [-30, -30], $ LineStyle = 0, Thick = 3, $ Color = !D.N_Colors -40

A yellow line is drawn next to “Sine.”
**Step 3** Place a text string at a position that begins at $x = 300$ and $y = -35$.

WAVE> XYOUTS, 300, -35, '!17Cosine', CharSize=2

The word “Cosine” is placed at the specified coordinates.

**Step 4** Overplot a horizontal line from $x = 350$ to $x = 500$ to represent the second function.

WAVE> O PLOT, [380, 500], [-35, -35], $\Rightarrow$ LineStyle = 4, Thick = 3, $\Rightarrow$ Color = !D.N_Colors*.6

An orange line is drawn next to “Cosine.”

---

**Resetting System Variables**

**NOTE** If you wish to retain your variables, you should save them before exiting (see the section *Saving Commands and Variables* on page 97).

Most system variables that are set with numeric values can be set back to the default value by setting them to zero or one. The `prep_plot.pro` procedure in

(UNIX) `$VNI_DIR/docs/tutorial/code`

(OpenVMS) `VNI_DIR:[DOCS.TUTORIAL.CODE]`
resets system variables to their defaults, as does the `wd_cleanplot.pro` procedure, which is in

(UNIX)  \$VNI_DIR/wave/demo/gallery3
(OpenVMS)  VNI_DIR:[WAVE.DEMO.GALLERY3]

You can use either procedure to reset system variables, but `prep_plot.pro` also does several other things, such as setting the device to “X” if it is not currently set to “X” and reloading the default color table.

The following steps demonstrate how to return each system variable to its default value without affecting any others (which you can do when you do not want to return all system variables to the default values.)

**Step 1**  Return the system variables to the default values. Type

WAVE>  !P.TickLen = 0.02
WAVE>  !P.Region = [0.0, 0.0, 1.0, 1.0]
WAVE>  !P.CharSize = 1
WAVE>  !X.CharSize = 1
WAVE>  !Y.CharSize = 1
WAVE>  !P.Thick = 1

Subsequent plots will be displayed with the default values.

---

**Creating Surfaces and Contours**

In this exercise, you will create a 3D surface of a function and display it in several different ways. You will create seven windows, each showing a different view of the data.

To demonstrate that PV-WAVE can multiply arrays as easily as integers, this example plots the function

\[ f(x,y) = x \sin(y) + y \cos(x) - \sin(0.25xy) \]

**Step 1**  Create an array \( x \) and set \( x \) equal to \( y \). Store the result in the variable \( z \).

Enter

WAVE>  \( x = \text{FINDGEN}(101)/5 -10 \)
Step 2  Set \( y \) equal to \( x \).

WAVE> \( y = x \)

Step 3  Next, create an empty 101-by-101-element array called \( z \) by using the FLTARR function.

WAVE> \( z = \text{FLTARR}(101, 101) \)

Step 4  Fill the array with the values.

WAVE> \( \text{FOR } i = 0, 100 \text{ DO BEGIN } \)

\( \Rightarrow z(i, *) = x(i) \cdot \text{SIN}(y) + \)

\( \Rightarrow y \cdot \text{COS}(x(i)) - \text{SIN}(0.25 \cdot x(i) \cdot y) \)

Next, resize the current window, which is window 0.

Step 5  To resize the window, type

WAVE> \( \text{WINDOW, 0, XSize = 400, YSize = 400} \)

The window is resized to 400-by-400 pixels.

The first four windows (0-3) you create are, by default, placed in the four corners of the screen, beginning with the upper-left corner. Even-numbered windows (including window 0) are placed in the top half of the screen; odd-numbered windows are placed in the bottom half. Consequently, you need to override the default placements for windows 4 and 5 to prevent them from covering windows 0 and 1.

Step 6  Draw a surface. Type

WAVE> \( \text{SURFACE, } z \)

SURFACE produces a 3D wire-frame model of an array. A wire-frame surface of the data is displayed. (See Figure 4-1)

The current color table displays the lines in white.

Step 7  Change to the Blue-Green-Red-Yellow color table by typing

WAVE> \( \text{LOADCT, 4} \)

LOADCT tells PV-WAVE to load a specific color table. The lines change to yellow.

Step 8  Create a new window and draw a contour by typing
Step 9  Draw a contour plot of $z$ and add a title.

WAVE> CONTOUR, z, Title = 'Contour Plot'
A 2D contour of $z$ is displayed with a title above it.

Step 10  Create a new window and draw a shaded surface. Enter

WAVE> WINDOW, 2, XSize = 400, YSize = 400
The new window appears in the upper-left corner of the screen.

Step 11  Draw a shaded surface of $z$.

WAVE> SHADE_SURF, z
The data is displayed as a light-source shaded surface.

Step 12  Create a new window.

WAVE> WINDOW, 3, XSize = 350, YSize = 350
A window appears in the lower-left corner of the screen.

Display the same data set as an image. The range of data values in a 101-by-101 image is better visualized by replicating the data to fit into your 350-by-350 window (using CONGRID). You can simultaneously scale the values in the image by using BYTSCL.
Step 13  Scale the data by typing

```
WAVE>  z_img = BYTSCL(CONGRID(z, 350, 350))
```

BYTSCL scales the values in the image into the range of !D_N_Colors. CONGRID re-samples the image to a specified dimension. In this case, it makes a 350-by-350 pixel replication of a 101-by-101 image. A quick way to display the image is to use the TV procedure. The TV procedure is only one of several procedures that can be used to display images.

Step 14  Display the data.

```
WAVE>  TV, z_img
```

PV-WAVE displays the image.

Notice that the pixel replication makes a jagged image. You can smooth it using image processing and re-display it in the same window.

Step 15  To smooth and re-display the image, type

```
WAVE>  smooth_z = SMOOTH(z_img, 5)
WAVE>  TV, smooth_z
```

SMOOTH returns a copy of the array smoothed with a boxcar average of the specified width. The result is of the same size and dimension as the array. A smoothed version of the image is displayed.

You can combine graphics and images to get even more information from your data. Use the Standard Library procedure, IMAGE_CONT, to display a contour over the image you made. Standard Library procedures are executable text files that you can read, copy, and edit. All have the .pro extension and reside in

(UNIX)  $VNI_DIR/wave/usr/std
(OpenVMS)  VNI_DIR: [WAVE_USR_STD]

Step 16  Open a new window, placing it to the right of window number 3 by typing

```
WAVE>  WINDOW, 4, XSize = 350, YSize = 350, $:
   XPos = 360, YPos = 0
```

XPos and YPos specify the x and y positions of the lower-left corner of the window, specified in device coordinates. Window 4 appears to the right of window 3.

Step 17  Display the image with a contour plot over it.
Creating Surfaces and Contours

WAVE> IMAGE_CONT, smooth_z

The image is drawn in window 4 with a contour plot over it.

A row profile is a plot of the pixel intensities or values in a particular row of the image. The PROFILES procedure enables you to dynamically select a row or column in a displayed array and plot a profile of the selection.

Step 18 Enter

WAVE> PROFILES, smooth_z

A window titled Profiles appears, and the instructions for its use are printed in the PV-WAVE window.

Step 19 Experiment with PROFILES and then close the PROFILES window by clicking the right mouse button while the pointer is in the image window.

To make a plot suitable for printing, you can extract a row or column and plot it. For window 5, you will take a row profile of the image and plot it.

Step 20 Create window 5 and place it above window 4 by typing

WAVE> WINDOW, 5, XSize = 350, YSize = 350, $
    \Rightarrow$ Xpos = 390, YPos = 543

Window 5 appears above window 4.
Step 21  Extract a row, such as row 51, out of the image, plot it in a new window and add a title. Type

WAVE>  PLOT, smooth_z(*, 50), Title = "Row 51 Profile"

A labeled plot of row 51 appears.

In the last window, you show $z$ three ways in a display that combines a SURFACE plot, a CONTOUR plot, and color-scaled pixels in a single window.

Step 22  Create window 6 displaying the three-part display. Type

WAVE>  WINDOW, 6, XSize = 600, YSize = 600, XPos = 300, YPos = 200 & SHOW3, z

The ampersand (&) allows you to enter two commands on the same line. The array $z$ is displayed as a surface, a contour, and as a pixel image.

Step 23  Consider the effects of a different color table.

WAVE>  LOADCT, 5

The lines on the bottom of the surface are a bright red.

Drag window 6 to a new position if you do not want it covering some other particular window.
Close the Windows

The WDELETE procedure deletes a specified window. You could close all the windows with the following command:

```
WAVE> WDELETE, 0 & WDELETE, 1 & WDELETE, 2 & $
    ➞ WDELETE, 3 & WDELETE, 4 & $
    ➞ WDELETE, 5 & WDELETE, 6 & WDELETE, 31
```

It is much simpler to delete all open windows with a command that states “while any window with a window index number greater than or equal to zero is open, do WDELETE.”

**Step 24** Close all open windows. Enter

```
WAVE> WHILE (!D.WINDOW GE 0) DO WDELETE, $
    ➞ !D.WINDOW
```

This lesson will prove useful regardless of how you plan to use PV-WAVE. In the next lesson, you will learn more fundamental concepts that will prove useful, regardless of how you choose to use PV-WAVE in the future.
Basic Information for Any Session

This lesson presents basic information that you will find useful during any session.

\[ f(x, y) = \left( \Gamma(0.01 + |x|)J_{0}(y)J_{1}(y) \right)^{\alpha} \]

**Figure 5-1** PV-WAVE:IMSL Mathematics functions Gamma and BessJ are used to define a shaded surface. The procedure for creating this plot is presented in Chapter 9, *Advanced Math and Statistics.*
Getting Help with PV-WAVE

You can, at any time, find assistance within PV-WAVE. PV-WAVE is equipped with extensive online help facilities that provide the following basic kinds of information:

• online reference help and context-sensitive help
• complete documentation for the PV-WAVE Software Family, including reference manuals and user’s guides, all with search, copy, and paste capabilities through FrameViewer
• information on the status of the PV-WAVE environment

Online Reference and Context-Sensitive Help

Type HELP at the WAVE> prompt to start the online help system. Online help is available on all platforms and gives you fast access to detailed information on all PV-WAVE commands and on many aspects of the programming language.

The graphical interface components of PV-WAVE: Visual Exploration, such as the Navigator and VDA Tools provide context-sensitive help. Each VDA Tool has a Help menu and all dialog boxes have a Help button that you can use to obtain information on whatever task you are performing.

Using Online Documentation

The complete set of online manuals for the PV-WAVE, the companion technologies, and toolkits is available online after you choose the optional installation of this documentation.

Although the documentation takes a significant amount of space, you will find the information, as well as the search, copy, and paste features, can save you time as you learn to use these products.

To open online documentation, type wavedoc at the operating system prompt.

Using the INFO Command

The INFO procedure gives information about the PV-WAVE session.
**Getting Information About the Session**

Typing INFO, with no additional parameters, displays an overview of the current PV-WAVE session, including one-line descriptions of all variables and the names of all compiled procedures and functions.

**Step 1** To obtain general information about the session, enter

```
WAVE> INFO
```

PV-WAVE returns information about variables, saved procedures and functions, area used for code and data, etc.

**Getting Information on Specific Variables**

To display information about a variable’s type and structure, add a comma (,) and the name of the variable. This makes the variable an argument to the INFO command, as is demonstrated next.

If you opened PV-WAVE at the beginning of this lesson, you have no user-defined variables.

**Step 1** Define a variable to use as an example. Create a 6-element array named `vector`. Type

```
WAVE> vector = [1, 2, 3, 4, 5, 6]
```

**Step 2** Display information on `vector`. Enter

```
WAVE> INFO, vector
```

PV-WAVE returns

```
vector int Array (6)
```

indicating `vector` is a 6-element integer array.

The PRINT command displays the value of variables, but does not retain the value in the memory buffer.

**Step 3** View both `vector` and the tripled value of each element, type

```
WAVE> PRINT, vector, 3*vector
```

PV-WAVE returns

```
1 2 3 4 5 6
3 5 9 12 15 18
```
Many keyword parameters can be used with the INFO procedure. For a complete list of these keywords, see the PV-WAVE Reference.

**Information About System Variables**

You can rapidly determine the settings of your system variables.

**Step 1**  To print the values of system variables, type

\[ \text{WAVE}> \text{INFO, /System\_Variables} \]

The values of the system variables are returned to the screen.

Check the paths in the following system variables:

- !Data\_Dir
- !Gallery\_Dir
- !Open\_Dir

These paths must be set properly for you to run all the examples in this tutorial. For example, the !Data\_Dir variable should be set to the data directory in the main PV-WAVE directory in order to open data files called in this tutorial. If, at any time while you are trying examples in this tutorial, you receive a message saying the file could not be found, or could not be opened or could not be written, it may be because these system variables need to be changed. Your installation procedure should automatically set these paths correctly.

**Changing a System Variable**

You can change the paths for system variables within PV-WAVE, but, at this time, it is better to change a less important system variable.

**Step 1**  Change the WAVE> prompt. Type

\[ \text{WAVE}> \text{!Prompt = "PV-WAVE ADVANTAGE">} \]

Your prompt is now PV-WAVE ADVANTAGE>.

When you change a system variable, the change will remain in effect during the session unless it is explicitly changed.
Interrupting PV-WAVE

Several types of interrupts are available in PV-WAVE. It is better to avoid using interrupts, so try to make sure that programs you write do not require them.

In UNIX, <Control>-C interrupts present activity, aborting commands that were to follow.

To interrupt the display of information, press <Control>-C at the WAVE prompt.

When a procedure or function is interrupted, control of PV-WAVE may stop in the procedure or function instead of returning to the main program level. This transfer of control to the procedure or function level can make variables defined at the main program level temporarily unavailable. Use the RETALL command (discussed in the next section) to return to the main program level.

<Control>-Z (UNIX) and <Control>-Y (OpenVMS) interrupt PV-WAVE and return you to the OS prompt.

To exit, type EXIT at the PV-WAVE prompt. Using <Control>-D (UNIX) and <Control>-Z (OpenVMS) abort the session and return to the OS prompt, but this is a less appropriate method.

Returning to Higher Program Levels

After an error or interrupt occurs inside a PV-WAVE procedure or function, you may find that your program doesn’t run the way you expect or that variables are unavailable. This occurs because PV-WAVE’s context is still inside the called procedure, not in the main program level. As a result, variables defined at the main level are not available at the current level. You can easily return to the main program level.

Entering the command RETALL (Return All) returns PV-WAVE’s context to the main program level, causing the variables to “reappear”. Alternately, you can type the command RETURN whenever you wish to return PV-WAVE’s context to the next highest level (in the case of nested procedures).
Command Recall

Sometimes, you will type a command you later wish to recall. PV-WAVE saves the last 20 lines of input to a buffer so that they can be re-displayed. Once displayed, the command lines can be copied and edited or simply copied and re-entered.

Procedure for recalling the last 20 lines of input text:

WAVE> INFO, /Recall_Commands

You can also use the up (↑) arrow key to recall commands one line at a time.

NOTE  For some systems, this command will work in an xterm window but it will not work in a shell tool window.

Step 1  To see how your keys are set up, type

WAVE> INFO, /Keys

PV-WAVE prints the current key settings.

Operating System Access

Operating system (UNIX or OpenVMS) commands can be executed from within PV-WAVE without quitting the current PV-WAVE session.

To execute a single operating system command from PV-WAVE, enter the dollar sign ($) followed by the desired operating system command.

Step 1  For example, to see a listing of files in the current directory (under UNIX), at the PV-WAVE prompt, type

WAVE> $ ls

The files in your current directory are displayed. Notice this is your home directory unless you have changed directories within PV-WAVE.

Step 2  To enter multiple operating system commands and temporarily suspend PV-WAVE, type

WAVE> SPAWN

The operating system prompt appears.
Now you can enter operating system commands just as you normally would.

**Step 3** To exit the operating system and return to PV-WAVE, at the operating system prompt, enter (for UNIX machines)

```plaintext
WAVE> exit
```
or (for OpenVMS machines)

```plaintext
WAVE> logout
```

---

**Saving Commands and Variables**

You can save all or only some of the commands and variables you use in PV-WAVE. By saving your variables, you are prepared to exit and later restore sessions. By saving sequences of commands, you can create batch files that may be easily called both alone and in other procedures.

**Saving a Session**

PV-WAVE offers you the ability to save and restore your sessions. To recreate a session, you need to be able to restore all the variables you create. With the SAVE command, PV-WAVE enables you to save all, individual, or groups of variables in the current session. The variables are saved in special data files, to which you may add the extension `.dat`.

The command syntax is

```plaintext
WAVE> SAVE, FileName = 'filename', /Variables
```

where `filename` is the name of the file to be saved.

Type the full pathname if you want to save the file to a different directory. If you do not specify a filename, the file is saved as `wavesave.dat`.

If you started PV-WAVE at the beginning of this lesson, the only variable you have defined is `vector`.

**Step 1** To save `vector` so that you can restore it and to receive information about what you saved, type

```plaintext
WAVE> SAVE, FileName = 'vector.dat', $
     /Variables, /Verbose
```
Verbose instructs PV-WAVE to print informative messages about saved objects. PV-WAVE returns something similar to

% SAVE: Portable (XDR) SAVE/RESTORE file.
% SAVE: Saved variable: VECTOR

For more information on keywords you can use with the SAVE command, see the PV-WAVE Reference.

**Restoring a Session**

**Step 1**  To demonstrate that your session information was saved, first type

WAVE> EXIT

**Step 2**  Now type at the operating system prompt

WAVE> % wave

PV-WAVE is initialized.

**Step 3**  To restore your saved session, type

WAVE> RESTORE, 'vector.dat', /Verbose

The session information is restored and PV-WAVE returns

% RESTORE: Portable (XDR) SAVE/RESTORE file.
% RESTORE: Save file written by yourID@your computer and the date
% RESTORE: Restored variable: VECTOR.

**Step 4**  To see vector, type

WAVE> PRINT, vector

PV-WAVE returns

1 2 3 4 5 6
Using Data from Files

Unlike many data visualization products, which require data in specific formats, PV-WAVE can read and write data files in virtually any data format, using general I/O routines, and thus provides unparalleled access to collected data. PV-WAVE can read both free-formatted and user-formatted data, as well as unformatted or binary data.

XDR (eXternal Data Representation) binary data is supported to encourage data portability across machine architectures. Procedures also are available to read and write Sun raster files and 8-bit TIFF files.

This tutorial provides a number of examples for reading data. However, for complete information about how to read your data into PV-WAVE and how to write data to files, see the *PV-WAVE Programmer’s Guide*.

Tips for the PV-WAVE Software Family

This section contains some information to help you improve your use of the PV-WAVE Software Family.

Troubleshooting

PV-WAVE will not open a window for plotting until your machine is set correctly. Two problems frequently occur when users first attempt to run an application from a remote machine on a network.

In UNIX, if you receive a message similar to “Cannot open display”, then you should check your environment variable DISPLAY within a UNIX shell by typing:

```bash
echo $DISPLAY
```

If the display has not been set properly for your local display terminal, then you need to do so, issuing a command such as the following:

```bash
setenv DISPLAY hostname:0.0
```

where `hostname` is the name of your machine.

In OpenVMS, you can issue a command such as the following:

```vms
SET DISPLAY /CREATE /NODE = NODENAME
```

If you receive a message such as “Client is not authorized to connect to Server”, then the system on which PV-WAVE is running is not allowed to create a window...
on your display terminal. To correct this, you should issue the following UNIX
commands on your local display system:

```
xhost + RemoteSystem
```

where RemoteSystem is the name of the system on which PV-WAVE is running.

**Program Area Full**

Eventually, you may see a message from PV-WAVE telling you the program area
is full. You can use the .SIZE executive command to change the amount of space
allowed for the code area. When you type the INFO command at the WAVE>
prompt, you will see information about the code area used and the data area used.
To increase the amount of space allowed for code area, try entering the following:

```
.SIZE 32000
```

When you re-enter the INFO command, you will see the new size and the percent
used.

Three functions exist that enable you to delete variables, processes, and functions;
they are DELVAR, DELPROC, and DELFUNC. The latter two will accept the /All
keyword. All three should be used with caution and only after invoking the INFO
command to determine what you currently have saved.

COMMON BLOCK data can sometimes grow to a larger size than you are willing
to allow. In such cases, you may prefer to set all variables in the COMMON
BLOCK to 0 bytes.

When you exit PV-WAVE without saving your variables, they are lost.

**Improving System Performance**

When many windows are displayed on your screen, it is often useful to reduce the
visual clutter by turning some of the windows into icons. As the number of win-
dows created by the PV-WAVE Family of Products grows, you may notice your
system responding more sluggishly. Each window does require some amount of
system memory to maintain and reserving space for many windows can degrade
the performance of your system. If you do have many windows or icons on the
screen, you may find that closing or removing some of them will improve the per-
formance of your machine.

Close online documents not in use if you would prefer to make the memory avail-
able for running PV-WAVE.
Opening an xterm Window

To copy and paste text from the online tutorial or the online documentation, you need to be running the PV-WAVE Software Family from an xterm window.

You need to be able to access the operating system command that creates xterm windows in order to open an xterm window. If your system does not have the directory for this command in the path, you can change your path or you can move to the appropriate directory.

The executable xterm command usually can be found in one of the following three directories:

/usr/bin/X11
/usr/bin/local/X11

If you are running Motif, you may have a tool to open an xterm window on your root window menu. Open the root window menu by pressing mouse button 3 on the root window (the root window is sometimes called the background).

Managing Default Resources Under X

When you make a change to your resource manager file (.Xresources or .Xdefaults), you need to reload it for the changes to take effect. The xrdb command is an easy method to reload the resource manager file. This command is usually located in the same directory as the xterm command (see previous section).

In this section, a number of the suggestions involve changes to your resource manager file, so methods to reload this file are discussed first.

Using the X Server Resource Database Utility (xrdb)

The X server resource database utility (xrdb) is used to get or set the contents of the RESOURCE_MANAGER property on the root window of screen 0. The xrdb utility also allows for dynamic changing of defaults without editing files.

If no resource manager (such as .Xresources) is defined, the resource manager will look for a file called .Xdefaults in your home directory. You can print the parameters for xrdb to the screen by entering

man xrdb
Reloading .Xdefaults or .Xresources
Whenever you make a change to your .Xdefaults or .Xresources files, the changes do not take effect until the file has been reloaded; reload it by

- exiting and re-entering your window manager or by
- explicitly reloading the file

It is faster to reload the file. For example, if you make the changes to the .Xdefaults file on a Sun workstation, enter the following line at an operating system prompt:

```
WAVE> xrdb -load .Xdefaults
```
or

```
WAVE> xrdb -load .Xresources
```
The newly-created file is reloaded.

Merging Text into .Xdefaults or .Xresources
If you wish to make a change without changing your .Xdefaults file, you can use xrdb with the -merge option. The xrdb program is used to read the resource specification from the standard input file, which is the terminal in this case. Any number of lines can be read by xrdb. The <Control>-D key combination is used to indicate the end of the input file.

Use the man command at the operating system prompt for more information on xrdb.

Online Images, Color, and Memory
Displaying an image in color requires more memory than displaying the same image in black and white. This section shows some ways you can customize the way FrameViewer documents are displayed.

Some Images Won’t Display in the Online Tutorial
If you get a gray area instead of an image where an image should be in the online tutorial, it may be that not enough memory has been allocated for this purpose. Try adding the following lines to your resource manager file (.Xresources or .Xdefaults):

```
Maker.clientBitmapSize: 3500000
Maker.serverBitmapSize: 3500000
```
These lines increase the space allowed for displaying images.

Save the changes, reload your .Xdefaults or .Xresources file, re-start FrameViewer, and re-open the document.

**Online Tutorial Images Are Not in Color**

If you have a color monitor, but none of the images in the online tutorial are displayed in color, adding the following lines to your resource manager file may provide the solution.

```
Maker.colorDocs: True
Maker.colorImages: True
```

Save the changes, reload your .Xdefaults or .Xresources file, re-start FrameViewer, and re-open the document.

You also may see flashing colors as you move from window to window. If you started PV-WAVE and opened a plotting window before you started the online tutorial, all the available colors may have been allocated for use by PV-WAVE before FrameViewer opened.

You can restrict the number of colors used by PV-WAVE. For example, opening the first plotting window with a command such as

```
WINDOW, Colors = -120
```

instructs PV-WAVE to allocate all but 120 of the currently available colors.

**Saving Memory**

If you want to save memory by displaying the images in black and white, change True to False on the lines for Maker.colorDocs and Maker.colorImages.

If you need to save more memory and are not concerned about whether you can see the images, decrease the number of the bytes allocated for

- Maker.clientBitmapSize
- Maker.serverBitmapSize.

**Pasting Text with the XPRIMARY Buffer**

On some systems, you can copy and insert selected text because selected (highlighted) text is stored in the XPRIMARY buffer. For a Sun Workstation, a line in
the .Xresources (or .Xdefaults) file containing the following (or similar) information for the xterm window

.Btn2Up>: insert-selection(PRIMARY, CLIPBOARD)

would make it possible to insert selected text by releasing button 2 in the xterm window running the PV-WAVE Software Family or in the PV-WAVE:Maple window. This feature can save you a lot of time; you may wish to add this line to the appropriate file and re-load the file before you continue. Save the changes.

The next three lines are related to this process.

CLIPBOARD, CUT_BUFFER0

<Key>L8: insert-selection(CLIPBOARD) \n
.Btn3Up>: select-end(CLIPBOARD) \n
To make the changes take effect, it is necessary to re-load the .Xresources (or .Xdefaults) file.
Plotting with PV-WAVE

PV-WAVE makes data plotting easy. Plots, both 2D and 3D, can be displayed with a single command, such as PLOT or SHADE_SURF, and multiple plots can be viewed at the same time. In this lesson, you gain experience using some of PV-WAVE’s plotting commands.

Figure 6-1  A 3D plot of the Pikes Peak, Colorado, region using the SHOW3 procedure.
Previewing This Lesson

To preview some of the plots you will create in this lesson, follow these steps:

**Step 1** Use the CD command to move to the PV-WAVE subdirectory that contains code for the tutorial. At the WAVE> prompt, enter:

```
WAVE> cd, '$VNI_DIR/docs/tutorial/code'
```

If you are running the UNIX version of PV-WAVE.

```
WAVE> cd, 'VNI_DIR:[DOCS.TUTORIAL.CODE]'
```

If you are running the OpenVMS version of PV-WAVE.

**Step 2** Run the lesson preview by entering the following command:

```
WAVE> @lesson_5
```

The batch file runs the programs, demonstrating the plots produced in this chapter.

If the plots fail to display properly because the paths are different at your site, copy the file and make the corrections for the paths. This lesson preview program will try to write (and delete) a temporary file to the /tmp directory (UNIX) or SYS$LOGIN directory (VMS); the directory must be present for all plots to display.

Reading Data from a File

One of PV-WAVE’s most powerful features is its ability to read data files in virtually any file format. Your data can come, for example, from spreadsheets, from your SQL database, from other computer programs, from numerical simulations, and from physical sensors and other data collection devices. Whether your data is row-oriented or column-oriented, formatted or unformatted, PV-WAVE’s general file reading routines can handle it.

Data files fall into two general categories: formatted files, which are usually human-readable ASCII files; and unformatted files, which are machine-readable binary files.

Binary files require less storage space than ASCII files and, for this reason, are often used to store large data sets containing image data. The disadvantage of binary files is that they are often not portable from one computer architecture to another. For example, you would not generally be able to read a binary file created on a computer running VMS if you were working on a computer using a UNIX
operating system. (The XDR format enables you to overcome this problem, however.)

On the other hand, formatted files are almost always portable from one machine to another.

**File Operations and Logical Unit Numbers**

The OPEN commands listed below are used to open files for input or output. Each opened file is assigned a Logical Unit Number (LUN). Other file reading and writing operations refer to the LUN rather than the filename.

- **OPENR**, `lun`, `
filename`
  - Open a file for Reading.
- **OPENW**, `lun`, `
filename`
  - Open a file for Writing.
- **OPENU**, `lun`, `
filename`
  - Open a file for Updating.

There are 128 logical unit numbers, or LUNs, available for you to use. LUNs numbered 1 to 99 can be used directly in an OPEN command like those described above. LUNs numbered 100 to 128 are managed by the GET_LUN and FREE_LUN procedures. Once a LUN in the range of 1 to 99 is assigned to a file, it cannot be reassigned until you close the file or you exit PV-WAVE (which automatically closes the file).

To close a file and release the LUN, use the CLOSE command

```
CLOSE, lun
```

where LUN is the logical unit number assigned to the file. For example, the following OPEN command opens the file named `numbers.dat` and associates the file with logical unit number 1:

```
OPENR, 1, `numbers.dat`
```

The command:

```
CLOSE, 1
```

closes the file and releases logical unit number 1.

You can also use one of the I/O commands that start with the letters “DC_”. These commands, which enable you to read data without having to specify a LUN, are discussed in the *Contour and Surface Plotting* section of this lesson. When you use
a DC command, you do not need to explicitly open and close the file. Data input and output is discussed in detail in the *PV-WAVE Programmer’s Guide*.

**Accessing Data**

The unformatted binary data file used for this example, `pv_wave.spd`, is a digitized speech sample of the name “PV-WAVE”. First, define the initial variables describing the data, and then open a dataset to display.

**Step 1**  Specify the size of the sample and store it in a variable called `original`:

```
WAVE> sig_len = 7519
WAVE> original = INTARR(sig_len)
```

**Step 2**  Create the string variable `sig_file` to contain the name and path to the data:

```
WAVE> sig_file = !Data_Dir + 'pv_wave.spd'
```

Normally, binary data is not portable between different machine architectures because of the way different machines represent binary data. XDR (External Data Representation, developed by Sun Microsystems, Inc.) converts between the machine’s internal and a standard external binary representation for data. XDR is supported to encourage data portability across machine architectures. The `Xdr` keyword is used to access XDR files. OPENW and OPENU normally open files for both input and output. However, XDR files can be open in only one direction at a time.

**Step 3**  Open the file and read the data into the variable named `original`:

```
WAVE> OPENR, 1, sig_file, /Xdr
WAVE> READU, 1, original
```

**Step 4**  Display information about the file. Enter:

```
WAVE> INFO, /Files
```

This displays information about all open files, including the logical unit number assigned to each, filenames, and attributes such as read/write access.

**Step 5**  Close the file:

```
WAVE> CLOSE, 1
```
Step 6  Verify that the file is closed by re-entering:
WAVE>  INFO, /Files

Step 7  Load a color table that will display the data in color:
WAVE>  LOADCT, 12

Step 8  Convert the array to float:
WAVE>  original=FLOAT(original)

Using 2D Plotting Capabilities

Perhaps one of the most common, and certainly one of the most useful, ways to display data is with the simple linear plot.

Processing and Plotting the Signal Data

Step 1  To view a quick plot of this data set, enter:
WAVE>  PLOT, original

The original data is plotted.

Step 2  Now add some uniformly-distributed random noise to this data set; store it in a new variable by entering:
WAVE>  noisy = original + (RANDOMU(seed, $ sig_len)*1000)-500
The RANDOMU function creates an array of uniformly distributed random values. The original data set plus the noise is stored in a new variable called noisy.

**Step 3** Plot noisy and specify a color for drawing it:

WAVE> PLOT, noisy, Color = 180, Psym=1

The line is now jagged.

![Plot of noisy data](image)

**Step 4** Display the original data set and the noisy version simultaneously by entering the following commands:

WAVE> PLOT, original, XTitle = 'Time', YTitle = 'Amplitude'

The original data is plotted again, this time with titles.

WAVE> O PLOT, noisy, Color = 180, PSym = 1

The data in noisy is plotted as points, using crosses to mark the points.

The XTitle and YTitle keywords are used to create the x and y axis titles. The O PLOT command is used to plot the noisy data set over the existing plot of original without erasing.

**Using the SMOOTH Command**

A simple way to smooth the noisy data set is to use PV-WAVE’s SMOOTH routine, which returns a copy of an array smoothed with a boxcar average of a specified width.

**Step 1** Create a new variable to hold the smoothed data set and display it by entering the following commands:

WAVE> smoothed = SMOOTH(noisy, 5)
Step 2  Plot the smoothed data in a different color:

\[ \text{WAVE}> \text{PLOT, smoothed, PSym = 1, Color = 80} \]

Step 3  Compare the smoothed data to the original by overplotting it on the original data and add a title:

\[ \text{WAVE}> \text{PLOT, original, \$} \]
\[ \Rightarrow \text{Title = "Smoothed Data Over Original"} \]

\[ \text{WAVE}> \text{OPLOT, smoothed, PSym = 1, Color = 80} \]

The Title keyword draws the title text centered above the plot, and the smoothed line appears less jagged than the original.

Notice that while SMOOTH did a fairly good job of removing noise spikes, the resulting amplitudes “taper off” as the frequency increases.

Velocity Field Plotting

An example of a more complicated plotting routine written in PV-WAVE is the VEL routine from the PV-WAVE Standard Library. The Standard Library contains many useful functions and procedures written with the PV-WAVE language. The VEL routine plots velocity vectors given arrays of x and y velocity values.

Step 1  Create a dummy set of x and y velocities to visualize by entering:

\[ \text{WAVE}> \text{VX = original#FINDGEN(20)} \]
\[ \text{WAVE}> \text{VY = noisy#FINDGEN(20)} \]

The PV-WAVE matrix multiplication operator (#) is used to make the needed dummy arrays.

Step 2  Now use the VEL command to plot the velocity vectors by entering:

\[ \text{WAVE}> \text{VEL, VX, VY} \]
The information is plotted, with the length of each arrow following the velocity field and being proportional to the field strength.

For most plots, the default appearance is adequate. Nevertheless, you can make the plot more informative by adding a few keywords to the command line.

**Step 3** Specify the length of the lines to be five times as long as the default value (0.1) and specify the number of points to be plotted as six times the default value (200):

```
WAVE> VEL, VX, VY, Length = .5, $ ➠ NVecs = 1200
```

Twelve hundred points are plotted with longer lines than in the previous example.

**More Information on 2D Plotting**

Using just a few PV-WAVE commands, you have performed some powerful plotting tasks. PV-WAVE has many more plotting abilities than the ones you learned in this lesson.

**TIP** For more information on creating 2D plots, see the *PV-WAVE User’s Guide*. 
Contour and Surface Plotting

PV-WAVE provides many techniques, including contour plots, wire-mesh surfaces, and shaded surfaces, for visualizing 2D arrays. This lesson demonstrates a few of these commands.

Accessing a Data Set

First, you need a 2D data set to visualize. This example is a freely formatted file of the Pikes Peak, Colorado, region. The data set contains information about latitude, longitude, elevation, and snow depth, with 2400 single values per variable.

Using the DC_READ_* Functions to Read Files

DC_READ_* functions simplify the process of reading many kinds of files. These functions automate many of the steps required to read data by other methods:

✔ opening the file
✔ assigning it a logical unit number (LUN)
✔ closing the file

These functions include the following:

• DC_READ_FREE — Reads freely-formatted ASCII files. Furthermore, relieves you of the task of composing a format string that describes the organization of the data in the input file.
• DC_READ_FIXED — Reads fixed-formatted ASCII data using a PV-WAVE format that you specify.
• DC_READ_TIFF — Reads a Tag Image File Format (TIFF) file.
• DC_READ_8_BIT — Reads an 8-bit image file.
• DC_READ_24_BIT — Reads a 24-bit image file.

Step 1  Open the data file, using status as the value returned by DC_READ_FREE. Enter:

WAVE> status = $

⇒ DC_READ_FREE(!Data_Dir + $ ‘wd_pike_elev.dat’,$ lat, lon, elev, depth, /Column)
Step 2 Use the INFO command to verify that the new variables *lat*, *lon*, *elev*, and *depth* were created. This command also tells you about the size and data type of the arrays:

```
WAVE> INFO
```

**Creating Arrays to Contain the Data**

**Step 1** Create four 2D arrays to contain the data. Use the REFORM function to reformat the 1D arrays without changing the values numerically:

```
WAVE> lat = REFORM(lat, 60, 40)
WAVE> lon = REFORM(lon, 60, 40)
WAVE> elev = REFORM(elev, 60, 40)
WAVE> depth = REFORM(depth, 60, 40)
```

**Step 2** Enter the INFO command again to see how the arrays have been changed:

```
WAVE> INFO
```

**Plotting with CONTOUR**

One way to view a 2D array is as a contour plot. The large number of keywords available make it possible to create almost any kind of contour plot.

**Creating Basic Contour Plots**

**Step 1** Create a simple contour plot of the elevation by entering:

```
WAVE> CONTOUR, elev
```

The contour lines are displayed.

That command was very simple, but the resulting plot wasn’t as informative as it could be.

**Step 2** Create a customized CONTOUR plot with more elevations and labels by entering:

```
WAVE> CONTOUR, elev, NLevels = 8, /Follow
```

The *NLevels* keyword told CONTOUR to plot eight equally-spaced elevation levels. The *Follow* keyword produced the labels on the contours.
Step 3  Smooth the contours using the *Spline* keyword:

```
WAVE> CONTOUR, elev, NLevels = 8, /Spline
```

The *Spline* keyword also produced labels on the contours.

Step 4  Add more contour levels to get a better picture of the area:

```
WAVE> CONTOUR, elev, NLevels = 24
```
Step 5  The same contour plot can be rendered from a 3D perspective. First, set the default 3D viewing angle by entering:

WAVE>  SURRE

Step 6  By using the T3D keyword in the next call to CONTOUR, the contours will be drawn as seen from a 3D perspective. Enter:

WAVE>  CONTOUR, elev, NLevels = 24, /T3D

The 3D perspective of the contour is plotted.

Step 7  Take advantage of the latitude and longitude data by displaying it along the x- and y-axes:

WAVE>  CONTOUR, elev, lon, lat
Step 8  Make the axes fit the data range by adding the X- and YStyle keywords:

```
WAVE> CONTOUR, elev, lon, lat, XStyle=1, $ YStyle = 1
```

Step 9  Add more contour levels:

```
WAVE> CONTOUR, elev, lon, lat, XStyle=1, $ YStyle = 1, NLevels = 10
```

Step 10 Double the thickness of the contour lines using the Thick keyword:

```
WAVE> CONTOUR, elev, lon, lat, XStyle=1, $ YStyle = 1, NLevels = 10, Thick = 2.0
```

The thicker lines add more definition to the contours.

Step 11 Create a variable to specify the contour levels to display:

```
WAVE> level = [5000, 6000, 7000, 8000, $ 9000, 10000, 11000, 12000]
```
**Step 12** Display the specified contour levels.

```
WAVE> CONTOUR, elev, lon, lat, XStyle=1, $  
    ➤ YStyle = 1, Levels = level
```

**Step 13** Add labels that display the assigned values to the contour levels:

```
WAVE> CONTOUR, elev, lon, lat, XStyle=1, $  
    ➤ YStyle = 1, Levels = level, $  
    ➤ C_Label = [1, 1, 1, 1, 1, 1, 1, 1]
```

**Step 14** Increase the size of the characters on the contour labels by 25%:

```
WAVE> CONTOUR, elev, lon, lat, XStyle=1, $  
    ➤ YStyle = 1, Levels = level, $  
    ➤ C_Label = [1, 1, 1, 1, 1, 1, 1, 1], $  
    ➤ C_Charsize = 1.25
```

The custom contour labels are larger than the tick labels.
Using Color in Contour Plots

The TEK_COLOR command loads 32 predefined, unique, highly saturated colors into the bottom 32 indices of the color table. When the TEK_COLOR color table is in effect, you will be able to easily differentiate the different data sets in a plot.

Chapter 8, Using Color, discusses additional color manipulation tools.

Step 1 Load a color table that specifies the first 32 distinct colors in the lower end of the color table:

WAVE> TEK_COLOR

Step 2 Bring up the COLOR_PALETTE window. This window displays the colors in the color table, and enables you to see the 32 colors (0-31) in the TEK_COLOR palette. The COLOR_PALETTE window is useful as a reference when you are choosing plot colors.

WAVE> COLOR_PALETTE

Step 3 Create a variable that specifies the indices for the colors of the contour levels:

WAVE> color1 = [11, 10, 1, 5, 8, 19, 7, $ 3, 31]
**TIP** The color table indices specified in the array must be in the range \([0 \ldots 31]\)
to take advantage of the bright colors created by the TEK_COLOR procedure. Color table indices above 31 are not affected by the TEK_COLOR procedure, and will remain as defined by the previously loaded color table.

**Step 4** Now display the contour levels in colors, smooth the contours, and add titles to the x- and y-axes:

```
WAVE> CONTOUR, elev, lon, lat, XStyle=1, $
          YStyle = 1, Levels = level, $
          C_Label = [1, 1, 1, 1, 1, 1, 1, 1], $
          C_Charsize = 1.25, C_Colors=color1, $
          /Spline, XTitle = 'Longitude', $
          YTitle = 'Latitude', Thick = 2
```

The color further defines the contour lines.

**Creating 3D Contour Plots**

You can create a 3D contour plot of the elevation using colors for the contour lines.

**Step 1** Use the color palette in TEK_COLOR to choose the colors, then create a variable to specify the color indices for the lines:

```
WAVE> TEK_COLOR
WAVE> color2 = [17, 23, 16, 2, 3, 5, 7, 1, $
             4, 31, 8, 9, 10, 11, 13, 15, 30, 19, $
             20, 21]
```

**Step 2** Use the SURFR procedure to duplicate the rotation, translation and scaling of the SURFACE procedure:

```
WAVE> SURFR
```

**Step 3** Create the contour plot in 3D space:
The lines are displayed in the specified colors.

**Step 4** To better see how SURFR works, change the rotation and then re-draw the plot:

WAVE> SURFR, AX = 0, AZ = 210
WAVE> CONTOUR, elev, NLevels = 20, $
   \text{ C Colors = color2, /Follow, /T3D}$

The x-y plane appears parallel to the bottom of the window.

**Filling the Contours with Color Using CONTOURFILL**

You can shade enclosed contours generated by the CONTOUR procedure with the CONTOURFILL procedure. The basic syntax for this procedure is:

CONTOURFILL, 'filename', z, x, y

**Step 1** Use the CD command to move to a directory where you have write privileges:

WAVE> CD, 'pathname'
Step 2  Write the contouring information to a file:

WAVE> CONTOUR, elev, XStyle=1, YStyle=1, 
    $  
    ➤ Levels = level, 
    $  
    ➤ Path_Filename = 'peak_elev.dat'

The information is saved to the specified file.

Step 3  Now plot the shaded areas, using the colors you specified earlier:

WAVE> CONTOURFILL, 'peak_elev.dat', elev, 
    $  
    ➤ Color_Index = color1

Now you are ready to display the contour lines. Using the NoErase keyword, you can draw them on top of the current plot. To be sure they will show up, draw the lines in black.

Step 4  Create a variable that specifies the color black:

WAVE> color3 = 0

Step 5  Now draw the contour lines on top of the colors:

WAVE> CONTOUR, elev, XStyle=1, YStyle=1, 
    $  
    ➤ Levels = level, 
    $  
    ➤ C_Label = [1, 1, 1, 1, 1, 1, 1], 
    $  
    ➤ C_Charsize = 1.25, C_Colors = color3,$
    ➤ /NoErase

The black lines clearly define the edges of the filled contours.
Step 6  You can make the lines show up better by doubling the thickness of each. Use the C_Thick keyword, which is specifically for the contour lines:

```
WAVE> CONTOUR, elev, XStyle=1, YStyle=1, $
    ➤ Levels = level, $
    ➤ C_Label = [1, 1, 1, 1, 1, 1, 1, 1], $
    ➤ C_Charsize = 1.25, C_Colors = color3,$
    ➤ /NoErase, C_Thick = 2.
```

The black contour lines appear twice as thick.

NOTE  For more information on contouring, see the PV-WAVE User’s Guide.
TIP In addition to the CONTOUR procedure, you can create contour plots with the CONTOUR2 procedure. CONTOUR2 is particularly useful for plotting irregularly gridded or “scattered” data. Furthermore, CONTOUR2 includes a Fill keyword that allows you to produce filled contours without using the CONTOURFILL method. For detailed information and examples of CONTOUR2, see the PV-WAVE Reference.

Plotting with SURFACE

Step 1 To view the array elev as a 3D, wire-frame surface, just enter the command:

WAVE> SURFACE, elev

A wire-frame representation of the array is displayed.

The SURFACE command can be used to view your data from any angle:

Step 2 Add the latitude and longitude information:

WAVE> SURFACE, elev, lon, lat

The x- and y-axes of the new plot contain the latitude and longitude information.

Step 3 Make the axes fit the data and increase the character size:

WAVE> SURFACE, elev, lon, lat, XStyle=1, $ CharSize = 1.75
Step 4  Make the peaks easier to see by drawing only the horizontal lines. Specify that the bottom of the surface be drawn in yellow (color number 7):

```
WAVE> SURFACE, elev, lon, lat, XStyle=1, $
    CharSize = 1.75, /Horizontal, Bottom=7
```

The new plot demonstrates that plotting half as many lines as the wire frame mesh provides ample information.

**NOTE**  The default viewing angle is quite suitable to get a general idea of the surface of this data, but what if you needed to rotate the plot to see the other side and most of the peaks. $AX$ and $AZ$ are plotting keywords that are used to control the SURFACE command. The keyword $AX$ specifies the angle of rotation of the surface (in degrees towards the viewer) about the $x$-axis. The $AZ$ keyword specifies the rotation of the surface in degrees counterclockwise around the $z$-axis.

Step 5  Use the $AX$ keyword to rotate the plot 60 degrees along the $x$-axis and use the $AZ$ keyword to rotate it $-30$ degrees along the $z$-axis:

```
WAVE> SURFACE, elev, lon, lat, XStyle=1, $
    CharSize=1.75, /Horizontal, Bottom=7, $
    AZ = -30, AX = 60
```

The surface is displayed rotated about the $x$- and $z$-axes.
Step 6  Now, draw only the yellow lines on the bottom of the surface:

```wavelin
WAVE> SURFACE, elev, lon, lat, XStyle=1, $
  ➤ CharSize=1.75, /Horizontal, Bottom = 7, $
  ➤ AZ = -30, AX = 60, /Lower_Only
```

Step 7  Draw the surface in the default viewing angle, adding a yellow skirt that begins at 5000 feet:

```wavelin
WAVE> SURFACE, elev, lon, lat, XStyle=1, $
  ➤ CharSize=1.75, /Horizontal, Bottom=7, $
  ➤ Skirt = 5000
```
Displaying Data as a Shaded Surface

You can also view a 2D array as a light-source shaded surface.

**Step 1**  First, enlarge the current window:

```
WAVE> WINDOW, 0, XSize = 800, YSize = 800
```

**Step 2**  Load one of the pre-defined PV-WAVE color tables by entering:

```
WAVE> LOADCT, 5
```

**Step 3**  To view the light-source shaded surface, simply enter the command:

```
WAVE> SHADE_SURF, elev, lon, lat
```

A shaded surface of the array is displayed.

**Step 4**  Outline the peaks in black using wire frame SURFACE command with the *Horizontal* keyword:

```
WAVE> SURFACE, elev, lon, lat, XStyle=4, $
    YStyle = 4, ZStyle = 4, Color = 0, $
    /Horizontal, /NoErase
```
NOTE The NoErase keyword allows the SURFACE plot to be drawn over the existing SHADE_SURF plot. The XStyle, YStyle, and ZStyle keywords are used to select different styles of axes. Here, SURFACE is told not to draw the x-, y-, and z-axes because they were already drawn by the SHADE_SURF command.

You can plot the contour lines on the shaded surface, but you will need to save the 3D transformation matrix using the Save keyword.

**Step 5** Draw the shaded surface without axes and save the transformation:

```
WAVE> SHADE_SURF, elev, lon, lat, $
➠ XStyle = 4, YStyle = 4, ZStyle=4, /Save
```

**Step 6** Now draw the contour lines on the current plot:

```
WAVE> CONTOUR, elev, lon, lat, XStyle=4, $
➠ YStyle = 4, ZStyle = 4, /NoErase, $
➠ Levels = level, /Follow, /T3D
```

The white contour lines follow the surface.
Step 7  Now place colored contour lines above the shaded surface. When you loaded color table 5, you overrode the TEK_COLOR palette, so you need to load it again:

WAVE>  TEK_COLOR

Step 8  Draw the contour lines in colors. Place them above the shaded surface by specifying displacement along the z-axis ($ZValue$) of 1.0:

WAVE>  SHADE_SURF, elev, lon, lat, $
    =>$ XStyle = 4, YStyle = 4, ZStyle=4, /Save

WAVE>  CONTOUR, elev, lon, lat, XStyle=4, $
    =>$ YStyle = 4, ZStyle = 4, /NoErase, $
    =>$ Levels = level, C_Colors = color2, $
    =>$ /Follow, /T3D, $ZValue = 1.0$

The colored contour lines are drawn at the top of the box.
Displaying a TIFF File or a Logo

What if you wanted your logo to appear on your plots? PV-WAVE has several tools for reading images in different formats. TIFF (Tagged Image File Format) files are very common and very useful because they are easily transported across platforms. This example shows how to place the Visual Numerics, Inc., logo on your plot.

You may not know the dimensions of the image, but DC_READ_TIFF will take care of this problem if you ask it to output them using the keywords imagewidth and imagelength.

Step 1  Read the file into the variable vni_s:

```
WAVE$> status = 
  ➤ DC_READ_TIFF(!Data_Dir + $
  ➤ 'vni_small.tif', $
  ➤ vni_s, imagewidth = Xsiz, $
  ➤ imagelength = Ysiz)
```

You can display the image using the TV procedure. The image is displayed by default from the bottom-up, which makes it upside-down and backwards. By specifying the Order to have the value 1, the image will display properly.
Step 2  Display the image:

WAVE>  TV, vni_s, Order = 1
The image is displayed at the bottom of the window.
Now you are ready to place the logo on a plot.

Showing Three Levels
With a little effort, you were able to display a contour plot above a shaded surface.
What if you wanted to do that and place an image below the surface? The SHOW3 procedure allows you to do this with one command.

Step 1  Try it by entering:

WAVE>  SHOW3, elev, /Interp
The image, wire-frame surface, and contour are displayed.
To specify the position of the logo, enter a numeric value after the filename. The numbers that can be used vary, depending on image and screen size, but the value 0 always places the image in the upper left corner.

Step 2  Add the Visual Numerics logo:

WAVE>  TV, vni_s, 0, Order = 1
The image is displayed in the upper-left corner of the plot.
Using Color to Represent Data

You can specify a different array for the shading colors.

**Step 1**  Use TEK_COLOR again to load 32 distinct colors at the beginning of the current color table:

```
WAVE> TEK_COLOR
```

**Step 2**  Find the BYTSCL values of the depth and allow the first 32 distinct values to be excluded:

```
WAVE> shade = BYTSCL(depth, Top=222) + 32b
```

**Step 3**  Shade the elevation data plot with snow depth values:

```
WAVE> SHADE_SURF, elev, lon, lat, $  
    ➤ XStyle = 1, Shades = shade, Color = 1
```

**NOTE**  The BYTSCL function scales and converts an array to byte data type. The Shades keyword specifies the same dimensions as the shade parameter, which contains the shading color indices.

The different shading colors correspond to snow depth.

The axes’ labels were drawn in white because this was specified by assigning the value of 1 (white in the TEK_COLOR palette) to the Color keyword.

**Step 4**  Display the Visual Numerics logo on the plot:

```
WAVE> TV, vni_s, 0, Order = 1
```

The logo is placed in the upper-left corner.
Step 5  Create a shaded surface that has the shading information provided by the elevation of each point:

WAVE>  shade = BYTSCl(elev, Top = 222) + 32b

WAVE>  SHADE_SURF, elev, lon, lat, $

  ➤ XStyle = 1, Shades = shade, Color = 1

WAVE>  TV, vni_s, 0, Order = 1

Now different shading colors on the plot correspond to different elevations.
Step 6  Shade the snow depth data plot with elevation:

WAVE>  SHADE_SURF, depth, lon, lat, $
   \xrightarrow{XStyle=1, \text{Shades} = \text{shade, Color} = 1$

WAVE>  TV, vni_s, 0, Order = 1

The shading colors correspond to the elevation data.
More Information on 3D Plotting

The SURFACE, CONTOUR, and SHADE_SURF commands have many more keywords that can be used to create even more complex, customized plots. For more information see the PV-WAVE User’s Guide.

Deleting Windows

Delete the open graphics windows by entering the following command:

```
WAVE> WHILE (!D.Window GE 0) DO WDELETE,$ !D.Window
```

All the windows close.
Array Processing Techniques

PV-WAVE is an ideal tool for working with arrays because of its interactive capabilities, uniform notation, and array-oriented operators and functions. This lesson demonstrates some of PV-WAVE’s capabilities when working with arrays and also focuses on the ability to display your data as an image and to make use of the many image processing tools in PV-WAVE.

Figure 7-1 An image of a section of a human brain made using a computer-aided tomography scan. Emphasis on different structures is created in these two views by adjusting the color table.
**Previewing This Lesson**

This lesson demonstrates some basic image processing techniques using PV-WAVE. To preview the steps you will take and the plots you will create in this lesson, do the following:

**Step 1** Use the CD command to go to the subdirectory that contains code for the tutorial. At the WAVE> prompt, enter:

```
WAVE> cd, '"$VNI_DIR/docs/tutorial/code'  
```

If you are running the UNIX version of PV-WAVE.

```
WAVE> cd, '"VNI_DIR:[DOCS.TUTORIAL.CODE]'  
```

If you are running the OpenVMS version of PV-WAVE.

**Step 2** Run the lesson preview by entering the following command at the WAVE> prompt:

```
WAVE> @lesson_6
```

The batch file runs the program, demonstrating the plots you will produce in this lesson.

---

**Displaying and Processing Arrays**

Images, which are 2D arrays, are easily visualized in PV-WAVE and can be processed just like any other array. PV-WAVE also contains many procedures and functions specifically designed for image display and processing.

**Reading an Array**

First, import an image to be processed. Reading data files into PV-WAVE is easy if you know the format in which the data is stored. Often, images are stored as arrays of bytes.

**Step 1** Open the file for reading by entering:

```
WAVE> OPENR, 1, $               

  ➤ FILEPATH('head.img', SubDir = 'data')
```
NOTE  The OPENR command opens the file named in quotes and assigns it to the specified logical unit number. Here you assign the file head.img to unit number 1. Unit numbers can range from 1 to 128. The FILEPATH function, used as an argument to OPENR, returns the full path for the file head.img located in the PV-WAVE data directory.

Step 2  The image you read is a 512-by-512-element array of bytes, so you will create a 512-element square array variable called head_LS by entering:

WAVE>  head_LS = BYTARR (512, 512)

Step 3  Read the image into the variable head_LS and close the file head.img by entering:

WAVE> READU, 1, head_LS
WAVE> CLOSE, 1

Displaying an Array
The default window size is 640-by-512 pixels.

Step 1  Since the image is 512-by-512, create a custom-sized window for the display:

WAVE>  WINDOW, XSize = 512, YSize = 512
The window appears in the upper right corner.

NOTE  Many of the keyword names can be abbreviated. In most cases, they can be abbreviated to the smallest unique set of letters. A slash (/) can be used to set a keyword equal to 1 or True.

Step 2  Now return to the default color table, B-W Linear, and display the image by entering:

WAVE>  LOADCT, 0
WAVE>  TV, head_LS
The image appears in the window.
NOTE The TV command writes an array to the display as an image without scaling. TVSCL scales the values of the image array into the range of available colors.

Step 3 To display the image with its values scaled to use the entire color table, enter:

WAVE> TVSCL, head_LS
The image uses the entire set of color table values.

Changing the Size of an Image

Two commands commonly used to expand or shrink image sizes are CONGRID and REBIN.

CONGRID
✔ Uses nearest neighbor interpolation
✔ Faster than REBIN
✔ Can produce final dimensions of arbitrary size
✔ Uses bilinear interpolation when the Interp keyword is specified

REBIN
✔ Uses bilinear interpolation
✔ Takes longer than CONGRID
✔ Produces higher quality results
✔ Produces final dimensions that are integral multiples or factors of the original

Step 1 Use the CONGRID function to create an enlarged image:

WAVE>  head_LSbig = CONGRID(head_LS, 768, $ ➤ 768)

Step 2 Now you need a larger window:

WAVE>  WINDOW, XSiz = 768, YSiz = 768
WAVE>  TVSCL, head_LSbig
Work with smaller images now so that you can display six windows simultaneously.

**Step 3** Make the image smaller and display it in a smaller window. Enter:

```
WAVE> b = CONGRID(head_LS, 384, 384)
WAVE> WINDOW, 0, XSiz = 384, YSiz = 384
WAVE> TVSCL, b
```

**Step 4** Load an rgb-range color table and display the image:

```
WAVE> LOADCT, 15 & TV, b
```

The TV and TVSCL commands can also accept array expressions as arguments.

**Step 5** For example, enter the command:

```
WAVE> TV, b*1.5
```

Each element of $b$ is multiplied by 1.5 and the result is sent to the display. The data in variable $b$ remains unchanged.

**Step 6** Multiply each element by 2:

```
WAVE> TV, b*2
```

Each element of $b$ is multiplied by 2.

**Contrast Enhancement**

*Thresholding* is one of the simplest contrast enhancements that can be performed on an image. Thresholding produces a two-level mapping from all of the possible intensities into black and white.

**NOTE** The PV-WAVE relational operators, EQ, NE, GE, GT, LE, and LT, return a value of 1 if the relation is true and 0 if the relation is false. When applied to images, the relation is evaluated for each pixel and an image of ones and zeros is created. These operators are:

- ✔ EQ — Equal
- ✔ GE — Greater than or equal to
- ✔ GT — Greater than
✔ LE — Less than or equal to
✔ LT — Less than
✔ NE — Not equal

Step 1  Add a new window:
WAVE> WINDOW, 1, XSize = 384, YSize = 384

Step 2  To display the pixels in the image $b$ that have values greater than 110 as white and all others as black, enter:
WAVE> TVSCL, b GT 110

Step 3  Similarly, you can display the pixels that have values less than 110 as white by entering the command:
WAVE> TVSCL, b LT 110

Another way to enhance the contrast of an image is to scale a subrange of pixel values to fill the entire range of displayed brightness. The PV-WAVE maximum operator $>$ (greater than), returns a result equal to the larger of its two parameters.

Step 4  Use the maximum operator to scale pixels with a value of 110 or greater into the full range of displayed brightness. Type:
WAVE> TVSCL, b > 110

This highlights certain aspects of the neural tissue that didn’t show before.

NOTE  The LT and GT operators display the pixels in either black or white, whereas the < and > operators display the pixels in the full range of brightness.

Step 5  To scale pixels with a value less than 110 into the full range of brightness, use the PV-WAVE minimum operator $<$ (less than). Enter:
WAVE> TVSCL, b < 110

This highlights the air spaces, soft tissue, and vascular areas.

Similarly, you can set the minimum brightness to 40, set the maximum brightness to 160, scale the image and display it by entering:
WAVE> TVSCL, b > 40 < 160

The neural portion is very bright.
Step 6  Although this command illustrates the use of the PV-WAVE minimum and maximum operators, you can execute the same function more efficiently with the command:

```
WAVE> c = BYTSCL(b, Min = 40, Max = 160, $  
     ⇒ Top = !D.N_Colors)
WAVE> TVSCL, c
```

Notice that this image looks exactly like the previous one.

Step 7  Add another window:

```
WAVE> WINDOW, 2, XSize = 384, YSize = 384
```

In many images, the pixels have values that are only a small subrange of the possible values. By spreading the distribution so that each range of pixel values contains an approximately equal number of members, the information content of the display is maximized. The HIST_EQUAL function performs this redistribution on an array.

Step 8  Create and retain a histogram-equalized image in a new variable called h:

```
WAVE> h = HIST_EQUAL(c)
```

Step 9  Display h by entering:

```
WAVE> TV, h
```

The displayed image appears much brighter, but with less detail than c.

**Smoothing and Sharpening**

The SMOOTH function is typically used to:

- Remove ripples, spikes or high frequency noise
- Blur an image or set of data so that only the general trends can be seen
- Isolate the lower spatial frequency components
- Soften sharp transitions from one color to another in a color table

Images can be rapidly smoothed to soften edges or compensate for random noise in an image using PV-WAVE’s SMOOTH function. This function performs an equally-weighted smoothing using a square neighborhood of a specified odd width, which is called boxcar averaging; the MEDIAN function finds the median value of an array or applies a median filter of a specified width.
MEDIAN smoothing replaces each point with the median of the 1D or 2D neighborhood of the given width, effectively eliminating high and low values without blurring any edges.

**Step 1** Display a median smoothed image of \( c \) with a 1D neighborhood of 3:

\[
\text{WAVE}> \text{TVSCL, MEDIAN}(c, 3)
\]

SMOOTH uses a boxcar average. If the first boxcar width you try does not give you the results you expected, try a different width. Boxcar widths should always be odd numbers.

**Step 2** Display the image smoothed using a 3-by-3 neighborhood by entering:

\[
\text{WAVE}> \text{TVSCL, SMOOTH}(c, 3)
\]

**Step 3** Try a wider neighborhood:

\[
\text{WAVE}> \text{TVSCL, SMOOTH}(c, 7)
\]

This image looks a bit blurred and contains only the low frequency components of the original image.

**Step 4** Now display the image smoothed using a 5-by-5 neighborhood by entering:

\[
\text{WAVE}> \text{TVSCL, SMOOTH}(c, 5)
\]

This image looks less blurred.

**Step 5** Add a new window:

\[
\text{WAVE}> \text{WINDOW, 3, XSize = 384, YSize = 384}
\]

**NOTE** Often, an image needs to be sharpened so that edges or high spatial frequency components of the image are enhanced. One way to sharpen an image is to subtract a smoothed image containing only low-frequency components from the original image. This technique is called *unsharp masking*.

**Step 6** To unsharp mask and save as a new variable, enter:

\[
\text{WAVE}> \text{smoothed = FIX}(c - \text{SMOOTH}(c, 5))
\]

Recall that \( c \) was created by displaying only values in the range 40–160. This command subtracts a smoothed version of the image \( c \) from the original \( c \) and saves
it as a variable called \textit{smoothed}. The \textsc{fix} command converts byte data to integer data.

\textbf{Step 7} Display the image, enter:

\texttt{WAVE> TVSCL, smoothed}

\textbf{Step 8} It is also possible to subtract a smoothed version of the original image ($b$) from $c$. Enter:

\texttt{WAVE> smoothed = FIX(c - SMOOTH(b, 5))}

\textbf{Step 9} Display the image, enter:

\texttt{WAVE> TVSCL, smoothed}

\textbf{Step 10} Add a new window:

\texttt{WAVE> WINDOW, 4, XSiz = 384, YSiz = 384, XPos = 385, YPos = 350}

\textbf{Step 11} Re-display the original image and compare it to the other images:

\texttt{WAVE> TVSCL, b}

\textbf{NOTE} \textsc{pv-wave} has other built-in sharpening functions that use differentiation to sharpen images. The \texttt{roberts} and \texttt{sobel} functions are edge enhancement generators. The \texttt{roberts} function returns the Roberts gradient of an image.

\textbf{Step 12} Try the \texttt{roberts} function by entering:

\texttt{WAVE> \texttt{r} = ROBERTS(c)}

\texttt{WAVE> TV, r}

\textbf{Step 13} The \textit{prism} color table, color table number 6, shows the results better. Load it by entering:

\texttt{WAVE> LOADCT, 6}

\texttt{WAVE> TVSCL, r}

The convoluted tissue is displayed primarily in red.
NOTE Another commonly-used gradient operator is the SOBEL operator. PV-WAVE’s SOBEL function operates over a 3-by-3 region, making it less sensitive to noise than some other methods.

Step 14 Display a SOBEL-sharpened version of the image:

```
WAVE> so = SOBEL(c)
```

```
WAVE> TVSCL, so
```

Other Image Manipulations

Sections of images are easily displayed by using subarrays.

Step 1 Create a new window:

```
WAVE> WINDOW, 5, XSize = 400, YSize = 400, $
  XPos = 385, YPos = 0
```

Step 2 Create a new array that contains just the 100-by-100 pixels of image \( b \) with the cerebellum in it and display it by entering:

```
WAVE> d = b(210:309, 130:229)
```

```
WAVE> TV, d
```

The image appears in the lower-left corner of the new window.

Step 3 Load the standard gamma-II color table:

```
WAVE> LOADCT, 5
```

The displayed image is small, so you can “magnify” the image to an arbitrary size using bilinear interpolation with the REBIN command.

NOTE REBIN allows you to scale each dimension by an integer factor.

Step 4 Make each dimension of \( d \) four times its current size and display the result by entering:

```
WAVE> e = REBIN(d, 400, 400)
```

```
WAVE> TV, e
```
The image has, in effect, been magnified four times.

**Step 5** To make this image the same size as the others while still using bilinear interpolation, use the CONGRID function with the *Interp* keyword:

WAVE>` f = CONGRID(d, 384, 384, /Interp)`

**Step 6** Change the size of the window:

WAVE>` WINDOW, 5, XSiz = 384, YSiz = 384, $`  
    `- $XPos = 385, YPos = 0`

**Step 7** Display *f*:

WAVE>` TVSCL, f`

**NOTE** Simple rotation in multiples of 90 degrees can be accomplished with the ROTATE function.

**Step 8** Rotate the magnified image by 90 degrees by entering:

WAVE>` g = ROTATE(f, 1)`

The second parameter of ROTATE is an integer from 1 to 8 that specifies which one of the eight possible combinations of rotation and axis reversal to use.

**Step 9** Display *g*:

WAVE>` TV, g`

The image is rotated 90 degrees counterclockwise.

**Step 10** Improve the image by using TVSCL to display it.

WAVE>` TVSCL, g`

**Using PV-WAVE Color Tables**

The predefined color tables offer a variety of ways to view the data. Try the following color tables and compare the results.

**TIP** Use the up arrow (↑) key to recall commands, then edit the color table number to rapidly cycle through the color tables.
The WDELETE function enables you clear the screen by removing several of the windows you created in this lesson:

WAVE> WDELETE, 0 & WDELETE, 1 & WDELETE, 2 & WDELETE, 3 & WDELETE, 4

All the windows except the window 5 close.

Extracting Profiles

Another useful image processing tool is the Standard Library routine PROFILES. This routine draws row or column profiles of an image, and it allows you to simultaneously view an image and an x-y plot of the pixel brightness in any row or column of the image.

Step 1 Use the PROFILES routine with the rotated image that you just displayed by entering:

WAVE> PROFILES, g
A new window for displaying the profiles appears.

**Step 2**  Move the pointer into window 5 (the one containing the image g) to display the profiles of different rows and columns.

**Step 3**  While the pointer is in window 5, press the left mouse button to switch between displaying row and column profiles.

**Step 4**  Exit the PROFILES routine by clicking the right mouse button while the pointer is in the image window (5).

The PROFILES window closes.

**Step 5**  Now delete window 5:

```
WAVE> WDELETE, 5
```

**More Information on Array Processing**

For more information on image display and image processing, see the *PV-WAVE User’s Guide*. To see an alphabetical listing of image display and image processing procedures and functions see the *PV-WAVE Reference*. 
Using Color

PV-WAVE provides numerous ways to enhance your data through the use of color. Working with color can enhance your data and provide insight into the subtleties of your data. This lesson shows you how to use PV-WAVE’s predefined color tables, how to customize color usage, and ways to use color to improve your results.

Figure 8-1 An image of New York City, New York. In the upper left corner, the Brooklyn, Manhattan, and Williamsburg bridges can be distinguished to the right of the tip of lower Manhattan.
**Using Color Tables**

PV-WAVE provides 16 pre-defined color tables that enable you to apply a large variety of color values to your illustrations. Color tables map the data values written to the screen to different colors and intensities.

**About Color in Previous Lessons**

You have already seen a number of ways to handle color in previous lessons. In Lesson 3, you began using color tables, COLOR_PALETTE and !D.N_COLORS to work with a wide range of colors.

If only a few distinct color values are necessary, as in the case of line plots, the Standard Library procedure TEK_COLOR may be all you need. The TEK_COLOR procedure, which you used in Lesson 5, defines and loads 32 distinct colors. You assign and then call the assigned colors by using the Color keyword or the C_Colors keyword (for contour plots).

**Step 1**

For example, type:

```
WAVE> PLOT, RANDOMN(seed, 10)
WAVE> TEK_COLOR
WAVE> COLOR_PALETTE
WAVE> OPLT, RANDOMN(seed, 10), Color = 4
WAVE> OPLT, RANDOMN(seed, 10), Color = 6
```

In Lesson 6, you loaded all the pre-defined color tables and saw how changing a color table can greatly affect a displayed image.

This lesson shows you how to create custom color tables, as well as some techniques for creatively managing color.

**Creating Your Own Colors**

The PV-WAVE Standard Library offers numerous routines that enable you to create and save your own color tables. The type of color table you use depends on your system’s capabilities. PV-WAVE accepts color specification in the RGB (Red, Green, and Blue), HSV (Hue, Saturation, and Value), or HLS (Hue, Lightness, and Saturation) color systems. Most devices capable of displaying color use the RGB
Using Color Tables

color system. Algorithms exist in PV-WAVE to convert colors from one system to another.

For detailed information about color systems see the PV-WAVE User’s Guide.

About Color Displays

Most systems employ 8-bit color, although 24-bit color is becoming more popular. Typically, digital display devices represent each component of an RGB color coordinate as an \( n \)-bit integer in the range of 0 to \( 2^n - 1 \). Each displayable color is an RGB coordinate triple of \( n \)-bit numbers yielding a palette containing \( 2^3n \) total colors. For the common example of 8-bit colors, each color coordinate may range from 0 to 255, and the total palette contains 224 or 16,777,216 colors.

Even though 8-bit displays can display up to 256 colors simultaneously, a specific application may not be able to display all 256. An application can allocate, at maximum, only the available number of colors, that is, those that have not been previously allocated by the window manager. Generally, a window manager allocates 15-25 colors, allowing an application to map an additional 230-240, if needed.

Step 1 To see the number of colors currently available enter:

\[ \text{PV-WAVE}> \text{PRINT, !D.N\_Colors} \]

PV-WAVE returns the number of colors that have not been reserved and are available to the device to which you are printing (the monitor).

Creating Custom Color in a Display

PV-WAVE maintains its own internal color table, which is read and written by the TVLCT procedure. If you want to create a few of your own colors or know exactly what values of red, green and blue your colors should be, you can explicitly define these vectors.

In this exercise, you create a graph with the axes drawn in white, and then successively add red, green, blue and yellow lines. As there are 5 distinct colors, plus one color for the background, a 6-element color table is created.

Usually, color index 0 represents black (0, 0, 0). You could choose color indices as follows:

- 1 = white (1, 1, 1)
- 2 = red (1, 0, 0)
- 3 = green (0, 1, 0)
• 4 = blue (0, 0, 1)
• 5 = yellow (1, 1, 0)

The display must have at least 3 bits per pixel to represent 6 colors simultaneously, and an 8-bit color table is assumed.

**Step 2**  Create a data set. Type:

```
WAVE> x = SIN((FINDGEN(200)/35)^2.5)
WAVE> y = (x - 0.5)
WAVE> z = (x - 0.75)
WAVE> r = (x - 1.0)
```

**Step 3**  Specify the components for each color. Type:

```
WAVE> red = [0, 1, 1, 0, 0, 1]
WAVE> green = [0, 1, 0, 1, 0, 1]
WAVE> blue = [0, 1, 0, 0, 1, 0]
```

**Step 4**  Load the first 6 elements of the color table. Type:

```
WAVE> TVLCT, 255*red, 255*green, 255*blue
```

**Step 5**  Draw the axes in white, color index 1. Type:

```
WAVE> PLOT, Color = 1, /NoData, x
```

x- and y-axes are drawn in white on a black background.

---

**NOTE**  *NoData* is used with the PLOT command to specify that the axes, titles, and annotation be drawn without plotting data points.
Step 6  Draw in red. Type:

WAVE>   OPLT, Color = 2, x
x is drawn in red.

Step 7  Draw in green. Type:

WAVE>   OPLT, Color = 3, y
y is drawn in green.

Step 8  Draw in blue. Type:

WAVE>   OPLT, Color = 4, z
z is drawn in blue.

Step 9  Draw in yellow. Type:

WAVE>   OPLT, Color = 5, r
r is drawn in yellow.

The final plot is shown in Figure 8-2.

Figure 8-2  Plot created using custom color table.
Using the WgCTTool Procedure

WgCTool provides a graphical menu of the 16 color tables, along with buttons to alter various parameters of the color ramp.

Step 1  Open the color table window by typing:

WAVE>  WgCTool

The color table tool window appears, as shown in Figure 8-3.

![Figure 8-3](image)

The Color Table Tool window is used to create custom color tables.

The window lists 16 color tables in the list box along the right. There are two slider bars along the left and a view of the colors in the current color table across the top. Two buttons are available to dismiss the window and the undo changes to a pre-defined color table. The Reverse button enables you to reverse the order of the colors in the table.

Step 2  Move the pointer to the color bar, press the left mouse button, and drag the pointer across the color bar.

The colors shift in the direction of the pointer movement.

Step 3  Select another color table by clicking on it.
Loading (or re-loading) a pre-defined color table restores the color table to its original condition.

**Step 4** Move the Stretch Top and Stretch Bottom sliders to the right and left, noticing the effects on the color table at the top.

**Step 5** Repeat steps 3 and 4 several times, noting how the color tables are affected by the sliders.

**Step 6** Click on Dismiss to exit the color window.

While you have the WgCTTool menu open, you cannot enter commands in the PV-WAVE window.

---

**Using Color to Enhance Analysis**

By using various color tables and changing the parameters, you can produce striking results in terms of image analysis.

**Displaying an Image**

You will use an image of New York City for your display.

**Step 1** Open the file `nyc.dat` for reading. Type:

```plaintext
WAVE> OPENR, 1, FILEPATH('nyc.dat', $ 
    ➤ SubDir = 'Data')
```

You need an array 1024-by-1024 to hold all the data.

**Step 2** Create the variable `nyc` by entering:

```plaintext
WAVE> nyc = BYTARR(1024, 1024)
```

**Step 3** Now read the New York City data. Type:

```plaintext
WAVE> READU, 1, nyc
```

**Step 4** Close the file by typing:

```plaintext
WAVE> CLOSE, 1
```

The image is too large to display all of it on most screens.
Step 5  Create a smaller version of the image.

WAVE>  small = REBIN(nyc, 512, 512)

Step 6  Display the data in your large window by typing:

WAVE>  TV, small, Order = 1

An image of New York City appears in the small window.

Step 7  Create a window large enough to display all the data:

WAVE>  WINDOW, 0, XSize = 1024, YSize = 1024

If the window that appears is too large to fit on your screen in its entirety, you can move it around as needed.

Step 8  Display the data in your large window by typing:

WAVE>  TV, nyc, Order = 1

The original image of New York City appears in the large window.

Step 9  Load a different color table. Type:

WAVE>  LOADCT, 4

Changing Colors in the Image

Now you are ready to see the effects of changing colors in your image.

Using WgCTTool

First, use the interactive color table menu, WgCTTool.

Step 1  Load the color table menu. Type:

WAVE>  WgCTool

The color table menu appears.

Step 2  Move the Stretch Bottom slider to about 20 and the Stretch Top slider to about 60.

Most of the data values for nyc.dat reside in a small portion of the color ramp. By manipulating the sliders, you can enhance those areas significantly.
**Using Color to Enhance Analysis**

**Step 3**  Move the pointer to the right-hand portion of the color bar and slowly drag it to the left.

The buildings, streets, trees, and water appear very different as the pointer is moved.

**Step 4**  Close the WgCTTool. Select **Dismiss**.

The window closes.

**Using WgCEditTool**

The WgCEditTool has more capabilities for color manipulation.

**Step 1**  Load the WgCEditTool. Type:

```
WAVE> WgCEditTool
```

The WgCEditTool window appears. The number of currently available colors is displayed at the bottom of the window.

This tool enables you to enter exact numbers for red, green, and blue.

**Step 2**  Display the **Options** menu and select **Color Wheel**.

The Color Wheel window opens.

You can use the Color Wheel window to modify the color of a specific color index by clicking the mouse on the wheel and by using the slider.

**Step 3**  Close the Color Wheel window by using the window manager tool to quit the window.

**Step 4**  Create a pair of custom colors at least 16 indices apart by selecting each color block then changing its color.

**Step 5**  Experiment with ramping: click the first mouse button (MB1) on a color square and change its values by adjusting the sliders. Then click MB1 on another square and adjust its color. Finally, click MB1 on the first square and MB2 on the second square, then select **Edit=>Ramp**.

**Step 6**  Experiment with the other options on the menus.

Note the Controls menu enables you to save your custom color table. It also contains the **Exit** option.

Exit the WgCEditTool when you have completed your experimentation. Select **Controls=>Exit**.

---

*Using Color to Enhance Analysis*  159
Using LOADCT

You can select any of the color tables from the PV-WAVE command line, as you have done in previous exercises. The default color table, 0, is B-W Linear, a grayscale color table. The other color tables are numbered 1-15.

**Step 1** Load the *Red Temperature* color table. At the PV-WAVE prompt, enter:

```
WAVE> LOADCT, 3
```

**Step 2** Use LOADCT to load several other color tables.

**More Information on Color**

From these exercises, you can see that color offers you great potential for enhancing image analysis. For more information, refer to the *PV-WAVE User’s Guide*. 
Advanced Math and Statistics

PV-WAVE provides some of the most powerful mathematics capabilities available for software today via its companion technologies PV-WAVE:IMSL Mathematics and PV-WAVE:IMSL Statistics. Simple commands can be used to rapidly solve complex mathematical and statistical problems. Whether your data sets are large or small, you will find the power of PV-WAVE is yours, enabling you to analyze more data in less time than before.

Figure 9-1 Trajectory solution of an ordinary differential equation (ODE). This graphic is generated in the lesson beginning on page 180.
Programs You Can Use

This chapter contains examples of two types of programs:

- programs that use PV-WAVE:IMSL Mathematics functions and
- programs that use PV-WAVE:IMSL Statistics functions.

Either one or both of these products must be installed for you to run examples in this chapter. Before each example, the product that is required to run the example is noted.

To start PV-WAVE:IMSL Mathematics, enter at the @WAVE> prompt:

WAVE> @math_startup

To start PV-WAVE:IMSL Statistics, enter at the @WAVE> prompt:

WAVE> @stat_startup

The programs in this lesson can be found in the subdirectory:

$VNI_DIR/docs/tutorial/code/advantage (UNIX)

VNI_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE] (OpenVMS)

To run these programs, you must be running PV-WAVE from this directory. Move there by entering the following command at the @WAVE> prompt:

WAVE> cd, '$VNI_DIR/docs/tutorial/code/advantage'

If you are running the UNIX version of PV-WAVE.

WAVE> cd, 'VNI_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE]'

If you are running the OpenVMS version of PV-WAVE.

You can run them, study them, and use any as a pattern for your own programs. For your convenience, each program is listed here in the tutorial.

This lesson demonstrates a variety of mathematics and statistics functions available in PV-WAVE:IMSL Mathematics and PV-WAVE:IMSL Statistics along with sample programs. Whether you examine the sample programs as they are listed here in the “hardcopy” or look at them online using a text editor, we recommend that you look carefully at the underlying code for each example.
Solving a Nonlinear System of Equations

The example program `nonlin_system.pro` shows the use of the PV-WAVE:IMSL Mathematics procedure ZEROSYS to solve a system of \( n \) nonlinear equations \( f(x) = 0 \).

**NOTE** ZEROSYS uses different keywords to solve this problem using different algorithms. Most PV-WAVE procedures implement various keywords so that you obtain added functionality with each procedure. The fact that the keywords are optional makes programming in PV-WAVE less cumbersome.

In this example, the following nonlinear system of equations is solved:

\[
\begin{align*}
    x_0^2 - 81(x_1 + 0.1)^2 + \sin(x_2) + 1.06 &= 0 \\
    3x_0 - \cos(x_1x_2) - \frac{1}{2} &= 0 \\
    e^{-x_0x_1} + 20x_2 + \frac{10\pi - 3}{3} &= 0
\end{align*}
\]

ZEROSYS solves the problems several times, using a different keyword each time after the first. Initially, the equation is solved by providing ZEROSYS with only the function defining the system and the size of the problem. Next, the keyword \( XGuess \) is added. \( XGuess \) is the array with \( n \) components containing the initial guess. The default is that all components of \( XGuess \) are zero.

The third time, the system is solved by using the keyword, \( Double \), so that the problem is solved in double precision. In the final solution the system is solved using double precision and by specifying the analytic Jacobian matrix with the keyword, \( Jacobian \).

**Running the Example Program**

This section explains how to run the example program; see the next section for a complete listing of the program.
**Step 1** Verify that you are in the `advantage` subdirectory. Enter:

```
WAVE> $ pwd (or $ SHOW DEF on an OpenVMS system)
```

The present working directory is returned.

**Step 2** If you are not in the `advantage` directory, go to it by entering the `CD` command shown on page 162.

**Step 3** Run the sample program. Enter:

```
WAVE> nonlin_system
```

PV-WAVE:IMSL Mathematics returns the following results:

```
WAVE> nonlin_system
Solution
Computed solution for x: 0.500000-1.49657e-008 -0.523599
Error in solution: 0.000000 2.36419e-007 9.53674e-007

Solution with Initial Guess (1, 1)
Computed solution for x: 0.500000 1.75984e-006 -0.523599
Error in solution: 0.000000 2.66102e-005 0.000000

Solution with double precision
Computed solution for x: 0.50000000 -7.0851286e-009 -0.52359861
Error in solution: 3.1086245e-015 7.0166095e-013 5.3260705e-015

Solution with double precision and analytic Jacobian
Computed solution for x: 0.50000000 -7.0851623e-009 -0.52359861
Error in solution: 4.4408921e-016 1.6184847e-013 1.7763568e-014
WAVE>
```

**Example Program Listing: nonlin_system.pro**

The following is a complete listing of the program `nonlin_system.pro` in:

```
$VNI_DIR/docs/tutorial/code/advantage (UNIX)
VNI_DIR: [DOCS.TUTORIAL.CODE.ADVANTAGE] (OpenVMS)
```
Solving a Nonlinear System of Equations

; This example illustrates finding the zero of a system of nonlinear equations

; Define the system of equations
FUNCTION NONLIN_FCN, x
; f will be the same type and size of x
f = x
f(0) = 3*x(0) - cos(x(1)*x(2)) - .5
f(1) = x(0)*x(0) -81*(x(1)+0.1)*(x(1)+0.1) + sin(x(2)) + 1.06
f(2) = exp(-x(0)*x(1)) + 20*x(2) + (10*pi - 3)/3
RETURN, f
END

; Define the Jacobian of the system
FUNCTION NONLIN_JACOBIAN, x
; df will be the same type and size of x#x
df = x#x
df(0, *) = [3, x(2)*SIN(x(1)*x(2)), x(1)*SIN(x(1)*x(2))]
df(1, *) = [2*x(0), -162*(x(1)+0.1), COS(x(2))]
df(2, *) = [-x(1)*EXP(-x(0)*x(1)), -x(0)*EXP(-x(0)*x(1)), 20]
RETURN, TRANSPOSE(df)
END

; Main Program
PRO NONLIN_SYSTEM
; Call PV-WAVE:IMSL Mathematics procedure ZEROSYS to find the zeros of the nonlinear system.
; The system will be solved several times showing the usage of PV WAVE:IMSL Mathematics keywords for ZEROSYS

; Solve the system using no keywords
result = ZEROSYS('nonlin_fcn', 3)
PRINT, 'Solution'
PRINT, 'Computed solution for x: ', result
PRINT, 'Error in solution: ', ABS(NONLIN_FCN(result))

; Solve the system providing an initial guess
result = ZEROSYS('nonlin_fcn', 3, XGuess = [1, 1, 1])
PRINT, 'Solution with Initial Guess (1, 1, 1)'
PRINT, 'Computed solution for x: ', result
PRINT, 'Error in solution: ', ABS(NONLIN_FCN(result))
; Solve the system using double precision
result = ZEROSYS('NONLIN_FCN',3, /Double)
PRINT, ''
PRINT, 'Solution with double precision'
PRINT, 'Computed solution for x: ', result
PRINT, 'Error in solution: ', ABS(NONLIN_FCN(result))
;
; Solve the system using double precision and analytic Jacobian
result = ZEROSYS('NONLIN_FCN', 3, /double, $
jacobian = 'NONLIN_JACOBIAN')
PRINT, ''
PRINT, 'Solution with double precision and analytic Jacobian'
PRINT, 'Computed solution for x: ', result
PRINT, 'Error in solution: ', ABS(NONLIN_FCN(result))
END

Using a 2D B-Spline Interpolation Procedure

The example program heat.pro uses the PV-WAVE:IMSL Mathematics 2D B-spline interpolation procedure. The data file heat.dat (obtained from a Farmer's Almanac) contains limited information detailing the heat index for a given Fahrenheit temperature and relative humidity. Interpolation procedures must be used to obtain values not present in the file heat.dat.

The data file heat.dat is in the directory:

$VNI_DIR/wave/data  (UNIX)
VNI_DIR:[WAVE.DATA]  (OpenVMS)

A listing of this file shows the following data:

999 70 75 80 85 90 95 100
0  64 69 73 78 83 87 91
10 65 70 75 80 85 90 95
20 66 72 77 82 87 93 99
30 67 73 78 84 90 96 104
40 68 74 79 86 93 101 110
50 69 75 81 88 96 107 120
60 70 76 82 90 100 114 132
70 70 77 85 93 106 124 144
80 71 78 86 97 113 136 156
90 71 79 88 102 122 148 169
100 72 80 91 108 131 161 181
The first row represents temperature and the first column represents the relative humidity. The other entries correspond to the heat index for a given temperature and humidity value.

**NOTE** The heat index is a value representing the “perceived” temperature when the relationship between relative humidity and air temperature is taken into account.

The function HEAT accepts the parameter `humidity` and returns and interprets the value for the heat index. The default splines produced are of order 4, or cubic splines. The procedure HEATPLOT uses the function HEAT to produce a plot.

**Running the Example Program**

This section explains how to run the example program; see the next section for a complete listing of the program.

**Step 1** If you are not in the `advantage` directory, go to it by entering the command shown on page 162.

**Step 2** Run the `prep_plot` procedure. It is used to reset plotting parameters and system variables:

```
WAVE> prep_plot
```

**Step 3** Run the sample program `heat.pro` without arguments. Enter:

```
WAVE> heat
```

PV-WAVE plots the heat index vs. temperature, using the default 50 percent humidity.
Step 4  Use a value of 90 for percent humidity. Enter:

WAVE>  heat, 90

The plot shows the heat index for the entire range of temperatures at 90 percent humidity.

Example Program Listing: heat.pro

The following is a complete listing of the program heat.pro, in:

$VNI_DIR/docs/tutorial/code/advantage  (UNIX)
VNI_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE]  (OpenVMS)
; Pro: heat.pro

PRO READ_HEAT_DATA
; Read the file heat.dat and parse the data file into
; appropriate variables
COMMON heat_data, temperatures, humidities, heat_values
OPENR, unit, !Data_Dir + 'heat.dat', /Get_LUN
RMF, unit, heat_data, 12, 8
FREE_LUN, unit
temperatures = heat_data(0, 1:7)
humidities = heat_data(1:11, 0)
heat_values = heat_data(1:11, 1:7)
END

FUNCTION CREATE_SPLINE, x, y
; Calculate a spline function based on interpolated values
; using the BSINTERP and SPVALUE functions
COMMON heat_data, temperatures, humidities, heat_values
heatindex = BSINTERP(humidities, REFORM(temperatures, 7), $ heat_values)
z = FLTARR(100)
FOR i = 0, 99 DO z(i) = SPVALUE(x(i), y(i), heatindex)
RETURN, z
END

PRO PLOT_HEAT_DATA, humidity
WHILE (!D.Window GE 0) DO WDELETE, !D.Window
prep_plot
WINDOW, 0, XSize = 875, YSize = 700, $ XPos = 3, YPos = 30, $ Title = 'PV-WAVE'
LOADCT, 4, /Silent
; Plot the temperature verses the heat index for the
; specified relative humidity
COMMON heat_data, temperatures, humidities, heat_values
; Plot over temperature range of 70-90 degrees
y = 70 + FINDGEN(100)/99*20
; Create the plot without data values
PLOT, y, XRange = [60, 100], YRange = [60, 140], $ /NoData, Title = 'Heat Index', $ XTitle = 'Fahrenheit Temperature', $ YTitle = 'Fahrenheit Heat Index', $ Thick = 3, CharSize = 3
; Create a vector of the Spline calculation
x = MAKE_ARRAY(100, Value = humidity)
z = CREATE_SPLINE(x, y)
;
; Overplot new data on the plot
OPLT, y, z
;
; Add annotation
XYOUTS, y(10) + 1, z(99), $
STRTRIM(STRING(humidity), 2) + $
'%!CRelative Humidity', Size = 2
WAIT, 8
;
WHILE (!D.Window GE 0) DO WDELETE, !D.Window
;
END
;
PRO HEAT, humidity
; This is the main program loop. The procedure
;is called with the relative humidity,
;for which the heat index should be
;calculated. For example, to plot the
;heat index curve for a relative humidity
;of 50%, call the procedure like this
;from within PV-WAVE:
;WAVE> .run heat.pro
;WAVE> heat, 60
; Note: There is little error checking in this program
;
IF (N_Params() EQ 0) THEN humidity = 50
READ_HEAT_DATA
PLOT_HEAT_DATA, humidity
prep_plot
END
Creating and Plotting a Parametric Cubic Spline Interpolant

The example program \texttt{para\_spline.pro} illustrates use of the PV-WAVE:IMSL Mathematics cubic spline interpolation and evaluation procedures in order to create a parametric cubic spline interpolant and plot from a set of \((x, y)\) data points. In this example, a parameter, \(t\), is introduced, and two interpolants are produced, \(x(t)\), and \(y(t)\). The parameter \(t\) is assigned equally-spaced values on the interval \([0, 1]\).

The two interpolants are evaluated, producing the plot of \((x(t), y(t))\). You control the number of spline evaluation points to use in order to achieve the desired smoothness.

Demonstrate the use of the program \texttt{para\_spline.pro} by plotting the parametric cubic spline defined by the following data set:

\[
\left( r(\theta)\cos\left(\theta + \frac{\pi}{2}\right), r(\theta)\sin\left(\theta + \frac{\pi}{2}\right) \right)
\]

where,

\[
\theta = 0, \ldots, 20\pi \\

r(\theta) = e^{-\cos(\theta)} - 2\cos(4\theta) + \sin\left(\frac{\theta}{12}\right)
\]

Running the Example

This section explains how to run the example program; see the next section for a complete listing of the program.

Step 1 If you are not in the \texttt{advantage} directory, go to it by entering the command shown on page 162.

Step 2 Run the \texttt{prep\_plot} procedure. It is used to reset plotting parameters and system variables:

\[
\text{WAVE} > \text{prep\_plot}
\]
Step 3 Enter:

WAVE> TwenPi = 20*!Pi
WAVE> Theta = TwenPi*FINDGEN(200)/199
WAVE> r = EXP(COS(Theta)) - 2*COS(Theta*4) + (SIN(Theta/12))^5
WAVE> x = r*COS(Theta+!Pi/2)
WAVE> y = r*SIN(Theta+!Pi/2)
WAVE> para_spline, x, y, NPts = 200
The plot shows 200 connected points.

NOTE!Pi is the PV-WAVE system variable that contains the value of Pi.

WAVE> WDELETE
WAVE> para_spline, x, y, NPts = 1000
The plot shows 1,000 connected points.

WAVE> OLOT, x, y, PSym = 2
Asterisks are drawn over the points.
WAVE> WDELETE
Example Program Listing: para_spline.pro

The following is a complete listing of the program \texttt{para\_spline.pro}, in:

\begin{verbatim}
$VNI\_DIR/docs/tutorial/code/advantage  \ (UNIX) \\
VNI\_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE]  \ (OpenVMS)
\end{verbatim}

\begin{verbatim}
; para_spline.pro  \\
; Usage: para_spline, xdata, fdata, npts = npts \\
; npts is an integer value indicating the number of times to \\
; evaluate the resulting interpolant. This number affects the \\
; smoothness of the resulting plot. \\
; \\
PRO para_spline, x, y, npts = npts \\
 prep_plot  \\
 WHILE (!D.Window GE 0) DO WDELETE, !D.Window  \\
 nxy = N\_ELEMENTS(x)  \\
 IF NOT(KEYWORD\_SET(npts)) THEN npts = 5\*nxy  \\
 t = FINDGEN(nxy)/(nxy -1)  \\
 xspline = CSINTERP(t, x)  \\
 yspline = CSINTERP(t, y)  \\
 t = FINDGEN(npts)/(npts -1)  \\
 LOADCT, 4, /Silent  \\
 WINDOW, 0, XSize = 875, YSize = 700, $  \\
 XPos = 3, YPos = 30, $  \\
 Title = 'PV-WAVE'
\end{verbatim}

Creating and Plotting a Parametric Cubic Spline Interpolant 173
Estimating Area with a Random Number Generator

The example program `monte.pro` uses the PV-WAVE:IMSL Statistics random number generator procedure, RANDOM, to estimate the area of a quarter-circle. Ordered pairs, \((x, y)\), are generated inside a unit square. The area of the inscribed quarter circle is \(\pi/4\). The `monte.pro` file uses the PV-WAVE:IMSL Statistics RANDOM function to carry out a Monte Carlo simulation to estimate the area of a quarter circle of radius one.

You provide, as input, the number of Monte Carlo trials to run. The trials produce random values. The resulting area estimate, error and relative error are displayed. A scatter plot is shown to visually indicate how well the simulation approximated the desired area.

Running the Example Program

This section explains how to run the example program; see the next section for a complete listing of the program.

**Step 1** If you are not in the `advantage` directory, go to it by entering the command shown on page 162.

**Step 2** Run the sample program using 5000 trials. Enter:

```
WAVE> monte, 5000
```

The program returns something similar to:

- Exact area of unit quarter circle = 0.785398
- Estimate of area = 0.787000
- Absolute Error = 0.00160182
- Relative Error = 0.00203949

and then plots the data.

**Step 3** Try different values, such as 10,000 and 50,000, and see the results.
Estimating Area with a Random Number Generator

Example Program Listing: monte.pro

The following is a complete listing of the program monte.pro, in:

`$VNI_DIR/docs/tutorial/code/advantage` (UNIX)

`VNI_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE]` (OpenVMS)

; monte.pro
; This program uses the PV WAVE:IMSL Statistics random number
; generator procedure, Random, to carry out a Monte Carlo
; simulation to estimate the area of a quarter circle of
; radius one
;
; USAGE: monte, ntrial
; where ntrial is the number of random ordered pairs to
; generate
;
PRO monte, ntrial
;
WHILE (!D.Window GE 0) DO WDELETE, !D.Window
;
; Generate ntrial ordered pairs
x = RANDOM(ntrial)
y = RANDOM(ntrial)
;
; Determine the distance between the origin
; and each point
z = x^2 + y^2
;
; Keep all (x, y) points within the quarter circle
x = x(WHERE(z LE 1, Count))
y = y(WHERE(z LE 1, Count))
;
; Calculate the area (Probability of an (x, y)
; point in the quarter circle)
prob = FLOAT(Count)/FLOAT(ntrial)
;
; Exact area is pi/4
exact = !Pi/4
;
PRINT, 'Exact area of unit quarter circle', exact
PRINT, 'Estimate of area = ', prob
PRINT, 'Absolute Error = ', abs(prob-exact)
PRINT, 'Relative Error = ', abs(prob-exact)/exact
;
Plotting a Fourier Sine Series

The example program `fourier.pro` illustrates a 2D function plot. The Fourier Sine series for $f(x) = 1$ for $x$ on the interval $[0, 1]$ is given by:

$$ f(x) \sim \frac{4}{\pi} \sum_{n=1}^{\infty} \frac{1}{2n+1} \sin((2n+1)\pi x) $$

The procedure, `fourier.pro`, plots the $n$th partial sums of the Fourier Series.
Running the Example

This section explains how to run the example program; see the next section for a complete listing of the program.

Step 1 If you are not in the advantage directory, go to it by entering the command shown on page 162.

Step 2 Create a window for this size plot:

```
WAVE> WINDOW, 0, XSize = 875, YSize = 800, $
  \Rightarrow XPos = 3, YPos = 30, \$
  \Rightarrow Title = 'PV-WAVE Fourier ' $
  \Rightarrow + 'Sine Series'
```

Step 3 Run the fourier.pro program. Enter:

```
WAVE> FOR i=2, 20, 2 DO BEGIN fourier, i & $
  \Rightarrow WAIT, 1
```

PV-WAVE plots the series by twos, pausing for one second between each series.

```
WAVE> WDELETE
```

Example Program Listing: fourier.pro

The following is a complete listing of the fourier.pro, in:

```
$VNI_DIR/docs/tutorial/code/advantage (UNIX)
VNI_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE] (OpenVMS)
```

```plaintext
; fourier.pro
; This program evaluates the Nth
; Partial sums to the Fourier Sine series for f(x) = 1
; USAGE: fourier, npartial
; npartial = number of partial sums to evaluate and plot
;
PRO fourier, npartial
;
; Read in the Visual Numerics logo
status = DC_READ_TIFF (!Data_Dir + 'vni_small.tif', $
  vni_s, ImageWidth = XSiz, ImageLength = YSiz)
;
; Set initial sum vector to zero
sum = MAKE_ARRAY(200, value = 0)
```
Chapter 9: Advanced Math and Statistics

PV-WAVE Tutorial: UNIX & OpenVMS

; Use 200 points on the interval [0, 1]
x = FINDGEN(200)/199

; red = RANDOM(150) & red(0) = 0 & red(149) = 0
green = RANDOM(150) & green(0) = 0 & green(149) = 1
blue = RANDOM(150) & blue(0) = 0 & blue(149) = 0
TVLCT, 255*red, 255*green, 255*blue

; TEK_COLOR
PLOT, x, /NoData, XRange = [0, 1],$
YRange = [0, 1.5], YMargin = [4, 7],$
Back = 0, color = 5, $
Title = '!17Nth Partial Sums for ' $
+ 'Sine Series of f(x) = 1 !CN=' $
+string(npartial), CharSize = 2

; Plot the N partial sums
FOR i = 0, npartial -1 DO BEGIN
    temp = !Pi*(2*i +1)
    sum = sum + 4/temp*sin(temp*x)
OPLOT, x, sum, Color = i
ENDFOR

; TV, vni_s, 0, Order = 1
END

---

**Plotting a Shaded Surface of a Scattered 2D Interpolant**

The example program scattered.pro uses the PV-WAVE:IMSL Mathematics procedure, SCAT2DINTERP. From a file, the scattered x, y values and the associated z value are read for each pair. The resulting interpolant is plotted as a shaded surface.

**Running the Example**

This section explains how to run the example program; see the next section for a complete listing of the program.

**Step 1** If you are not in the advantage directory, go to it by entering the command shown on page 162.
Step 2  Run the prep_plot procedure. It is used to reset plotting parameters and system variables:

WAVE> prep_plot

Step 3  Run the sample program. Enter:

WAVE> scattered

The shaded surface of the interpolant appears.

---

**Example Program Listing: scattered.pro**

The following is a complete listing of the scattered.pro, in:

$VNI_DIR/docs/tutorial/code/advantage  (UNIX)

VNI_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE]  (OpenVMS)

; scattered.pro
PRO scattered
prep_plot
CLOSE, 1
OPENR, 1, !Data_Dir + 'scattered.dat'
; Read x, y and function values in matrix A
RMF, 1, A, 50, 3
CLOSE, 1
; Create array to contain the x, y values
x = FLTARR(2, 50)
x(0, *) = A(*, 0)
Using the Lorenz Attractor

The example program lorenz.pro is an example of use of the PV-WAVE:IMSL Mathematics function ODE to solve a system of ordinary differential equations. The example used is the Lorenz attractor.

The Lorenz model is an autonomous set of dissipative first-order differential equations. The system can be represented as:

\[
\frac{dy}{dt} = F(y)
\]
where the derivative components of \( \vec{y} \) are:

\[
\frac{dy_0}{dt} = \sigma(y_0 - y_1)
\]

\[
\frac{dy_1}{dt} = -y_0y_2 + ry_0 - y_1
\]

\[
\frac{dy_2}{dt} = -y_0y_1 - by_1
\]

The dissipative nature of the equations means that for an arbitrary volume element \( V \), enclosed by the surface \( S \) evolving from the solution of the differential equation, the volume contracts in time, or \( dV/dt < 0 \).

For the solution, choose \( \sigma = 10, r = 28, \) and \( b = 8/3 \). Allow for a maximum of 20,000 time steps, and ask for the return of the solution for 50,000 points in the interval \( t = [0, 150] \).

The initial condition is \( y(0, 0, 0) = (0, 0.01, 0) \).

**Running the Example**

This section explains how to run the example program; see the next section for a complete listing of the program.

**Step 1** If you are not in the `advantage` directory, go to it by entering the command shown on page 162.

**Step 2** Run the `prep_plot` procedure. It is used to reset plotting parameters and system variables:

WAVE> `prep_plot`  

**Step 3** Run `lorenz.pro`. Enter:
WAVE> lorenz

The points are plotted and connected, as shown in Figure 9-1 on page 161.

Example Program Listing: lorenz.pro

The following is a complete listing of the program lorenz.pro, in:

$VNI_DIR/docs/tutorial/code/advantage (UNIX)
VNI_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE] (OpenVMS)

; lorenz.pro
; Function used by ODE
FUNCTION f, t, y
COMMON CONSTANTS, a, b, r
    yp = y
    yp(0) = a*(y(1) - y(0))
    yp(1) = -y(0)*y(2) + r*y(0) - y(1)
    yp(2) = y(0)*y(1) - b*y(2)
RETURN , yp
END

; Main driver
PRO lorenz
prep_plot
COMMON CONSTANTS, a, b, r
a = 10
b = 8./3
r = 28
ntime = 50000
time_range = 150
max_steps = 20000
t = FINDGEN(ntime)/(ntime-1)*time_range
y = [.0, .01, 0]
y = ODE(t, y, 'f', Max_Steps = max_steps)

; Plot the results:
;1. Make a big window
;2. Set up a transformation matrix using SURFACE
;3. Plot the data with PLOTS
;4. Use XYOUTS to place title
;
WHILE (!D.Window GE 0) DO WDELETE, !D.Window
WINDOW, 0, XSize = 875, YSize = 700,
XPos = 3, YPos = 30,
Title = 'PV-WAVE Demonstrates the Lorenz Attractor'
LOADCT, 4, /Silent
;
SURFACE, PLTARR(2, 2), /NoData, /Save, CharSize = 2, $
   XRange = \{\min(y(0, *)) - \max(y(0, *))\},$
   ZRange = \{\min(y(1, *)) - \max(y(1, *))\},$
   YRange = \{\min(y(2, *)) - \max(y(2, *))\}
;
; Setting PSym = 0 plots data as connected lines
PLOTS, y(0, *), y(2, *), y(1, *), PSym = 0, /T3D
ss = '18Lorenz Attractor'
XYOUTS, .2, .8, ss, Size = 3, Color = 227, /Normal, /NoClip
WAIT, 8
WHILE (!D.Window GE 0) DO WDELETE, !D.Window
prep_plot
END

Using Multiple Regression Capabilities

The example program mreg.pro is designed as an introduction to the multiple regression capabilities that are built into PV-WAVE:IMSL Statistics. For each data set, the demo plots the data and fits a least-squares surface. The model used for all data sets is

\[
y = b_0 + b_1 x_1 + b_2 x_2 + b_3 x_1 x_2 + b_4 x_1^2 + b_5 x_2^2 + \text{error}
\]

Running the Example

This section explains how to run the example program; see the next section for a complete listing of the program.

Step 1  If you are not in the advantage directory, go to it by entering the command shown on page 162.

Step 2  Run the prep_plot procedure. It is used to reset plotting parameters and system variables:

WAVE> prep_plot

Step 3  Run mreg.pro. Enter:

WAVE> mreg

The multiple regression plot appears. The complete program is listed in the next section.
Example Program Listing: mreg.pro

The following is a complete listing of the program mreg.pro, in:

```
$VNI_DIR/docs/tutorial/code/advantage (UNIX)
VNI_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE] (OpenVMS)
```

```
; mreg.pro
PRO mreg
;
x1 = FLTARR(10, 5)
x1(*, 0) = [8.5, 8.9, 10.6, 10.2, 9.8, 10.8, 11.6, 12.0, 12.5, 10.9]
x1(*, 1) = [2.0, 3.0, 3.0, 20.0, 22.0, 20.0, 31.0, 32.0, 31.0, 28.0]
x1(*, 2) = x1(*, 0)*x1(*, 1)
x1(*, 3) = x1(*, 0)*x1(*, 0)
x1(*, 4) = x1(*, 1)*x1(*, 1)
y = [30.9, 32.7, 36.7, 41.9, 40.9, 42.9, 46.3, 47.6, 47.2, 44.0]
ax = 30
az = 30
color_points = .98*D.N_Colors
color_grid = .12*D.N_Colors
color_title = .98*D.N_Colors
x1(*, 2) = x1(*, 0)*x1(*, 1)
x1(*, 3) = x1(*, 0)*x1(*, 0)
```

Two-Variable Second-Degree Fit
x1(*, 4) = x1(*, 1)*x1(*, 1)
;
; Setup vectors for surface plot. These will be nxgrid x nygrid
; element each, evenly spaced over the range of the data in x1(*, 0)
; and x1(*, 1)

nxgrid = 30
nygrid = 30

ax1 = MIN(x1(*, 0)) + (MAX(x1(*, 0))- MIN(x1(*, 0)))*FINDGEN(NXGrid)/(nxgrid-1)
ax2 = MIN(x1(*, 1)) + (MAX(x1(*, 1))- MIN(x1(*, 1)))*FINDGEN(nxgrid)/(nxgrid-1)

; Compute regression coefficients
coefs = MULTIREGRESS(x1, y, residual = Resid)

; Create two-dimensional array of evaluations of the regression
; model at points in grid established by ax1 and ax2
z = FLTARR(nxgrid, nygrid)
FOR i = 0, nxgrid-1 DO BEGIN
  FOR j = 0, nygrid-1 DO BEGIN
    z(i,j) = coefs(0) + coefs(1)*ax1(i) + coefs(2)*ax2(j) + coefs(3)*ax1(i)*ax2(j) + coefs(4)*ax1(i)^2 + coefs(5)*ax2(j)^2
  ENDFOR
ENDFOR

!P.TickLen = .03
!P.CharSize = 2
WHILE (!D.Window GE 0) DO WDELETE, !D.Window
WINDOW, 0, XSize = 875, YSize = 700, $XPos = 3, YPos = 30, $Title = 'PV-Wave Regression Example'
LOADCT, 2, /Silent

SHADE_SURF, z, ax1, ax2, /SAVE, $XRange = [MIN(ax1), MAX(ax1)], $YRange = [MIN(ax2), MAX(ax2)], $ZRange = [MIN(z) -2, MAX(z)+2], $
AX = 30, AZ = 40
SURFACE, z, ax1, ax2, /NoErase, $
XRange = [\text{MIN}(ax1), \text{MAX}(ax1)]$, $
YRange = [\text{MIN}(ax2), \text{MAX}(ax2)]$, $
ZRange = [\text{MIN}(z) - 2, \text{MAX}(z) + 2]$, $
AX = 30, AZ = 40$, $
Color = \text{color\_grid}
\text{PLOTS, x1(*, 0), x1(*, 1), y, /T3D, }$
\text{PSym = 4, SymSize = 5, }$
\text{Color = color\_points, }$
\text{Thick = 2}
\text{XYOUTS, 130, 720, /Device, CharSize = 3.0, }$
'!17Two-Variable Second-Degree Fit', $
\text{Color = color\_title}
\text{XYOUTS, 610, 90, /Device, CharSize = 2.0, }$
'X1', \text{Color = color\_title}
\text{XYOUTS, 215, 90, /Device, CharSize = 2.0, }$
'X2', \text{Color = color\_title } & \text{WAIT, 10}
\text{WHILE (!D.Window GE 0) Do WDelete, !D.Window prep\_plot}
\text{END}

writing programs

One of the best methods to learn how to use a programming language is to study examples and then copy and modify some short programs containing relevant code. This lesson not only provides building blocks for more detailed programs, it also gives you rapid, hands-on experience in using some of the powerful mathematical routines in PV-WAVE:IMSL Mathematics and PV-WAVE:IMSL Statistics.

Since this lesson is designed to demonstrate the powerful mathematical and statistical capabilities of PV-WAVE:IMSL Mathematics and PV-WAVE:IMSL Statistics, detailed explanations for some of the more “basic” commands are presented elsewhere in this tutorial.

The exercises in this lesson show you how to execute sample programs. All the programs referenced in this lesson are located in:

$\text{VNI\_DIR/docs/tutorial/code/advantage}$ (UNIX)
\text{VNI\_DIR: [DOCS\_TUTORIAL\_CODE\_ADVANTAGE]} (OpenVMS)

All the examples are written in ASCII text and have a *.pro extension. The examples can be printed, edited, and read.
Creating an Executable Program File

It is easy to create an executable program file. Because PV-WAVE executable programs (*.pro files) are text files, they may be created from within PV-WAVE or with the use of a text editor. Using a text editor, you can easily compose and edit the file. When you create the file from within PV-WAVE, you have the advantage of having each line compiled as you enter it.

You do not need to exit PV-WAVE to use the text editor. You may simply open the text editor in another window, or you may use the SPAWN command within PV-WAVE. For example, on a UNIX system, you could begin the file within PV-WAVE by entering:

WAVE> $ vi filename

If PV-WAVE is not running, re-start the program now to clear the memory buffer and to begin the exercise using PV-WAVE’s default settings for character size, color table, etc.

You also need to start PV-WAVE:IMSL Mathematics to run the following example. To do this, type the following command:

WAVE> @math_startup

This program, which you will save as quadrature.pro, uses the PV-WAVE:IMSL Mathematics quadrature function, INTFCN, to evaluate the following integral:

\[ \int_0^{\pi} \ln(\sin(x)) \, dx = -\pi \ln 2 \]

Look at the program you will be typing (step 2 below) Note that the integrand is singular at both end points. The PV-WAVE:IMSL Mathematics function INTFCN can handle endpoint singularities, and also allows you to specify internal singularities as well. First, the value of the integral is computed and compared to the exact value. This information is returned in PV-WAVE when the program is run. Next, the function \( \ln(\sin(x)) \) in the interval \( x = [0.01, \pi -0.01] \) is plotted in a PV-WAVE window.

Step 1  Open a text editor in another window. You will save this file as quadrature.pro.

When you type the commands shown here, pay careful attention to the punctuation marks and special characters, as this is where people are most prone to make errors.

Step 2  Type the following program with a text editor:

```plaintext
\[ \int_0^{\pi} \ln(\sin(x)) \, dx = -\pi \ln 2 \]
```
FUNCTION f, x
    RETURN, ALOG(SIN(x))
END

PRO QUADRATURE
    Exact = - !Pi * ALog(2)
    Result = INTFCN("f", 0, !Pi)
    PRINT, 'Computed answer = ', result
    PRINT, 'Exact answer = ', exact
    PRINT, 'Relative error = ', $
    ABS((exact - result)/exact)
    x = .01 + FINDGEN(101)/100*(!Pi - .02)
    y = f(x)
    PLOT, x, y, Title = 'Graph of ln(SIN(x))',$
    XTitle = 'x', YTitle = 'y', $
    CharSize = 2, Thick = 2
END

Step 3   Save the program as quadrature.pro.

Compiling and Running Your Program
Move to the directory that contains the file you just created.

Step 1   At the PV-WAVE prompt, type
PV-WAVE> cd, 'mydirectory'
where mydirectory is the pathname to the directory where quadrature.pro file resides.
PV-WAVE moves to your directory.

Step 2   To compile the quadrature.pro file, type
PV-WAVE> .RUN quadrature
The .RUN command compiles a program, returning error messages if errors are present. You do not need to issue the .RUN command for a compiled program unless you want to force recompilation. The first time you type the name of a procedure or function, PV-WAVE will automatically compile it.
Two messages appear, telling you PV-WAVE compiled the module $F$ and the module *quadrature*.

If you made any errors when you typed the file, you will probably receive an error message that will aid you in locating the error.

If you made any errors, return to the text editor and correct them, re-save the file, then repeat steps 1, 2, and 3 above.

**Step 3**  To run the *quadrature.pro* program, type

```
WAVE> quadrature
```

The program runs, delivering the information you requested it to print:

- **Computed answer** = -2.17759
- **Exact answer** = -2.17759
- **Relative error** = 1.09488e-07

PV-WAVE then plots the result, labeling it as specified by the *Title* keyword.

**Step 4**  Close the window. Enter

```
WAVE> WDELETE
```
Creating and Using Batch Files

Earlier in this lesson, you created a .pro file using a text editor. In this section, you will create an executable .pro file by using the JOURNAL command to record and save in a file everything you enter at the WAVE> prompt. The file that is created is called a batch file.

About Batch Files

Unlike PV-WAVE program files, batch files are interpreted as though they were entered from the keyboard. In other words, each line of a batch file is independently compiled and executed before proceeding to the next line. Batch files can be created with any text editor or with the PV-WAVE JOURNAL facility. As you will see, batch files are executed from the WAVE> prompt with the @ command.

Using JOURNAL to Save Commands

The JOURNAL procedure enables you to save to a file all the text you enter at the PV-WAVE prompt. You can use this command to create a file that contains a record of an interactive PV-WAVE session. In this way, you can create a complete description of your PV-WAVE session. These recorded commands constitute a batch file that can then be run to “replay” the session.

Files created by using the JOURNAL command will, like any batch file, be executed a line at a time, as opposed to programs, which are first compiled in their entirety by PV-WAVE, then run as a complete program.

The syntax for the JOURNAL command is:

```
JOURNAL, 'filename'
```

where filename is the name of the journal file to be created.

If no filename is specified, the JOURNAL file will be named wavesave.pro. To close the journal file, enter JOURNAL again or exit PV-WAVE.

Example Program: gamma_bessel.pro

You will use JOURNAL to create and save a program called gamma_bessel.pro. This program illustrates the use of two special functions from PV-WAVE:IMSL Mathematics. GAMMA and BESSJ are used to define a surface to be plotted. In this example, you plot the function:
\[ f(x, y) = \sqrt{(0.01 + |x|)J_0(y)J_1(y)} \]

in the interval, \( x = [-6, 6], y = [-3, 3] \) and use SHADE_SURF to plot a shaded surface.

**Open a JOURNAL File**

**Step 1** If you are not in one, move to a directory where you have write permission. For example:

```
WAVE> CD, 'pathname'
```

**Step 2** Open a JOURNAL file:

```
WAVE> JOURNAL, 'gamma_bessel.pro'
```

**Enter Commands at the PV-WAVE Command Line**

The commands you enter are being recorded directly in the JOURNAL file `gamma_bessel.pro`.

**Step 1** Generate 100 \( x \) values in the interval \([-6, 6]\). Type:

```
WAVE> x = -6 + FINDGEN(100)/99*12
```

**Step 2** Generate 100 \( y \) values in the interval \([-3, 3]\). Type:

```
WAVE> y = -3 + FINDGEN(100)/99*6
```

**Step 3** Create a matrix to hold the \( z \) values. Type:

```
WAVE> z = FLTARR(100, 100)
```

**Step 4** Create a larger window. Type:

```
WAVE> WINDOW, 0, XSize = 875, YSize = 800
```

An empty window appears.

**Step 5** Load color table 6, *Prism*. Type:

```
WAVE> LOADCT, 6
```
PV-WAVE returns a message telling you the color table has been loaded.

**Step 6**  Define the surface in the 2D matrix $z$, using GAMMA and BESSJ. Type:

```
WAVE> FOR I = 0, 99 DO z(*,i) = $  
    ➤ SQRT(ABS(GAMMA(.01 + $  
    ➤ ABS(x)) * BESSJ(0, y(i)) * $  
    ➤ BESSJ(1, y(i))) )
```

**NOTE** A space is required before a $ when: (a) an equal sign (=) appears immediately before the $ or (b) when the equal sign (=) falls at the beginning of the following line.

**Step 7**  Plot a shaded surface of $x$, $y$, and $z$. Type:

```
WAVE> SHADE_SURF, z, CharSize = 3, $  
    ➤ Color = 127
```

A shaded surface of the result is displayed.

Add a line displaying the mathematical function. You can use the **Title** keyword to place the function above the plot, but you also have the ability to display the information across the plot by using XYOUTS.

A string that will display the following function requires text commands capable of producing the characters in the correct graphic relationship:

$$f(x, y) = \sqrt{\Gamma(0.01 + |x|)J_0(y)J_1(y)}$$

**TIP** For a complete discussion of the text commands used in the next step, refer to the **PV-WAVE User’s Guide**.

**Step 8**  First, create a string to produce the equation. Type:

```
WAVE> SS = '!18f!6(x, y) = '$  
    ➤ + '!7C!6(0.01 + !9!!!6x!9!!!6)' $  
    ➤ + '!J!S!i0!r (y)!J!S!i1!r (y))!1!e(1/2)'
```

**NOTE** The plus sign (+) is the concatenation character used for text strings in PV-WAVE.
Step 9  Output the string over the plot. Type:

WAVE>  XYOUTS, .2, .81, SS, Size = 3, $
\Rightarrow$ Color = 50, /Normal, /NoClip

The string is displayed across the plot.

\[ f(x, y) = (\Gamma(0.01 + |x|)J_0(y)J_1(y))^{(1/2)} \]

Step 10  Close the window. Type:

WAVE>  WDELETE

**Close the JOURNAL File**

Step 1  To close and save the JOURNAL file type:

WAVE>  JOURNAL

The gamma_bessel.pro file is saved in your current directory.

**Running the Batch File**

Now that you have created a batch file, you can run it. You may wish to view the contents first.

Step 1  Go to a text editor or an OS window and display the file. For example, if you are using UNIX, enter
$ more gamma_bessel.pro

If you used capitals in creating the filename, you must type the filename exactly as you did before, using capitals.

NOTE The file is displayed. Comments added by PV-WAVE include the PV-WAVE version number, the file type and machine identification, the working directory pathname, and the date the file was created at the top.

Step 2 Go to the PV-WAVE window and compile and run your file. Type:

WAVE> @gamma_bessel.pro

NOTE The @ command is a special command used to execute batch files. As the file is read, each line is compiled and executed one after another, displaying a shaded surface as before.

Step 3 Close the window. Enter:

WAVE> WDELETE

Step 4 Example Program: population_ode.pro

This example uses the PV-WAVE:IMSL Mathematics function ODE to solve a simple, non-linear, one-dimensional, ordinary differential equation.

The simplest population model assumes that population growth is directly proportional to the size of the population:

\[
\frac{dy}{dt} = \epsilon y
\]

where \( t \) is the time in years, \( y \) is the population at time \( t \), and \( \epsilon > 0 \) is the growth rate.

The solution to this equation is:

\[
y(t) = y_0 e^{\epsilon t}
\]

where \( y(0) = y_0 \). This gives an exponentially growing population.

However, eventually, resources will limit population growth, so that the growth rate is not constant but a function of the population. Thus, for small populations, growth
will occur due to availability of resources, and for large populations the limitations on resources will produce an inhibitory effect on population. A simple function meeting these criteria is achieved by setting the growth rate to be:

\[ \varepsilon - \sigma \Psi \]

where \( \varepsilon, \sigma > 0 \). The ODE then becomes

\[ \frac{dy}{dt} = \varepsilon y - \sigma y^2 \]

The exact solution is given by:

\[ y(t) = \frac{\varepsilon}{\sigma} \left( 1 - \frac{y_0}{\varepsilon/\sigma} e^{-\varepsilon t} \right) \]

As \( t \to \infty \), then \( y \to \varepsilon/\sigma \).

For this example, choose \( \varepsilon = 0.07 \) and \( \sigma = 0.001 \), and solve the ODE for various values of initial conditions. The resulting solutions are plotted. Note that the line \( y = 0.07/0.001 = 70 \) is the limiting curve, regardless of the initial population value. For each initial condition, the population at time \( t = 40 \) is given.

**Step 1**  Open a text editor to type this program, which you save as `population_ode.pro`.

**Step 2**  Type in the following program.

```plaintext
; Define a function to evaluate the right-hand side of the ODE
FUNCTION ode_1, t, y
  epsilon = 0.07
  sigma = 0.001
```

**NOTE**  Comments are preceded by semicolons (;). The plus character (+) is needed when two character strings are concatenated into one. Character strings can be entered only one line at a time; therefore, any string longer than one line must be broken into two by using a plus sign to combine them. The plus sign can be placed at the end of the first line or at the beginning of the second.
RETURN, epsilon*y - sigma*y*y

END

; Main program
PRO POPULATION_ODE

; The variable t represents time in years
  t = [0, 40]
  t = FINDGEN(41)
; Set up a matrix to hold the ODE solution
; corresponding to runs with 10
; different initial solutions
  yprime = FLTARR(10, 41)
  WINDOW, 0, XSize = 875, YSize = 800, $
  XPos = 3, YPos = 30, $
  Title = 'PV-WAVE ODE Integrator'
; Set up the axes for a plot of the solutions
  PLOT, yprime(0, *), t, YRange = [0, 100], $
  XRange = [0, 40], /NoData, Title = '!17ODE Population Model', $
  XTitle= 'Time t in Years', YTitle= 'Population y in millions', $
  CharSize = 2
; For each solution print the initial
;condition and final value
  PM, 'Initial Condition y(0) Population at t = 40'
; Loop over 10 different initial conditions
  FOR i = 10, 100, 10 DO BEGIN
    yinitial = [i]
    index = i/10 - 1
; Call PV-WAVE:IMSL Mathematics function ODE
    yprime(index,*) = ODE(t, yinitial, 'ode_1')
; Print initial and final solutions
    PRINT, yinitial(0), ' ', yprime(index, 40)
; Plot solutions
    OPLOT, t, yprime(index, *)
  ENDFOR
END

Step 3  Save the file as population_ode.pro.
Now you are ready to compile and run the program.

**Step 4**  Run the `prep_plot` procedure. It is used to reset plotting parameters and system variables:

```
WAVE> prep_plot
```

**Step 5**  Compile the program. Type:

```
WAVE> .run population_ode
```

The program is compiled.

**NOTE** A runtime error may stop the program at a level below the main level. To return to the main program level, type `RETALL` at the `WAVE>` prompt.

If you made a typing error, you will receive an error message. In this case, go back to your text editor and correct the mistake; save the program; then run the program as in the previous step. You do not need to close (exit) PV-WAVE.

**Step 6**  Now you can use your program. At the `WAVE>` prompt, type:

```
WAVE> population_ode
```

The program returns the values for the *Initial Condition* and for the *Population* at each condition,

<table>
<thead>
<tr>
<th>Initial Condition y(0)</th>
<th>Population at t=40</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>51.2446</td>
</tr>
<tr>
<td>20</td>
<td>60.8025</td>
</tr>
<tr>
<td>30</td>
<td>64.7429</td>
</tr>
<tr>
<td>40</td>
<td>67.0317</td>
</tr>
<tr>
<td>50</td>
<td>68.4430</td>
</tr>
<tr>
<td>60</td>
<td>69.3272</td>
</tr>
<tr>
<td>70</td>
<td>70.0000</td>
</tr>
<tr>
<td>80</td>
<td>70.5622</td>
</tr>
<tr>
<td>90</td>
<td>70.9890</td>
</tr>
<tr>
<td>100</td>
<td>71.3117</td>
</tr>
</tbody>
</table>

then it plots the values:
A Comparison of Matrices and Arrays

Matrices can be referenced differently from arrays by using the functions PM (Print Matrix), RM (Read Matrix), PMF (print matrix file), and RMF (Read Matrix File).

Matrices are used by mathematically-oriented functions and procedures, such as EIG (compute eigenvalues). If $A$ is a matrix, then $A(i, j)$ refers to the $i$-th row, $j$-th column of $A$. This conforms to standard mathematical notation. The elements in a matrix are stored columnwise, i.e., the elements of the 0-th column are first, followed by the elements of the 1-st row, etc. A matrix can be converted to an array by taking its transpose.

Other functions and procedures, such as the image display function TV, use arrays. If $A$ is an array (an image is an array of pixels), then $A(i, j)$ refers to the pixel whose $x$ coordinate is related to $i$ and whose $y$ coordinate is related to $j$. The elements in an array are stored row-wise, i.e., the elements of the 0-th row are first, followed by the elements of the 1-st row, etc. If the array is an image, then a row corresponds to a scan line. Images are stored in scan line order. The main reason for this is to allow the $x$ subscript to appear first when subscripting images, as is the convention.

PV-WAVE provides specific methods to read arrays and matrices. The PV-WAVE PRINT command returns values according to the array syntax, and the READ command is the corresponding command to read data. The PV-WAVE PM
command (Print Matrix) and the RM command (Read Matrix) follow the matrix notation convention. Both matrices and arrays are read and printed in column-major order unless you use PM, RM, PMF, or RMF, which specify row-major order.

You have the option of using the type of commands that emulate the notation with which you are most comfortable. By being consistent in your choice of commands to read and write your matrix data, you will always find that the PV-WAVE commands work the way you expect.

**Example Program: matrices.pro**

The first part of this exercise demonstrates the use of the RM and PM commands; you can best see how these commands work by actually typing the nine short lines within PV-WAVE. This example solves a simple linear system using LUSOL.

In this example, you are prompted to enter the 2-by-2 matrix of coefficients, $A$, and the 2-by-1 right-hand side of the vector, $b$. The systems, $Ax = b$, and $A^T x = b$ are then solved.

**Step 1**  Tell PV-WAVE to keep track of your commands under the name matrices.pro. Enter:

```
WAVE> JOURNAL, 'matrices.pro'
```

**Step 2**  Type the program:

```
WAVE> PM, 'Enter a 2x2 matrix of coeffs, a:'
WAVE> RM, a, 2, 2
```

PV-WAVE returns:

```
row 0:
```

**Step 3**  Input any two numbers, separated by a comma (or a space), such as “3,5” (or 3 5). Then you are prompted to input the values for the next row (row 1). Again, enter two numbers (such as 4, 6), separating them with a comma or a space.

**Step 4**  Enter:

```
WAVE> PM, 'Enter the 2x1 vector for the $\Rightarrow +$ right hand side, b:'
WAVE> RM, b, 2, 1
```
PV-WAVE returns:

row 0:

**Step 5** Enter:

row 0: 8
row 1: 7

**Step 6** Continue. Enter:

WAVE> PM, ‘a = ′, a, ‘b = ′, b
WAVE> x = LUSOL(b, a)
WAVE> PM, ‘x =’, x, ‘a#x’, a#x
WAVE> y = LUSOL(b, a, /Transpose)
WAVE> PM, ‘y = ′, y, ‘TRANSPOSE(a)#y =’, $TRANSPOSE(a)#y$

**Step 7** Stop the journaling session. Enter:

WAVE> JOURNAL
The file matrices.pro saved in the current directory.

**Step 8** Now run your program. Enter:

WAVE> @matrices
The program prompts you for input, then returns the values specified in matrix algebra notation. The solution is found only if A is nonsingular.

**Example Program: linear.pro**

This colorful example, linear.pro, illustrates use of the PV-WAVE procedures designed to solve general linear system problems. In this example, you solve the 10-by-10 linear system, \(Ax = b\), where \(A\) is the tri-diagonal matrix,
The linear system is solved using the PV-WAVE:IMSL Mathematics function, LUSOL, and the quantity \( \max\{|Ax-b|\} \), the largest residual, is returned. The solution, \( x \), is plotted, then the system is solved 100 more times with a different right-hand side vector, \( b \). Each \( b(i) \) is perturbed by an additive factor of at most 1. The corresponding solution vectors are plotted.

As you examine the code, notice that, in the course of solving the problem 100 times with LUSOL, the factorization of the matrix \( A \) is calculated needlessly each time. A more efficient method would be to use the PV-WAVE:IMSL Mathematics function LUFAC to compute the factorization one time. Then, using the given factorization, use LUSOL each time to only solve the system.

The WAIT command is used within the procedure linear.pro to slow the plotting so that you can see each line being plotted.

**Running the Example Program**

This section explains how to run the example program; see the next section for a complete listing of the program.

**Step 1** Go to the directory containing linear.pro by entering the command shown on page 162.

\[
A = \begin{bmatrix}
-2 & 1 & 0 & 0 & 0 & 0 & 0 & 0 & 0 \\
0 & -2 & 1 & 0 & 0 & 0 & 0 & 0 & 0 \\
0 & 0 & -2 & 1 & 0 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & -2 & 1 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & 0 & -2 & 1 & 0 & 0 & 0 \\
0 & 0 & 0 & 0 & 0 & -2 & 1 & 0 & 0 \\
0 & 0 & 0 & 0 & 0 & 0 & -2 & 1 & 0 \\
0 & 0 & 0 & 0 & 0 & 0 & 0 & -2 & 1 \\
0 & 0 & 0 & 0 & 0 & 0 & 0 & 0 & -2
\end{bmatrix}
\]

and

\[
b_i = \sin\left(\frac{2\pi i}{9}\right) \quad i = 0, \ldots, 9
\]
Step 2  Compile the prep_plot procedure. It is used to reset plotting parameters and system variables:

WAVE> prep_plot

Step 3  To run the program, enter:

WAVE> linear
PV-WAVE returns:
Maximum residual error = 2.08616e-07
and plots the values:

![Graph](image)

Example Program Listing: linear.pro

The following is a complete listing of the program linear.pro, in:

$VNI_DIR/docs/tutorial/code/advantage (UNIX)
VNI_DIR:[DOCS.TUTORIAL.CODE.ADVANTAGE] (OpenVMS)

; linear.pro
; This example illustrates usage of the PV WAVE:IMSL Mathematics
; procedures designed to solve real
; general linear system problems
;
PRO linear
prep_plot
;
; Solve the linear system Ax = b
; A is a tri-diagonal matrix with 2's along the diagonal and
A Comparison of Matrices and Arrays

; 1's along the sub- and super-diagonal
A = FLTARR(10, 10)
FOR i = 0, 9 DO A(i, i) = -2.
FOR i = 0, 8 DO A(i + 1, i) = 1.
FOR i = 0, 8 DO A(i, i + 1) = 1.

; Generate values for the right-hand side
b = SIN(2.*!Pi*FINDGEN(10)/9.)

; Solve the linear system
x = LUSOL(b, A)

; As a measure of accuracy, print the maximum residual error
PM, 'Maximum residual error = ', MAX(ABS(A#x - b))

; Load 150 colors to use
red = RANDOM(150) & red(0) = 0 & red(149) = 0
green = RANDOM(150) & green(0) = 0 & green(149) = 1
blue = RANDOM(150) & blue(0) = 0 & blue(149) = 0
TVLCT, 255*red, 255*green, 255*blue

WINDOW, 0, XSize = 875, YSize = 700, $
XPos = 3, YPos = 30, $
Title = 'PV-WAVE General Linear Systems' $
+ 'Problem Example'

PLOT, x, YRange = [-4, 4], Back = 0, Color = 149
WAIT, 3

; Solve the system with 100 different right-hand sides
; The PV WAVE:IMSL Statistics random number generator is used to$
; perturb each component of b$
; by at most +-1.
FOR i = 1, 100 DO OPLT, $
LUSOL(b + .2*(RANDOM(10) -.5), A);$
Color = i$

; A more efficient way is to save the factorization of$
; the matrix, A.$
WAIT, 3
PLOT, x, YRange = [-4, 4], Back = 0, Color = 149
WAIT, 3
; Compute the factorization
LUFAC, A, pvt, fac
FOR i = 1, 100 DO BEGIN
  OPLOT, LUSOL(b + .2*(RANDOM(10) -.5), $ Pivot = pvt, Factor = fac), $ Color = i, Thick = 2
  WAIT, .2
ENDFOR
; Read in the Visual Numerics logo
status = DC_READ_TIFF (!Data_Dir + 'vni_small.tif', $ vni_s, ImageWidth = XSiz, ImageLength = YSiz)
TV, vni_s, 0, Order = 1 & WAIT, 10
;
WHILE (!D.Window GE 0) DO WDELETE, !D.Window
prep_plot
END
Using PV-WAVE:GTGRID™

PV-WAVE:GTGRID is an optional toolkit for PV-WAVE. PV-WAVE:GTGRID offers advanced gridding capabilities in the form of a library of powerful analytical and numerical interpolation and extrapolation techniques.

Figure 10-1  A shaded surface of data made after using PV-WAVE:GTGRID (left) is compared to a surface of the same data (right) drawn before processing it with the GTGRID function.
In this lesson, you will create and compare a surface plot of data made without using PV-WAVE:GTGRID to a surface plot of the same data made using the gridding capabilities of PV-WAVE:GTGRID.

**NOTE** PV-WAVE:GTGRID only runs on UNIX workstations.

---

**Previewing This Lesson**

Before you can run the lesson preview, PV-WAVE:GTGRID must be installed. To preview the steps you will take and the plots you will create in this lesson, run the batch file named below.

**Step 1**
Go to the tutorial code subdirectory.

```
WAVE> cd, '$VNI_DIR/docs/tutorial/code'
```

**Step 2**
Start PV-WAVE:GTGRID.

```
WAVE> @gtgrid_startup
```

**Step 3**
Run the program.

```
WAVE> @lesson_9
```

The batch files run the programs, demonstrating the plots you will produce in this chapter.

If the plots fail to display properly because the paths are different at your site, copy the file `gtgrid_surf.pro` and make the corrections for the paths.

---

**About PV-WAVE:GTGRID**

The PV-WAVE:GTGRID Library is a structured collection of FORTRAN subroutines for solving surface estimation (gridding) problems. It is valuable for PV-WAVE users in such areas as:

- oil and gas industry
- aerospace
- radar and sonic applications
- weather and atmospheric conditions
PV-WAVE:GTGRID accepts 3D random data from PV-WAVE in the form of x, y, and z vectors. The result from PV-WAVE:GTGRID is a 2D array containing the gridded z values on a uniform x-y grid.

PV-WAVE:GTGRID provides several unique gridding methods, each designed to treat a certain class of data in an optimum manner. The choice of gridding method is made primarily based on the distribution of the input points. The default method, Scatter, is used in this lesson. Scatter handles faults and large datasets well.

One of the major advantages of PV-WAVE:GTGRID is that it enables you to define a fault or a discontinuity in your data and the gridding algorithm won’t interpolate across the fault or discontinuity.

PV-WAVE:GTGRID writes a file called scratch.dat during the gridding process. If you do not have write permission in the directory named in step 1, you can copy the following three files to a directory in which you have write permission and you then will be able to run the lesson_9 batch file:

```
lesson_9
gtgrid_surf.pro
prep_plot.pro
```

---

**Drawing a Surface Plot**

The dataset used in this example consists of 342 values arranged in 3 columns, with each column containing the x, y, or z values. Since x, y, and z must be converted to arrays, an easy way to accomplish this is to use the DC_READ_FREE function to create variables associated with the columns, then to use the REFORM function to create the arrays.

**Step 1**  Open and read the data file.

```
WAVE> status = $
  ➤ DC_READ_FREE(!Data_Dir $ + 'gtgrid1.dat', $ a, b, c, /Column)
```
Step 2  Define x, y, and z arrays.

WAVE>  a = REFORM(a, 6, 19)
WAVE>  b = REFORM(b, 6, 19)
WAVE>  c = REFORM(c, 6, 19)

Step 3  Open a window and give it a title.

WAVE>  WINDOW, 0, Title='PV-WAVE Non-Gridded Data'

Step 4  Draw a surface plot of the data.

WAVE>  SURFACE, c, a, b, AZ = 70, $
      
      ➤ CharSize=3, XTitle = '!17X', $
      
      ➤ YTitle = 'Y', ZTitle = 'Z'

The plot appears.
Using the PV-WAVE:GTGRID Function

If you choose to use the OPENR command, you will need to declare the data array before you read the data file.

**Step 1** Create an array variable to hold the data and read the data into it.

```
WAVE> data = FLTARR(3, 114)
WAVE> OPENR, 1, !Data_Dir + 'gtgrid1.dat'
WAVE> READF, 1, data
WAVE> CLOSE, 1
```

GTGRID is a PV-WAVE function. It returns a 2D array containing the gridded $z$ values in a uniform $x$-$y$ grid. The syntax is

```
result = GTGRID(XVEC, YVEC, ZVEC)
```

The XVEC, YVEC, and ZVEC arguments represent arrays of floating-point values containing the $x$-, $y$-, and $z$-coordinates of the random input data.

**Step 2** Define $x$, $y$, and $z$ arrays.

```
WAVE> x = data(0, *)
WAVE> y = data(1, *)
WAVE> z = data(2, *)
```

**Step 3** Call GTGRID and override the default values for NX and NY (number of columns).

```
WAVE> zz = GTGRID(x, y, z, NX = 75, NY = 75)
```

The program returns information about the gridding process.

- Grid requires 5625 nodes
- Performing Primary Gridding
- There were 107 gradient estimates made
  Avg no. neighbors used for gradient - 15
- Secondary Gridding in Progress
- Smoothing of current Surface in progress
Step 4  Open a larger window and place it on the left side of the screen.

WAVE> WINDOW, 1, XSize = 875, YSize = 800, $
   ➤ XPos = 3, YPos = 30, $
   ➤ Title = 'PV-WAVE:GTGRID Gridded Data'

Step 5  Draw the surface plot and rotate the plot to match the angle of the plot of the ungridded data.

WAVE> SURFACE, zz, AZ = 70, CharSize = 3, $
   ➤ XTitle = '!17X', YTitle = 'Y', $
   ➤ ZTitle = 'Z'

The plot appears.
There is a marked difference in the appearance of the two plots.

**Step 6** Add a skirt and define the \( z \) range.

\[
\text{WAVE}> \text{SURFACE, } zz, \text{ AZ } = 70, \text{ CharSize } = 3, \$
\Rightarrow \text{XTitle } = '17X', \text{ YTitle } = 'Y', \$
\Rightarrow \text{ZTitle } = 'Z', \text{ Skirt } = -2500, \$
\Rightarrow \text{ZRange } = [-2500, 2000]
\]

The plot appears.

For fun, draw a shaded surface of the data.

**Step 7** Use the \textit{WAVE Special} color table.

\[
\text{WAVE}> \text{LOADCT, 15}
\]
Step 8  Draw the shaded surface.

\texttt{WAVE> SHADE\_SURF, zz, AZ = 70, CharSize = 3,}$
\begin{itemize}
  \item \texttt{XTitle = '!17X', YTitle = 'Y',}$
  \item \texttt{ZTitle = 'Z', Skirt = -2500,}$
  \item \texttt{ZRange = [-2500, 2000]}$
\end{itemize}

The plot appears. (See Figure 10-1.)

This concludes the plots for this lesson.

Step 9  Close the windows.

\texttt{WAVE> WDELETE, 0 & WDELETE, 1}

The GTGRID function has four methods, including \textit{Direct}, \textit{Cluster}, and \textit{Weighted}, to specify how primary gridding estimates at grid nodes are performed. The keywords that can be used with the GTGRID function include the following:

\begin{center}
\begin{tabular}{l l l l}
\textit{Bounding\_Poly} & \textit{Dist\_Avg} & \textit{Interp\_Dist} & \textit{Method} \\
\textit{Neighbors} & \textit{Nodestroy} & \textit{Nomessage} & \textit{Nsmooth} \\
\textit{Nulval} & \textit{Nx} & \textit{Ny} & \textit{Radius} \\
\textit{Surf\_id} & \textit{Xfaults} & \textit{Xmax} & \textit{Xmin} \\
\textit{Xorg} & \textit{Xspacing} & \textit{Yfaults} & \textit{Ymax} \\
\textit{Ymin} & \textit{Yorg} & \textit{Yspacing} & \textit{Zresolution}
\end{tabular}
\end{center}

With these keywords, it is possible to obtain an appropriate gridding method for any type of data, whether it be large, noisy or faulted.

More Information on PV-WAVE:GTGRID

For more information on PV-WAVE:GTGRID, see the \textit{PV-WAVE :GTGRID User’s Guide}.
Animation with PV-WAVE

This chapter explains how PV-WAVE can help you visualize your data dynamically with animation.

Figure 11-1 In this example from the Gallery demo, MRI data of a human head is displayed as a series of translucent images, which produces animation that simulates full-circle rotations.
An animation is a series of still frames shown sequentially to create the illusion of motion. In PV-WAVE, a series of frames can be represented by a 3D array (for example, a 3D array could hold forty, 300-by-300 pixel images). This lesson shows you how to create arrays of images and play them back as animated sequences.

Previewing This Lesson

To preview some of the programs you will create in this lesson, run the batch file named below.

**Step 1** If you have not already done so, start PV-WAVE by entering at the operating system prompt:

```wave
```

**Step 2** Use the CD command to move to the PV-WAVE subdirectory that contains code for the tutorial. At the `WAVE>` prompt, enter:

```wave
WAVE> cd, '$VNI_DIR/docs/tutorial/code'
```

If you are running the UNIX version of PV-WAVE.

```wave
WAVE> cd, 'VNI_DIR:\[DOCS.TUTORIAL.CODE\]'
```

If you are running the OpenVMS version of PV-WAVE.

**Step 3** Run the lesson preview by entering the following command at the `WAVE>` prompt:

```wave
WAVE> @lesson_11
```

The batch file `lesson_11` runs the programs. The instructions for running and quitting the animations are printed in the PV-WAVE window. After a brief pause, the last window is closed.

Displaying a Series of Images

Create an animation that shows a series of images that represent an abnormal heartbeat. First, read in the images to be displayed. The file `abnorm.dat` holds a series of 16 images of a human heart stored as 64-by-64 byte arrays.

**Step 1** Open the file and prepare it for reading by entering the following commands at the `WAVE>` prompt:
OPENR, 1, !Data_dir + 'abnorm.dat'
This command opens the file abnorm.dat for reading.

Define a variable, \( h \), as a 64-by-64-by-16 byte array.

**Step 2** Create a variable \( h \) to hold the images. Enter:

\[
WAVE> h = BYTARR(64, 64, 16)
\]

**Step 3** Read the images into the variable \( h \), using the command, READU, which reads unformatted, or byte, data. Enter:

\[
WAVE> READU, 1, h
\]

**Step 4** Close the file abnorm.dat by entering:

\[
WAVE> CLOSE, 1
\]

**Step 5** Load an appropriate color table, Red Temperature, by entering:

\[
WAVE> LOADCT, 3
\]

**Step 6** Open a window that will fit the final image. The final image size will be 256-by-256 bytes.

\[
WAVE> WINDOW, 1, XSize = 256, YSize = 256
\]

**Step 7** Display the first image in the array \( h \) by entering:

\[
WAVE> TV, h(*, *, 0)
\]

The small image appears in the lower left corner of the window.

The asterisks (*) in the first two subscript positions tell PV-WAVE to use all of the elements in those positions. Hence, the TV command displays a 64-by-64 byte image.
Step 8  The image is rather small, so resize each image in the array with bilinear interpolation by entering:

WAVE>  h = REBIN(h, 256, 256, 16)

Step 9  Redisplay the image:

WAVE>  TV, h(*, *, 0)

Each image in \( h \) is four times its previous size.

Step 10 Now use the Standard Library procedure MOVIE to display each image in array \( h \) one after another. Enter:

WAVE>  MOVIE, h, Order = 0

The animation appears.

Step 11 Press <s> to slow the animation, <f> to speed it up, and <q> to return to the PV-WAVE command line.

---

**Animation As a Wire Frame Surface**

The data in abnom.dat also can be displayed as a series of surface plots.

Step 1  Create a new array \( s \) to hold the heartbeat data by entering:

WAVE>  s = REBIN(h, 32, 32, 16)

The variable \( s \) now holds sixteen 32-by-32 byte versions of the heartbeat images. SURFACE plots are often more legible when made from a resized version of the data set with fewer data points in it.

Step 2  Now create a new window 300-by-300 pixels wide in which to display the images.

WAVE>  WINDOW, 2, XSize = 300, YSize = 300,$

\*  Title = ‘PV-WAVE Animation’

Step 3  Display the first image in \( s \) as a wire-mesh surface by entering:

WAVE>  SURFACE, s(*, *, 0)

The surface is drawn in white.
To make the surface plots appear in color, first load 32 distinct colors:

WAVE> TEK_COLOR

Create a series of surface plots, one for each image in the original data set.

First, create a 3D array frames to hold all of the images by entering:

WAVE> frames = BYTARR(300, 300, 16)

The variable frames will hold sixteen, 300-by-300 byte images.

The next command draws each frame of the animation. A surface plot is drawn in
the window and then the TVRD command is used to read the image from the plot-
ting window into the frames array. The FOR loop is used to increment the array
indices. The lines below are actually a single PV-WAVE command.

Draw each animation frame. Enter:

WAVE> FOR I=0, 15 DO BEGIN SURFACE, $
  \Rightarrow$ Color = 10, $
  \Rightarrow$ s(*, *, I), ZRange = [0, 250] & $
  \Rightarrow$ frames(0,0,I)=TVRD(0, 0, !D.X_VSize, $
  \Rightarrow$ !D.Y_VSize) & END

NOTE The dollar sign ($) works as a continuation character in PV-WAVE and the
ampersand (&) allows multiple commands in the same line.

A series of surface plots is drawn in the window.

NOTE The ZRange keyword is used to keep the surface height at the same scale
for each plot. The TVRD function returns the contents of the specified rectangular
portion of a displayed image. The system variables, !D.X_VSize and !D.Y_VSize,
report the size of the current window and each is updated when the window is
resized.
Step 7  Now display the new animation by entering

```
WAVE> MOVIE, frames, Order = 0
```

Step 8  Press <s> to slow the animation, <f> to speed it up, and <q> to return to the PV-WAVE command line.

---

**Rotating the Images in an Animation**

The file nist.dat, contains data representing the magnitude displacement caused by a shock wave. The next example, animate.pro, provides the general framework for creating and then rotating 30 increments of six degrees.

The REBIN function is used to reduce the 50-by-50 array to 25-by-25. The angle of rotation is assigned by specifying the variable `angle` equal to $-i * 6.0$. The surfaces are read as images into the variable `frames` and `frames` is viewed both forward and backward to create a smooth loop.

Step 1  Compile and run the procedure.

```
WAVE> .RUN animate
WAVE> animate
```

Step 2  To quit the program, place the pointer in the plotting window and click the left mouse button.

---

**More Information on Animation**

With just a few PV-WAVE commands, you have created a number of different types of animation. If you use PV-WAVE with the X Window System, you can use PV-WAVE’s WgAnimateTool and WgMovieTool routines. For more information on animation, see the PV-WAVE User’s Guide and the PV-WAVE Reference.
PV-WAVE Gallery

The PV-WAVE Gallery is a suite of sample PV-WAVE applications. The entire Gallery program is written using PV-WAVE to display a wide range of application areas appropriate for Visual Data Analysis. The application code and data files are provided so you can extract parts of them and use them within your own applications.

Figure 12-1  Advanced rendering techniques are used to display a region of high oil potential in this example from the PV-WAVE Gallery.
The objective of the Gallery is to highlight the performance and flexibility of PV-WAVE. While your own applications may be more or less elaborate, the Gallery helps you understand how PV-WAVE helps users discover and understand the trends, anomalies, and relationships in their data.

**PV-WAVE Gallery Setup**

Starting the Gallery is similar to starting up PV-WAVE. First, set up the environment variables and then start the Gallery:

UNIX using a C shell:

```
% source $VNI_DIR/wave/bin/wvsetup
```

where VNI_DIR is the directory in which PV-WAVE is installed.

```
% wave_gallery
```

UNIX using Korn or Bourne shell:

```
% source $VNI_DIR/wave/bin/wvsetup.sh
```

where VNI_DIR is the directory in which PV-WAVE is installed.

```
% wave_gallery
```

OpenVMS

```
$ @VNI_DIR:[WAVE.BIN]WVSETUP.COM
```

where VNI_DIR is the directory in which PV-WAVE is installed.

```
$ @wave_gallery.com
```

You can run the Gallery interactively by selecting the menu buttons.

**Gallery Contents**

The main menu contains buttons of various sizes. Press any button to open the section described on the button.

**PV-WAVE Functional Demonstrations**

The first eight buttons on the Gallery menu access demonstrations of the functionality available in PV-WAVE:

- Basic Functions
• Array/Equation Manipulations
• Advanced Mathematics & Statistics
• Time Series
• Mapping
• Advanced Rendering
• Simulations
• Table Tools

PV-WAVE Industry Applications

Buttons 9 through 16 on the Gallery menu access applications created with PV-WAVE:
• Financial Analysis
• Medical Imaging
• Oil/Gas Exploration
• Earth Sciences
• Test Engineering
• CFD Aerospace
• Signal Image Processing
• Image Processing

Each of these applications is summarized in this chapter.

**PV-WAVE Software Family**

Buttons 17 through 20 on the Gallery menu access demonstrations concerning the complete PV-WAVE Product Family:
• PV-WAVE: Database Connection
• PV-WAVE: GTGRID
• PV-WAVE: Signal Processing Toolkit

**Help Button**

Clicking the HELP button while a demonstration is running will provide information about running the Gallery and on PV-WAVE code that created the applications.

---

**Applications**

**Basic Functions**

The basic capabilities and functions available in PV-WAVE for reading and displaying 1D, 2D, 3D and 4D data are showcased in this demonstration. The functions shown are:
• Display ASCII Column formatted data as a 1D x-y plot.
• Display binary unformatted data as a 2D image.
• Display ASCII Column formatted data as a 2D contour plot.
• Display ASCII Column formatted data as a 3D mesh surface plot.
• Display ASCII Column formatted data as a 4D shaded surface plot.
Array/Equation Manipulation

This demonstration shows how PV-WAVE’s simple array manipulation syntax can be used to perform complex calculations. You can select from a list of 1D and 2D functions. PV-WAVE then plots the function over the selected data range.

Advanced Mathematics & Statistics

This demonstration shows PV-WAVE’s ability to perform advanced numerical and statistical analyses. Hundreds of powerful data analysis and numerics functions are integrated, including linear systems of equations, interpolation and approximation, quadrature, differential equations, eigensystem analysis, correlation and regression, to mention only a few. The main functions that are highlighted by this demonstration are radial-basis fit, singular value decomposition, and spline fit analysis.
Time Series Data
This demonstration shows PV-WAVE’s ability to display data as bit-mapped images and the rapidity with which a row or column profile of an image is displayed as a line graph. The data used is air quality information from Colorado Springs, Colorado.

Mapping
This demonstration is designed to show you some of the ways you can use the mapping procedures provided in PV-WAVE.

Advanced Rendering
This demonstration uses four pre-computed images to demonstrate some of RENDER’s abilities. The data used is a volumetric 3D array containing Magnetic Resonance Imaging (MRI) data of a human head.

RENDER has the following capabilities:
• Diffuse polygon mesh rendering
• Multiple planar slices through a volume
• Rendering of translucent polygon meshes
• Rendering multiple objects with different transformations
• Generation of quadratic objects (sphere, cylinder, cone)
• Rendering with multiple light sources

Simulations
This Gallery application module displays shock wave propagation through a graphite-epoxy composite material. Researchers at the National Institute of Standards and Technology and Virginia Polytechnic developed this simulation technique in an effort to advance non-destructive materials evaluation techniques.

Table Tools, Date/Time
The Table Tools and Date/Time functionality are shown in this demonstration.
The data used is a table of 1000 records for electronic parts that failed control tests. The data includes information on who assembled the part, the part number, the time
it took to assemble the part, the sub-component that failed within the part, the failed component type, the type of failure, and the date and time the part was assembled. You can explore the data by using the Table Tools functions and view the different kinds of plot types available with the Date/Time functions.

Financial Analysis

The four modules in this application show how PV-WAVE can be applied to financial analysis.

- Break-Even Analysis
- Loan/Mortgage Analysis
- Stock Price Analysis
- Option Pricing Analysis
Medical Imaging

MRI Scan

A 3D MRI (Magnetic Resonance Imaging) scan of a human head is rendered as a cut-away volume and a series of volume rendered images displayed from different viewpoints. You may interactively define a slicing plane and extract an oblique slice from the volumetric data.

The concepts demonstrated include:

- Overlaying vector graphics and text on a raster image
- Animation of a sequence of contour plots
- Reading in 3D volumetric data
- Slicing 3D volumetric data
- Volume rendering and animation of 3D data
**PET Scan**

This Gallery application module first displays images of a normal brain and a concussion damaged brain. The data for these images was generated using a medical technique called PET (Positron Emission Topography). The scientists compare the rate of glucose absorption in healthy tissue, compared to the sample.

**Heartbeat Animation**

Next, an animation sequence of an abnormal heartbeat is displayed as a series of images and contours. This data was collected using an ultrasound device which scanned a horse’s heart.

**Oil/Gas Exploration**

This demonstration shows how PV-WAVE can be used to analyze well log information. You may display

- the actual well log for a specific well
- the well paths colored by a selected variable
- an image showing the location of the underground reservoir

**Earth Sciences**

Several plots of global wind velocity data are shown in this demonstration.

The first is a colored velocity vector plot showing atmospheric wind speed at several different pressure layers around the world. Wind speed point values can be obtained by selecting them with the mouse.

The second plot is a filled contour plot atmospheric wind speed at several different pressure layers around the world. Wind speed point values can be obtained by selecting them with the mouse.

The last part of the demonstration shows the filled contour plot of the wind velocity wrapped around a sphere.

**Test Engineering**

This module displays multi-variate engine test data consisting of over 20,000 floating point values. This module shows an interface where various relationships between selected variables can be displayed using strip charts and raster images.

The concepts demonstrated include:
• Display of test data on a supercomputer
• Data reduction
• Animation of a sequence of images
• Calculation and display of relationships between multiple variables
• Multiple strip charts
• Display of floating-point data as raster images

**CFD Aerospace**

PV-WAVE’s abilities for displaying and analyzing computational fluid dynamic (CFD) data are shown in this demonstration.

In the first part of the demonstration, various types of displays generated from and airfoil tested in a wind tunnel are available.

The second part of the demonstration uses 3D data representing fluid flow through a turbine with a flow restrictor. Here you may display oblique slices through the data, 3D vector field plots, and translucent volume renderings.

**Image Processing**

This demonstration shows how PV-WAVE can be used to perform many common image processing filtering and analysis functions. Interactive tools for plotting profiles, zooming in on particular regions, plotting histograms, and manipulating color palettes are available. Many common spatial and frequency domain filters are available as well as geometric transformations and image comparisons.

**Signal Processing**

This application demonstrates some of the ways PV-WAVE can be used to manipulate and display signal data. X-Y plots can be combined with filters built into PV-WAVE or developed using the PV-WAVE language. The data is a sample signal of a voice saying “PV-WAVE”. In the plotted waveform you can see the “P”, the “V” and “WAVE” as three distinct bursts.

The raster image of the spectrogram displays the frequencies present in the original voice signal.

The concepts demonstrated include:
• Filtering and displaying the signal
• Use of FFT’s to calculate the spectrogram of a signal
PV-WAVE Software Family

You do not need to have any of the following products installed to display the screen captures of each of these products:

- PV-WAVE:Database Connection — This selection displays screen captures of PV-WAVE: Database Connection searching both Sybase and Oracle databases and displaying the acquired information.
- PV-WAVE:GTGRID — This selection displays screen captures of the advanced gridding capabilities available with PV-WAVE:GTGRID.
- PV-WAVE:Signal Processing Toolkit — Not included in this group of screen captures.
- PV-WAVE:Image Processing Toolkit — Not included in this group of screen captures.
Index

Symbols

# (matrix multiplication operator) 111
$ (continuation character) 13
$ (dollar sign) 67, 96
& (ampersand) 13, 88
+ (plus character) 79, 195
, (comma) 13, 68
; (semicolon) 13
/ (slash) 139
; (semicolon) 13

A

abnorm.dat 214
ampersand (&) 13, 88
animation 52, 213
arrays 68
  compared to matrices 198
  definition 14
  processing techniques 137
ASCII characters 71

B

batch files 97, 190
binary data 99
boxcar averaging 143
buffer
  input 77
  XPRIMARY 103
Byte 14

cannot open display 99
case sensitivity
  in PV-WAVE 13
character string
  break onto multiple lines 79
  concatenating 195
color 75, 102
24-bit 73, 153
8-bit 73, 153
create custom 153
displays 153
in plots 119
keyword 110
manipulation tools 119
reversing 156
table 73, 147
used to enhance images 157
using 151
wheel 159
column profiles 148
coma (,) 13, 68
command recall 96
COMMON BLOCK data 100
Complex 14
concatenating character strings 195
continuation character ($) 13
contour plot
  3D 120
    creating 85, 114
    filled 121
CONTOUR2 procedure 124
contrast enhancement 142
creating data 68
D

- data 68
  - binary 99
  - COMMON BLOCK 100
  - creating 68
- date/time functionality 79
- default
  - resources 101
  - viewing angle 125
  - window index number 69
- differential equations 196
- display
  - latitude and longitude data 116
  - online documentation 102, 103
  - PV-WAVE window 99
  - subarrays 146
  - TIFF file or logo 130
- documentation, online 92
- dollar sign ($) 67, 96
- Double 14
- Double Complex 14

E

- EQ operator 141
- exiting
  - PV-WAVE Advantage and CL 95
- external data representation (xdr) 99, 108

F

- files
  - batch 190
  - closing 107
  - keyword 108
  - opening 107
  - reading 108
- filled contour plots 121
- Floating 14
- follow
  - keyword 114, 128
  - method of contouring 114
- fonts
  - built-in 77
  - description of 77
  - Hershey 77
  - specification 78

FrameMaker documents 102
FrameViewer 103

G

- GT operator 141
- GTGRID
  - function 209
  - keywords 212

H

-HELP
  - context sensitive 35
  - starting online documentation 13
  - variables 93
- help
  - online 13
- Hershey fonts 77
- HLS 152
- HSV 152

I

- image processing tools 27, 137
- index number 69
- Integer 14
- interrupts 95

K

- key settings 96
- keyword 69
  - names and abbreviations 139
  - set to 1 with slash 139

L

- LE operator 141
- line style 75
- linear systems
  - problems 200
- LineStyle 75
- loading
  - a color table 109
  - data from a file 108
- logical unit number (LUN) 113
- logo, displaying 130
Longword 14
LT operator 141

M
matrices 14, 198
matrix multiplication operator (#) 111
maximum operator 142
memory 102

N
Navigator
introduction to 17
starting the 19
NE operator 141

O
opening an xterm window 101
operators
infix notation 12
ordinary differential equations 180, 196
overplotting 72, 81

P
paths, may be incorrect 106
plots
2D 24
3D contour 120
contour 85, 114
filled contours 121
linear 109
profile 29
shaded surface 85, 127
surface 84, 124
vector 111
plotting symbols 71
plus character (+) 79, 195
previewing ASCII data 21
printing 36
profile plots 29
program area is full 100
prompt 94
PV-WAVE exiting 66
starting 66
PV-WAVE:GTGRID 6, 207

R
ramping, color 74
reading a file
DC_READ_24_BIT 113
DC_READ_8_BIT 113
DC_READ_FIXED 113
DC_READ_FREE 113
DC_READ_TIFF 113
READ 198
READU 108
recalling commands 76
regression 183
resource manager file 101
restoring a PV-WAVE session 98
RGB 152
rotating the images in an animation 218
row profile 87

S
saving
a PV-WAVE session 97
memory 103
semicolon (;) 13
shaded surface plots 85
shading, plots 127
sharpening 145
shell tool 76
.SIZE 100
Skirt 211
slash (/) 139
smoothing 143
Standard Library 86, 111
String 14
strings, concatenating 195
supported platforms 10
surface plots 34, 84, 124
symbols 71
SYS$LOGIN directory 106
system variables 94
T

text
  merging into resource file 102
  pasting 103
Thresholding 141
TIFF 130
tmp directory 106
transformation, 3D 128
troubleshooting 99

U

unsharp masking 144
up arrow ( )
  (up arrow) 76

V

variable
  information 93
  system 94
VDA 6
VDA Tools, definition of 17
vector
  create a 68
  plot 111
Visual Data Analysis 6

W

wavesave.pro 190
window, deleting 89

X

X PRIMARY buffer 103
X server resource database utility (xrdb) 101
  .Xdefaults 101, 104
  files
    .Xdefaults 101, 104
  XDR 99, 107
  .Xresources 101, 102, 104
  files
    .Xresources 101, 102, 104
  xterm window 76, 101